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About this guide

This guide provides information about administering the HP Integrated Archive Platform (IAP). For
information on administering HP Email Archiving Software (EAs) for Exchange or Domino, see the
respective administration guide included on the documentation CD in those products.

Intended audience

This guide is infended for HP Integrated Archive Platform administrators.

Related documentation

HP provides the following related documentation.

For administrators and installers:

HP Integrated Archive Platform Installation Guide (available to HP personnel installing IAP hardware
and software)

HP Virtual IAP 2.1.2 Installation Guide (available to HP personnel installing virtual IAP software)

HP IAP File Export Installation and Administration Guide (available to HP personnel installing AP
hardware and software)

Online help for the Platform Control Center (PCC) (the help is a subset of the administrator guide)

HP Email Archiving software for Microsoft Exchange or IBM Lotus Domino administration guide
(located on the documentation CD included in those products)

HP Email Archiving software for Microsoft Exchange or IBM Lotus Domino installation guide
(available to HP personnel installing those products)

For users:

HP Integrated Archive Platform User Guide (located on the documentation CD)

Online help for the IAP Content Search and Retrieve Web Interface; the help is a subset of the
user guide

HP Email Archiving software for Microsoft Exchange or IBM Lotus Domino user guide (located on
the documentation CD included in the those products)
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Support

You can visit the HP Software Support web site at: http://www.hp.com/go/hpsoftwaresupport

HP Software Support Online provides an efficient way to access interactive technical support tools.
As a valued support customer, you can benefit by using the support site to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract.

To find more information about access levels, go to: hitp://support.openview.hp.com
new_access levels.jsp

For continuous quality improvement, calls may be recorded or monitored.

Subscription service

HP strongly recommends that customers register online using the Subscriber's choice web site: http:/
www.hp.com/go/e-updates.

Subscribing to this service provides you with email updates on the latest product enhancements, newest
driver versions, and firmware documentation updates as well as instant access to numerous other
product resources.

Document conventions and symbols

Table 1 Document conventions

Convention Element

Medium blue text: Related docu-
mentation

Cross-reference links and email addresses

Medium blue, underlined text (ht-

Web site addresses

tp://www.hp.com)
* Key names
¢ Text typed into a graphical user interface (GUI) element, such as into
Bold font a box
e GUI elements that are clicked or selected, such as menu and list items,
buttons, and check boxes
Italic font Text emphasis
14 About this guide
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Convention Element

¢ File and directory names
e System output
* Code

* Text typed at the command line

Monospace font

e Code variables
Monospace, italic font . .
P g e Command-line variables

Emphasis of file and directory names, system output, code, and text typed

Monospace, bold font .
P ! at the command line

A WARNING!

Indicates that failure to follow directions could result in bodily harm or death.

A CAUTION:

Indicates that failure to follow directions could result in damage to equipment or data.

® IMPORTANT:

Provides clarifying information or specific instructions.

B NOTE:

Provides additional information.

% TIP:

Provides helpful hints and shortcuts.
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1 IAP product overview

This chapter describes key concepts involving the HP Integrated Archive Platform.

Introduction to |AP

HP’s Integrated Archive Platform (IAP) is a fault-tolerant, secure system of software and services for
archiving and retention management. It provides long-term information retention combined with
high-speed, interactive search and retrieval capabilities to help organizations meet their regulatory
requirements.

The IAP software can be deployed on IAP hardware (HP Proliant servers and ProCurve switches on
a factory-assembled rack system) or on servers running VMware ESXi Server software.

Understanding the components

In order to create a framework for understanding the components of IAP and how they work together,
this chapter covers a number of high level themes, such as a conceptual overview, key benefits and
features, software components, hardware components, network architecture and data flow. Taking

a look at the anatomy or architecture of IAP and its components will support the goal of operating,
maintaining, optimizing and troubleshooting the IAP system more effectively.

Conceptual overview

In broad conceptual terms, the IAP can be thought of as having three aspects:

1. An organization's archived content
2. Application archiving software
3. Working with archived content effectively through the capabilities of IAP

Organizational content

IAP serves as a platform for archiving many types of content generated by an organization. It
automatically and actively archives files, email (Exchange, Domino), documents and other types of
data. See Appendix B on page 187.

Application archiving software

HP provides a variety of application archiving software that works with IAP to capture and store data.
These software components are focused on ingesting data into IAP. The IAP can be precisely customized
and configured to support an organization’s archiving and retention policies.

IAP works with the following application archiving software:
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HP Email Archiving software (EAs) for Exchange

HP Email Archiving software (EAs) for Exchange is mail administration software that archives messages
and attachments, and stores the messages in IAP. Users can search for and retrieve their archived
messages directly from Outlook. HP EAs for Exchange fully integrates with Microsoft Exchange and
Outlook. Outlook Integrated Archive Search enables search of the IAP repositories directly from
Outlook by key words and date ranges.

HP Email Archiving software (EAs) for Domino

HP Email Archiving software (EAs) for Domino is mail administration software that archives messages
and attachments, and stores the messages in IAP. Users can retrieve their archived messages directly
from IBM Lotus Notes and iNotes, and EAs for Domino is fully integrated with Lotus Notes and iNotes.

HP File Archiving software

HP File Archiving software (FAs) is a policy-based file archiving solution that enables you to
automatically archive files, web and application server data from a Windows environment for migration

into IAP. (FAs was formerly known as FMA.)

Archiving methods
HP EAs for Exchange and HP EAs for Domino support the following archiving methods:

* Compliance Archiving. In EAs for Exchange, compliance archiving captures all inbound and out-
bound messages. EAs for Exchange provides two different mechanisms to implement compliance
archiving. One technique copies each inbound and outbound message to a journal mailbox which
the Archive Gateway scans periodically to archive the contents on the IAP. The other technique,
available on Exchange 2007 and later, uses Simple Mail Transport Protocol (SMTP) to relay every
message directly to an Archive Gateway which then archives them to the IAP.

In EAs for Domino, compliance archiving can capture messages at an individual, group, and/or
organization level when the Advanced Filtering feature is used.

¢ Selective archiving (mail database mining). Selective archiving helps administrators reduce the
amount of primary storage used on the mail servers. It provides policies fo mine messages from
users’ mailboxes. Administrators can centrally configure policies, including quota archive thresholds,
message age or size, sender/recipient, specific folders, and keywords. Policies can be set at the
individual, group, and/or organization level. Messages are automatically archived when the
policies are enabled. After archiving, links fo the archived messages (called tombstones) can be
placed in mail databases.

*  Archiving of inactive or archive mail databases. EAs for Exchange and EAs for Domino also
provide optional tombstoning of messages in inactive PST and NSF databases.

Working with content on IAP
An overarching focus of IAP is the ability to work effectively with an organization's stored content.

The many abilities and benefits of working with stored content on IAP include:

¢ Storage
* Indexing
* Single instancing

* Retention policies
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Encryption
Authentication
Replication

(This feature is not currently available in virtual IAP environments.)

Monitoring
Search
Retrieval
Backup/restore

(The optional backup system running HP Data Protector software, and the IAP Smartcell group
restore feature are not supported in virtual IAP environments.)

Key benefits

Using IAP helps you:

Features

Mitigate the costs and business impact of regulatory compliance, e-discovery preparation, and

legal response. When entering litigation, companies need to be able to show that their emails

have not been tampered with and to be able to pull the information that pertains to a particular
case.

Effectively manage, retain, and retrieve information. IAP turns data into information by providing
fast retrieval of archived content. Data retrieval from the archival system is accelerated using
storage grid architecture that evenly distributes full text indexes and original content across many
Smartcells (storage cells). Searches are executed across all Smartcells in parallel.

Increase email, file, and application server performance by offloading documents from the server
to the IAP. Storing mail and files on IAP provides a faster means for query and retrieval. IAP supports
free text searching through any Web browser.

Reduce the cost and complexity of managing email, file system storage, and quotas.
Defer capital expenditures on new primary storage systems.

IAP automatically and actively archives email messages and other types of data. It provides interactive
data querying to quickly and easily search for and retrieve archived data according to various criteria.
Authorized users are granted access to archived information through IAP’s Web user interface.

The following is a list of high-level features of IAP:

Grid computing architecture. HP IAP’s grid computing architecture provides scalability in perform-
ance and capacity. Searches are executed across all Smartcells in parallel.

Integrated distributed content indexing and search tools. Comprehensive integrated search cap-
abilities that leverage the IAP's distributed indexing and grid architecture technologies ensure fast
access to consolidated and centralized multi-content information silos, such as email and files, for
hundreds of thousands of users across hundreds of terabytes and billions of objects.

Storage reduction algorithms. IAP uses storage reduction algorithms including data compression
and object level single instancing. This enables IAP to provide an efficient means for identifying
duplicate emails or documents and removing them from the archive.

Search tool integrated with Exchange Outlook and Lotus Notes. Users can search for their archived
messages directly from within their email application; they don’t have to learn or bring up a sep-
arate utility.

Business policy-driven automated archiving applications. Selectively archive emails and documents
according to flexible policies.
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* Reduced administration overhead for managed applications such as Microsoft Exchange servers.
HP IAP Platform Control Center (PCC) software is included to monitor the status and administration
of the IAP system.

* Tamper-resistant environment. Digital signatures, timestamps, and data retention policies are used
to protect data against erasure and tampering. Data cannot be deleted from the archive until the
end of the retention period.

¢ Data replication and mirroring. Data is mirrored synchronously across a group of Smartcells for
increased data availability.

* Support for unstructured, semi-structured, and structured data such as email and files.

* Mitigation of regulatory and legal risks and support of corporate governance initiatives. Data
stored in HP IAP is managed by retention policies and is tamper-resistant in alignment with SEC
and regulatory rules. Data can be searched with proper credentials. Litigation holds can be applied
when required.

*  Flexible refention management. Preservation of information through flexible retention policies ensures
proper disposition of data at the end of its refention period whether it is to meet compliance, legal
hold, or governance requirements.

Software components

There are two main types of software components for working with IAP — user applications and
administrator applications.

Applications for users

The following application is available for all IAP users.

Table 2 IAP application for users

Application Tasks

Use a web browser to:

* Search for documents archived on the system and save and reuse
search criteria and results.

* Send archived emails to the email client.

* Downlocad files to a local computer or network folder.

IAP Web Interface * Export emails and files when the appropriate export tool is installed

on the user's system.

* (Compliance/legal officers) Place a legal hold on emails so they are
retained indefinitely.

* (Compliance/legal officers) View the Auditlog, the compliance system
log.

To interact with the system, the following optional email archiving and file archiving applications are
available for users. Outlook Plug-In, Notes Client Plug-In, Local Cache, Export Search, and IAP File
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Export are installed on users' computers. The Outlook Plug-In can also be installed on a server running

Citrix Presentation Manager.

Table 3 EAs and FAs applications for users

Application

Tasks

Outlook Plug-In (customer option)

Search for, view, and work with archived emails using Outlook with a
Microsoft Exchange mail server. Export email from the IAP to a PST file.

OWA Extension (customer option)

View and work with archived emails using Outlook Web Access with a
Microsoft Exchange mail server.

Notes Client Plug-In
Local Cache
Export Search
(customer options)

(Windows users only)

View and work with archived emails using Lotus Notes with an IBM
Domino mail server.

Access archived email offline while traveling.
Export email from the IAP to a Notes NSF file.

DWA Extension (customer option)

View and work with archived emails using iNotes (Domino Web Access)
with an IBM Domino mail server.

IAP File Export (customer option)

Export files migrated using HP File Archiving Software or BIBO to a local
computer or network folder.

Tools for administrators

The IAP provides the following troubleshooting and administrative features.

Table 4 IAP tools for administrators

Feature

Tasks

Platform Control Center (PCC)

Monitor and troubleshoot system status and performance, configure system
options, and manage user accounts using the web-based administrator
interface. See “Introduction to Platform Control Center (PCC)” on page 33.

Command-line interface

Configure and enable system options from the command line (in some
cases under the guidance of HP authorized support personnel)

Auditlog

Enable the Auditlog for regulatory compliance. See “Enabling the
Auditlog” on page 147.

External access

View and configure EAs for Exchange options using VNC access to the
Archive Gateway. See “External access” on page 141.

Remote server management

Administer remote management of IAP servers using HP Proliant Onboard
Administrator Powered by Lights-Out 100 or Integrated Lights-Out 2. See
Chapter 13 on page 165.

This feature is not supported in virtual IAP environments.
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The following email archiving, file archiving, and backup applications are available for use with the

IAP.

Table 5 Applications for administrators

Application

Tasks

HP Email Archiving software for
Exchange

Archive journaled mail, configure archiving rules, and batch process
multiple Outlook PST files for Microsoft Exchange. See the HP Email
Archiving software for Microsoft Exchange Administrator Guide included
with the EAs for Exchange product on the documentation CD.

HP Email Archiving software for
Domino

Archive journaled mail, configure archiving rules, and batch process
mail databases for IBM Lotus Domino. See the HP Email Archiving
software for IBM lotus Domino Administrator Guide included with the
EAs for Domino product on the documentation CD.

HP File Archiving software

Archive files, web, and application server data from Windows systems.

HP Data Protector

Automates high-performance backup and recovery with scalable data
protection.

This feature is not supported in virtual IAP environments.

Hardware components

The following components are available in non-virtual IAP environments.

IAP base system

The IAP base system consists of the following components:

42U rack
(9x) management servers
(1x) Universal Smartcell
(Tx) KVM/Mon

(1x) 5406 switch

(

1x) 2510G-48 switch for iLO
Total U used in base rack: 19U
Available U for upgrade: 23U

The management servers consist of the following:

22

Archive Gateway (option)
Firewall

Load Balancer

Query portal (HTTP)

Store portal (SMTP)
Metaserver

Cloud router

Database (DB2)

PCC (Platform Control Center)
Kickstart server
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The IAP 2.1 base system ships with DL360 G6é or G7 servers for all servers except the Universal
Smartcell, which uses DL180 Gé servers. It includes one pair of Smartcells which provides 5 TB of
storage. Two additional pairs of Smaricells can be ordered to fully load the base system. This increases
the storage capacity from 5 TB to 15 TB.

B NOTE:

When you upgrade to IAP 2.1 software, you may need to upgrade to IAP 2.1 hardware to achieve
optimal performance.

Expansion rack
42U rack
(10x) Universal Smartcells
Total: 40U
Total capacity of one expansion rack: 50 TB
Up to 21 expansion racks per HP IAP system
Maximum capacity of an IAP is now 10650 TB (213 groups times 5 TB)

Performance upgrades (for example additional SMTP or HTTP portals) can optionally be housed in
expansion racks

The expansion rack can hold an additional ten pairs of Smartcells providing 50 TB of storage capacity.

Additional options

The base system can accommodate up to three Smartcell groups. If you choose to add Smartcells,
you must have an expansion rack. An expansion rack can accommodate up to ten pairs of Smartcells.
It can also hold performance upgrades, such as an additional query portal or store portal. You can
mix and match on the expansion rack.

Additional factory-integrated options
The following are available as factory-integrated options:

* 5 TB Smartcell storage capacity upgrade

*  Query (HTTP) portal performance upgrade

¢ Store (SMTP) portal performance upgrade

* Replication performance upgrade

* |IAP backup option (a dedicated tape backup solution)
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Expansion Capacity Performance upgrade option

The Expansion Capacity Performance upgrade option allows for improved performance with a larger
(expanded capacity) IAP.

Replication option

Another option is an IAP replication option for one system. The replication option is a software license
that supports the replication of a base system, local or remote. Replication is not currently available
in virtual IAP environments.

Network architecture

The following diagram shows the overall picture of the network architecture. It is a basic network
diagram of IAP. The VLAN 500 is the backbone of the IAP network. Users connect through the
firewall/NAT. Administrative functions connect through the PCC. With the PCC, you can monitor the
IAP and its health, the state of the servers, and whether or not IAP is storing or not storing.

IAP 2.1 Network diagram

All systems are Linux-based, except for the optional HP Gateway server, which runs Windows Server
software.
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Figure 1 Architecture diagram

Virtual LANS (VLANS)

IAP uses Virtual LANS (VLANS), or Virtual Local Area Networks. The VLANS connect the management
servers to one another. The following list indicates how various components are connected through
the VLANS:

VLAN 200: Connects the firewall/NAT with the load balancer and Archive Gateway servers
VLAN 300: Connects the load balancer with the HTTP portal and the SMTP portal
VLAN 400: HTTP portal goes to VLAN 400 and can talk through the VLAN 300

VLAN 500: The backbone of the IAP network. Connects with the PCC server, the database server,

kickstart server, cloud router, and metaserver(s).
VLAN 600: Connects to Cloud Router 1 and optional backup servers
VLAN 700: Connects to Cloud Router 2 and optional backup servers
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Grid architecture

IAP’s grid storage implementation using Universal Smartcells is a distributed computer system of
self-contained, all-inclusive data repositories. It enables intelligent distribution of hundreds of terabytes
of content and billions of objects across a grid of Smartcells. It allows parallel searches, so that within
three to five seconds, IAP can perform a quick search across terabytes of referenced information.

IAP’s grid computing architecture helps manage explosive growth in information by consolidating
and centralizing silos of information throughout the enterprise. It ensures the highest levels of
performance as the number of users or document traffic into HP IAP increases.

Part of the grid architecture implementation involves domains and repositories. Domains are sub-groups
of Smartcells within the larger grid architecture. For example, domain 1 may have four pairs of
Smartcells, while domain 2 may have three pairs of Smaricells (both domains being in the same IAP
grid). Each domain can have distinct policies, representing different divisions of a large organization.
Repositories are logical entities spanning one or more Smartcells. Multiple repositories can exist within
a single domain. A repository might represent a single user’s mailbox, or it might represent the
mailboxes of a group of users. Access control determines who has access to a particular domain or
repository.

Management servers

The basic IAP system includes nine management servers. The following section briefly describes each
management server’s primary functions.

Firewall /NAT

The firewall/NAT (Network Address Translation) restricts access to IAP. It leads out to users. Data
that is stored goes through the firewall/NAT, which provides network address translation between
internal and external networks. The firewall /NAT static IP address is 10.0.101.1. You can have a
second firewalll.

Load balancer
The load balancer balances incoming traffic to the SMTP and HTTP portals. Its IP address is 10.0.100.1.

You can have a second load balancer.

HTTP portal

The HTTP portal is used for querying and retrieving documents. Queries first pass through the firewall,
then to the load balancer. The load balancer selects an available HTTP portal. The HTTP portal queries
the metaserver to identify which Smartcell groups contain the document.

The HTTP portal’s IP address is 10.0.71.1. Additional HTTP portals use IP addresses that increase
incrementally by the last digit. For example: 10.0.71.2, 10.0.71.3, and so forth.

SMTP portal

The SMTP portal is used for storing messages. It identifies which repositories have access to messages.
lts IP address is 10.0.102.1. Additional SMTP portals use IP addresses that increase incrementally
by the last digit. For example: 10.0.102.2, 10.0.102.3, and so forth.
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Metaserver

The metaserver manages Smartcell allocation, system state, and Bias Dimensional Indexing (BDI)
mapping. It determines if additional Smartcells need to be allocated for storage. The metaserver
continuously monitors the Smartcell states; for example, suspended state or stopped state.

The metaserver also tracks which IAP domains correspond to which Smartcells and users. For example,
certain Smartcells belong to domain 1. Certain other Smaricells belong to domain 2. The metaserver
communicates with the DB2 server and with the HTTP and SMTP portals to determine which Smartcell
is applicable to each store or query request.

The metaserver’s IP address is 10.0.97.1. It is possible to have a second metaserver. In that case,
you would have a primary or master metaserver. The additional or secondary metaserver would use

IP address 10.0.97.2.

Cloud router

The cloud router routes internal network traffic to and among Smartcells. In order for data to be stored
or retrieved, it goes through the cloud router and then goes to the Smartcells via VLAN 600 or VLAN
700. lts static IP address is 10.0.96.3. It is possible to add a second cloud router.

Database server (DB2)

The database server stores usernames, passwords, and other access-control information. It stores
routing rules for messages entering the repository, reflecting who will have access to that repository
and message. The database server also stores query results. Those query results can be pulled out at
a later time. In addition, the server stores Smartcell state information. Smartcell state information is
also stored in the Smartcell itself which supersedes the state in the DB2 database.

The database server controls the replication flow between the primary IAP and the replica IAP in cases
where the replication option is utilized. The DB2 server’s IP address is 10.0.99.1.

Kickstart server

Platform

The kickstart server acts as a hub for all the IAP management servers. It stores the operating systems,
software applications and configuration files needed for each of the management servers. Each
management server has its own MAC address. For any given MAC address, the kickstart server knows
the management server, the operating system (OS) of the server, the applications that the server runs,
and the configuration files the server requires. The kickstart server’s IP address is 10.0.107.1.

Control Center (PCC)

The PCC provides a web-based interface for administrators to monitor and troubleshoot the IAP and
manage user accounts. It also provides a command-line interface. Common administrator tasks include:
¢ Checking overall system health and performance

* Checking Smartcell health and performance

*  Monitoring system status and RAID support

¢ Starting, stopping, and restarting system servers

¢ Synchronizing user accounts

* Managing user accounts

*  Monitoring system alerts

The PCC’s IP address is: 10.0.101.2.
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Archive Gateway (option)

The Archive Gateway server is optional, based on customer requirements. It contains the software
components necessary for archiving email. It is a connector to the IAP and drains email messages
from production mail servers. The Archive Gateway also creates message stubs or tombstones in the
client mailboxes if selective archiving is implemented.

There are two types of Archive Gateways, one for Microsoft Exchange and one for Lotus Domino.
For Exchange, the Archive Gateway contains HP Email Archiving software for Exchange (HP EAs for
Exchange). The IP address for the Exchange Archive Gateway is 10.0.14 .x.

For Domino, the Archive Gateway contains HP Email Archiving software for Domino (HP EAs for
Domino). The IP address for the Domino Exchange Gateway is not fixed as it resides outside of the

IAP firewall.

Backup server (option)

In non-virtual IAP environments, customers can choose to add the backup option, which is a backup
server with HP Data Protector software. The backup server performs backups of the IAP's Smartcell,
DB2 data, and IAP configuration to tape. You can have one or more backup servers.

The backup server’s IP addresses are 10.0.169.x and 10.0.201.x (one interface on each Smartcell
network).

Universal Smartcell

The Universal Smartcell is the basic element of storage for IAP. Two Smartcells make one Smartcell
group; Smartcells are always configured as a pair — a primary and a secondary Smartcell. The
Smartcells are “intelligent storage” servers that handle their own data operations, including capture,
indexing, compression, storage, searching and retrieval. A Universal Smartcell group has up to 5 TB
of storage capacity and it is in a RAID 6 configuration with ADG protection.

The IP address for the primary Smartcell can be 10.0.172.1 or 10.0.204.1, and it is accessed through
VLAN 600. The IP address for the secondary Smartcell can be 10.0.172.1 or 10.0.204.1 (but it

must not be the same as the primary), and it is accessed through VLAN 700. For situations in which
customer needs require additional Smartcells, additional primary Smartcells will use IP addresses of

10.0.172.2, 10.0.172.3, and so forth. Additional secondary Smartcells will use IP addresses of
10.0.204.2, 10.0.204.3, and so forth.

Data flow

This section describes the general flow of data going into and coming out of IAP.

Store path

The store path is a part of the data flow in which data goes into IAP. It refers to email and files being
archived. The actual unit of data that the store path works with is a bitfile. Before describing the data
flow in more detail, we need to understand the bitfile.
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Bitfile

Manifest

Data

Metadata

Sig

A bitfile is a basic document storage unit used by the IAP. It is a four-part ZIP file consisting of these
parts:

*  Manifest
* Data

*  Metadata
* Sig

The manifest is a plain text date. It contains three comma-separated pieces of information. The first
piece of information is a plain-text date (for example, Tue Jul 10 17:45:18 JST 2007); the second
piece is a version number (for example, 1); the third is a key type number (for example, 1). An example
of a manifest looks like this:

(Tue Jul 10 17:45:18 JST 2007,1,1)

This is the original data. For email, messages are archived in the RFC822 format.

IAP adds metadata to each bitfile. The metadata describes the bitfile's data; it consists of dates,
repositories, an indexable structure of the document, and e-mail envelope information. The metadata
is originally added by the SMTP portal, which scans the data being streamed into the bitfile. Metadata
is primarily used for indexing and access control.

The Sig is a digital signature, used to ensure that the digital content has not been tampered with. The
way it is computed ensures that the data content's digital signature is also “time locked.”

How the SMTP portal processes data

In the store path, an object enters the system through the network. A mail message comes from the
Exchange or Domino mail server via the Archive Gateway, goes through the front firewall/NAT, and
is load balanced. If there are multiple SMTP portals, the system determines which SMTP portal is
available.

The SMTP portal processes the object by doing the following:

* It creates a digital signature of the object plus the date and time of receipt.
¢ For email, it performs address resolution.

* It locates the repository for the data. In a sense, it is asking the question, “Whose document is
this2” It then locates the corresponding repository. If the data is an email message for Jan, for
example, the message will be archived for Jan. The SMTP portal will find a repository to which
Jan has access.

* It streams data through the cloud router to the primary and secondary Smartcell.
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How the Smartcells process data

At this point in the store path, the Smartcells receive and process the data by doing the following:

¢ Confirm successful storing of data on both the primary and secondary Smartcells.

*  Schedule the bitfile for indexing (parsing the data for keywords so that when searches are per-
formed, the relevant data can be found).

¢ Transmit an acknowledgement to the sending application that the data was successfully stored,
and then move on to the next item.

This store path process just described is the same for all types of archiving.

Query and retrieval path

Query

Retrieval

The query and retrieval path refers to email and files being searched and retrieved, resulting in data
flowing out of IAP to the user.

Queries are performed using the system's HTTP portals, and are performed from the IAP Web Interface
(via a web browser) or through the Outlook Integrated Archive Search.

The query is submitted through the front firewall. If there are multiple HTTP portals, the load balancer
determines which HTTP portal is available.

The HTTP portal formats the query and uses information from the metaserver to determine which
Smartcells will return data.

The Smartcells receive a multicast request in parallel; those with the data perform a local query.

After the multicast is performed, the Smartcells search for a match to the search criteria. Each Smartcell
returns results from its search, along with results” digital signature.

The metaserver receives the results, places them in a time-sequential order, and passes them back to

the HTTP portal.

The HTTP portal computes the digital signature and validates it against the stored digital signature.
This is to make sure that nothing was tampered with before returning data to the querying application.

At that point, the system sends the data back through the firewall, and to the user’s browser screen
or Outlook client to show the results. For example, if a user had performed a search for “technical

information” in messages archived during the past three months, the system returns email messages
that contain the key words from that search query.
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IAP power on/oft

Below are instructions for turning the IAP on and off, and specific instructions to follow in case of a
power failure.

Power off

To turn off the IAP:

1.

Power on

In a virtual IAP environment, follow steps a-e below.
In non-virtual IAP environments, go to step 2.
a. Start vSphere Client by selecting Start > All Programs > VMware > VMware vSphere Client.

Log in to the vCenter Server that manages the ESXi host using the IP address, Administrator
ID, and password.

c. Select the ESXi host.

d. Click the PCC virtual server.

e. Click the Console tab.

On the PCC console, log in as the root user.
Enter the following commands:

# /opt/bin/stop

# /opt/bin/shutdown

Wait until the shutdown script completes before removing power from server(s) running IAP
software.

To power on the IAP:

1.

In non-virtual IAP environments, make sure the ProCurve switch(es) inside the IAP are powered
on. Once power is restored, the ProCurve switch(es) should automatically come up.

In a virtual IAP environment, follow steps a-c below.
In non-virtual IAP environments, go to step 3.
a. Start vSphere Client by selecting Start > All Programs > VMware > VMware vSphere Client.

b. Llog in to the vCenter Server that manages the ESXi host using the IP address, Administrator
ID, and password.

c. Select the ESXi host.
Power on the kickstart server/kickstart virtual machine. Wait five minutes.

Power on the other servers/virtual machines. Order is not important, unless there has been a
power failure (see below).

Wait for all machines to start, then log in to the PCC console and issue the command:

# /opt/bin/restart
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How to restart IAP after a power failure
After a power failure has occurred, a specific power on sequence is required.
1. In a virtual IAP environment, follow steps a-c below.
In non-virtual IAP environments, go to step 2.
a. Start vSphere Client by selecting Start > All Programs > VMware > VMware vSphere Client.

b. Llog in to the vCenter Server that manages the ESXi host using the IP address, Administrator
ID, and password.

c. Select the ESXi host.
Power off all IAP systems.
Power on the kickstart server/virtual machine.
4. When the kickstart server is running, log in to the kickstart console and issue these commands:
# /etc/init.d/postgresgl stop
# /etc/init.d/postgresqgl start
Wait for the start to complete successfully.
Power on the DB2 server, routers, firewall, and load balancers.
Power on the Smartcells.
Power on the metaservers.

Power on the remaining servers/virtual machines.

= 0 ® N o o

0. Wait for all machines to start, then log in to the PCC console and issue the command:
# /opt/bin/restart

11. After the IAP has restarted, log into PCC Web Administration and verify that the IAP is running
and monitoring reporting system availabilities as expected.

B NOTE:

In the event both routers go down, the system should be restarted with /opt/bin/restart once
the routers are back up.

Maximum file size
The maximum file size that the IAP API allows for all file types is 1.47 GB.

VPN access

Your HP authorized support representative can discuss your VPN access options with you and help
select and implement the option that will work best for you.
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2 Introduction to Platform Control Center
(PCC)

This chapter introduces the Platform Control Center (PCC) administration tool for monitoring and
troubleshooting the IAP and user accounts.

It includes the following topics:

*  Accessing PCC, page 33

* User interface components, page 33

* User interface orientation tips, page 34

* Pages for common tasks, page 34

* Updating pages before printing, page 35
¢ left menu, page 35

* Monitoring and reporting, page 37

* Statuses and states, page 37

B NOTE:

PCC pages must be fully loaded (as indicated by the progress bar or icon in the browser) before
using the functions on the page.

Accessing PCC

To access the PCC, open a web browser, enter the PCC server's IP address, then log in using the
administrative user name and password.

Administrator privileges are set up in the Account Manager. See “User account information” on page
77 for more information.

You can also log in as the super user. The IAP super user login name and password are set up during
system installation.

B NOTE:

When opening PCC using Mozilla Firefox, accept the exception request if one appears.

User interface components

The PCC is an HTML-based application containing a menu on the left side of the page (referred to as
the left menu). Use the left menu to access most pages in the PCC.
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Figure 2 PCC user interface

User interface orientation tips
To orient yourself, pay attention to the different ways a PCC page is characterized.

¢ Link fext: A navigation link leading to a page is a general description of the page.
Most links to a page are from the left menu.

* HTML name: Each PCC page has a descriptive HTML name, which is displayed in the browser.

B NOTE:
Be sure to wait until a PCC page is fully loaded before using any of the page functionality.

Pages for common tasks

Table 6 Pages for common system administration tasks

Task Page

Check overall system health and performance | “Overview” on page 41

Start, stop, and restart IAP applications on sys-

“Software Management” on page 47
tem servers

Monitor system hardware status or remotely
manage servers (non-virtual IAP environments | “Hardware Management” on page 49

only)

34 Introduction to Platform Control Center (PCC)



Task

Page

Check the platform configuration

“Platform Settings” on page 57

Display firewalled ports enabled in the system

“Firewall Settings” on page 58

View IAP software version code installed

“Software Version” on page 62

Synchronize user accounts

“Account Synchronization” on page 63

Manage user accounts

“Account Manager (AM)” on page 73

Monitor, start, and stop replication for domains
(non-virtual IAP environments only)

“Replication” on page 92

Clone Smaricells (copy data)

“Smartcell Cloning” on page 115

Check database backup history

“Backup” on page 107

Monitor system events

“Event Viewer” on page 125

Activate SNMP traps and send email notifica-
tions

“SNMP Management” on page 127

Configure periodic email reporis of system status
and performance

“Email Reporter” on page 129

Link to Microsoft Exchange Archive Gateway

“Archive Gateway Management” on page 141

Updating pages before printing

PCC pages displayed in the web interface are not automatically updated. To manually update the
page, click Refresh (or Reload) in your browser.

If the browser caches web pages, the cached page displayed when you click the browser's Back
button can be out of date. Refresh it manually.

Some browsers print from an updated version of the web page without refreshing the browser display.
If the displayed page is out of date, the printout can be different from the displayed page. To ensure
you print what is displayed, refresh the browser manually before printing.

Left menu

The left menu provides quick access to PCC views. The left menu varies depending on the way the
system is configured. For example, systems not using replication do not have the Replication menu
item available. Also, HP support personnel utilizes a Service Tools menu item which they may make
available to you as needed.
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Table 7 Pages accessible from left menu

Left menu item

Description

“Overview” on page 41

View summary of system health, storage status, Smartcell perform-
ance by domain, and system alerts.

“Storage Status” on page 46

View summary, by domain, of document storage rates and
used/free disk space.

“Software Management” on page 47

View server software status, and start, stop, or restart IAP applic
ations on one or more servers on the system.

“Hardware Management” on page 49

Monitor server hardware status and remotely manage servers.
(Not supported in virtual IAP environments).

“Performance Graph” on page 53

Graph system storage and indexing rates and system perform-
ance.

General Configuration pages

“Platform Settings” on page 57

Display configuration information about the I1AP.

“Firewall Settings” on page 58

Display each firewalled port that is enabled in the system.

“SSL Configuration” on page 58

Generate third party public certificate requests for the PCC and
HTTP portals.

“Software Version” on page 62

View the IAP software version code used by the system.

“Software Update” on page 62

Install patches to the IAP software.

User Management pages

“Account Synchronization” on page 63

Configure dynamic account synchronization (DAS) fo automatically
create and update IAP users with information obtained from LDAP
servers.

“Account Manager (AM)” on page 73

Provision, update, and manage IAP user accounts.

“Account Error Recovery” on page 87

Repair account synchronization errors.

Archive

Gateway Management pages

“Overview Archive Gateway” on page 142

View status information about the Archive Gateway for each do-
main.

“VNC Archive Gateway” on page 141

Access the Microsoft Exchance Archive Gateway using VNC.

Data Management pages

“Duplicate Manager” on page 89

View status of duplicate merge jobs and schedule duplicate merge
jobs. (For Microsoft Exchange only)

“Reprocessing” on page 97

Schedule and enable reprocessing based on new routing rules.

“Retention” on page 99

Configure refention periods for domains and repositories.
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Left menu item Description

View status information about database, configuration, and
Smartcell backup.

“Backup” on page 107 Access HP Data Protector user interface for backup system detailed
information and configuration. (Not supported in virtual IAP
environments.)

Monitor and start or stop replication for IAP domains. (Not cur-

Replication” on page 92 rently available in virtual IAP environments.)

Restore a Smartcell group from tape. (Not supported in virtual

Restoring a Smarfcell group” on page 112 IAP environments )

Clone Smaricells (copy data) to give them a new, viable mirror

Smartcell Cloning” on page 115 cell

Reporting pages

View events that have occurred in a system service or application

Event Viewer” on page 125 or system hardware.

Set SNMP traps for system monitoring and send email notifica-

SNMP Management” on page 127 fions.

“Email Reporter” on page 129 Configure system monitoring reports to be sent fo email recipients.

Collect log file reports and email or FTP them to HP technical

Collect Log Files” on page 131 support or other recipients.

“User Repository Utilization Re-

port” on page 132 Create a snapshot of the current utilization of IAP user repositories.

Monitoring and reporting

PCC monitors the system and reports on its health and activity. PCC provides reports on:

*  System health

*  System performance

*  Smartcell states

Servers in the system (and their services) are organized info groups of the same type, called host
groups.

As long as services appear to be functioning correctly, the server is assumed to be healthy. If monitoring
indicates a server is not functioning correctly, none of its services are available. If a service has critical
status, but the host is up, the service probably needs to be restarted.

Statuses and states

Several PCC pages show current life cycle states of Smaricells or status values of particular hosts or
services. Status values measure relative health, and can be associated with a status condition conveying
a measure of confidence in the reported value.
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For example, the health of a Smartcell in the SUSPENDED life cycle state can be reported with the
HEALTHY host status value, which means the IAP operating system and applications are functioning
as they should be.

PCC pages often use status and state loosely and interchangeably when referring to hosts and services.
State is always used when referring to Smartcell life cycle states, but status and state are both used
when reporting Smartcell health, since Smartcells are regarded as a host like any other. PCC pages
also refer to status conditions as states or state types.

Smartcell life cycle states

Table 8 Smartcell life cycle states

Life cycle state Definition Importance

ASSIGNED The Smartcell is assigned to a domain.

The Smartcell is available for document storage,
search, and retrieval. If backup is enabled, Smartcell
data can be backed up.

normal

The Smartcell is full.
CLOSED
It is available for document search and retrieval, but

not sforage. If backup is enabled, all Smartcell data
was backed up before the Smartcell entered this state.

normal

COMPLETE_PROCESSING Data indexing.is being comp'vleted.
The Smartcell is full. It is available for document

search and retrieval, but not storage. If backup is
enabled, Smartcell data can be backed up.

maintenance

The Smartcell is a target for data restoration from

RESTORE another Smartcell.

. . maintenance
The Smartcell is not available for document storage,

search, or retrieval.

The metaserver and Smartcell are determining the
Smartcell's start state (the state following
DISCOVERY DISCOVERY), based on expected states of the

DHSER maintenance (startup
Smartcell and its mirror Smartcell.

only)
The Smartcell is not available for document storage,
search, or retrieval.

The Smartcell is being recycled. Stored documents
and corresponding management data, such as
document indexes, are destroyed during recycling.

RESET The system administrator has determined that existing
Smartcell data is no longer needed. The RESET state | maintenance
is only set manually.

The Smartcell is not affiliated with any domain, so it
is not available for document storage, search, or
retrieval.
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Life cycle state Definition Importance
Either of the following is true:
* The Smartcell or its mirror Smartcell has one or
more failed processes.
*  The mirror Smartcell is DEAD.
SUSPENDED NOTE:
If the Smartcell's status is OK, only the mirror failure
. Smartcell has failed.
The Smartcell is not available for storage. It is
available for document search and retrieval (unless
a failed process disabled the search engine). If
backup is enabled, the Smaricell is backing up new
data that has not yet been backed up.
The Smartcell has failed.
DEAD It is not available for document storage, search, or
. retrieval. If backup is enabled, some or all Smartcell | failure
data might not be backed up; if so, data will never
be backed up.
UNKNOWN
. The state of the Smartcell is unknown. unknown
The Smartcell is free. (Shown in blue.) It can become
ASSIGNED or become a target for data restoration.
FREE The Smartcell is not affiliated with any domain, so it | normal

is not available for document storage, search, or
retrieval.
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3 System Status

This chapter discusses the information that is found in the system status pages.
It includes the following topics:

e Overview, page 41

¢ Storage Status, page 46

* Software Management, page 47
* Hardware Management, page 49
¢ Performance Graph, page 53

Overview

The Overview provides a high-level look at system health. It displays the following information:

* Alerts for problems that are currently occurring in the system.
¢ Information about document storage rates and capacity, for the system and for each domain.
*  Platform information on objects stored or deleted.

*  Summary of the number of IAP users, groups, and repositories in the system. (Groups are not
currently supported, so the number is always 0.)

*  Summary of the number of partially indexed objects and CatchAll repository obijects.
¢ Information, by domain, about the status, health, and storage rate of each Smartcell.
* Information about the IAP software version code installed.

e The number of SMTP connections in each domain.

B NOTE:

Typically, you should monitor the Overview every day.

To open the page, go to Overview in the left menu.

Current Platform Alerts

A Current Platform Alerts log at the top of the Overview displays alerts for problems that are currently
occurring in system hardware, services, or applications.

B NOTE:

Current Platform Alerts does not appear in the Overview if problems are not currently occurring in
the system.
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Alerts are grouped by features. For example, all indexing alerts are grouped under Indexing. Each
alert includes a description of the problem, the context in which the problem is occurring, the server
on which the problem is occurring, and the date and time the problem began. Clicking More, if it
appears in the alert context, displays more details about the issue.

Whenever an alert is raised or cleared, a system event is logged. You can view all recent system
events by clicking Go to Event Viewer or navigating to Reporting > Event Viewer. See “Event
Viewer” on page 125 for more information.

Alert levels
There are three levels of alerts:

& Critical: The feature is completely down. It is critical for the entire system and requires immediate
action from the IAP administrator.
* ¥ Major: The feature has major issues, but it is not critical for the entire system.

* i Minor: The feature has some internal problems, but it is not critical for the feature health.

Application alerts

Application alerts are generated by the IAP software. They are cleared from the PCC Overview page
automatically when the problem is fixed or has disappeared. (See Clearing alerts.) For a description
of each application alert, see “IAP application-generated alerts” on page 179.

Currant Platform Alerts (Software Alerts: 6, Hardware Alents: 0, Towl: &)

© & A0 The archhing process does not find & group available Mo archiver sensces are svailable for domain thumb.com 100001021 072672009
for storage (SMTPPartal) 05:26:37
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I~ & AT  The apphcation sener did not stan successhully Couwdn load all the senices. Check the sener log 1000.71.1 (HTTPPortal) 0?.'211.'2?&9

r € AMT  The apphcation senes did not $tan successhully Coudnt load all the senices, Check the sener log 100,87 1 (MetaSenr) EE%.’%M

r © ADIZ  The DBZ instance is unavailable Could not create connection to database sener 10.0.101.2 (TSCHAT) 0722002009
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Figure 3 Sample application alerts

Application alerts can be forwarded as SNMP traps to external SNMP trap listeners or forwarded in
email to designated recipients. For more information, see “SNMP Management” on page 127.

Hardware alerts

Hardware alerts are generated by the Proliant Service Packs installed on the machines in the IAP
system. Generally, hardware alerts require your intervention. They are not cleared automatically,

unless the server where the problem occurred is restarted. All hardware alerts have an alert ID of
HOO1.

Each hardware alert provides a link to the server's HP System Management Homepage, where more
information can be found. See “Hardware monitoring” on page 50.

Hardware alerts are not supported and do not appear in virtual IAP environments.
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Current Platform Alerts (Software Alerts: 0, Hardware Alerts: 1, Total: 1)
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need replacement.
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Figure 4 Sample hardware alerts

Clearing alerts

Alerts are maintained as runtime information. They are only generated once, when the problem first
occurs. They can be cleared in one of three ways:

* The problem is resolved; the system observes that the problem is resolved; and the alert is cleared
automatically from the PCC Overview page. (Applies to application alerts only.)

* A server is restarted; it notifies the PCC that it has restarted; and it requests the PCC to remove
any alerts previously raised by it.

* The problem is resolved manually. You can resolve the problem and then manually clear the alert
on the PCC Overview page by selecting the check box in front of the alert and clicking Clear
Checked Alert(s).

® IMPORTANT:

Use caution when clearing an alert manually, as the system does not perform any verification that
the problem is actually fixed. The assumption is that you know the problem does not exist anymore.

Platform Performance

This area of the overview provides information from the Storage Status page (see “Storage

Status” on page 46). The table on the left displays the number of objects (documents) stored, the
amount of used and total disk space, the document storage rate, and the document index rate for
each domain. The bar graph displays the system's storage space ratio. The line graph on the right
shows the messages per second that the system stored and updated in the past day, ending with the
current time, as well as the amount of folder updates.

Account Manager Service

The Account Manager Service provides a brief summary of information from the PCC Account Manager
(see “Account Manager (AM)” on page 73). This area displays the number of individual IAP users
and groups, pending users and groups, and the number of IAP repositories. (Groups are not currently
supported, so the number is always 0.) This area also displays the number of synchronization errors,
if any, pertaining to IAP user accounts. Synchronization errors can be corrected in the Error Recovery
page (see “Account Error Recovery” on page 87).
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CatchAll and Partially indexed objects

This area of the Overview displays the following information:

*  CatchAll Objects: The number of documents in the CatchAll repository. This repository contains
documents that fail to route into the correct user repositories because they cannot be associated
with:

* Email addresses of registered IAP users imported by DAS
* A domain routing rule

Mailing-list messages cannot be routed if the recipient's name is not included in the message as
a destination.

The CatchAll repository can be viewed in the Account Manager (see “Account Manager
(AM)” on page 73 by clicking the Repository radio button in AM, clicking the Other tab, then
opening the CatchAll repository.

*  Partially Indexed Objects: The number of documents in the failed indexing repository. This repos-
itory contains documents that failed to be indexed or were partially indexed. (For example, the
system might not have been able to index the particular file type.) The failed indexing repository
can be viewed in the Account Manager (see “Account Manager (AM)” on page 73. Click the
Repository radio button in Account Manager, click the Other tab, then open the failed indexing

repository.

The CatchAll and failed indexing repositories are automatically created when the system is started.

B NOTE:

If the number of documents shown is -1, the values cannot be read by the system.

Platform Statistics

The Platform Statistics area provides status, health, and storage information about the IAP Smartcells.
You can click a tab to view information about Smartcells in all domains or Smartcells in a particular
domain. The Platform Statistics area also shows the IP addresses of free Smartcells in the system.

Each Smartcell's life cycle state is color-coded.

A green table row indicates a Smartcell is ASSIGNED.
A light green table row indicates Smartcell is CLOSED.
A yellow-orange table row indicates a Smartcell is in the COMPLETE_PROCESSING or RESTORE

state.

A light yellow table row indicates a Smartcell is in the DISCOVERY or RESET state.
. A red table row indicates a Smartcell is SUSPENDED.
. A black table row indicates a Smartcell is DEAD.

. A gray table row indicates the state of a Smartcell is UNKNOWN.
See “Smartcell life cycle states” on page 38 for more information.

The icon at the beginning of the table row displays the JBoss status of the Smartcell.
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¢ @ A green check icon indicates the Smartcell is healthy, and both machine and JBoss are up.

* & A yellow icon indicates the Smartcell is unhealthy. The machine and JBoss are up, but there
are some failed and/or unhealthy MBeans.

* & A red X icon indicates the Smartcell is down. Either the whole machine or JBoss is down.

* [d A gray icon indicates that service monitoring failed. The server status is unknown.

¥ TIP:

If you move your mouse over the icon, you will see more information including the host name, active
thread count, and the Smartcell's MAC address.

Platform Statistics features

Table 9 Platform Statistics features

Feature Description

Platform The platform name, IP address, and document storage rate.

Domain The name of the domain.

Group Name OACEOTSZEGSIL,(;;O;E_ identifier generated automatically by IAP. This number is unique
Smartcell IP The IP address of the Smartcell.

Smartcell Role

A Smartcell can be Primary, Secondary, Replica-1, or Replica-2.

State

The current life cycle state of the Smartcell. See “Smartcell life cycle
states” on page 38.

Stored Obiject(s)

The number of objects stored since the Smartcell was assigned.

NOTE:

When the system is actively storing objects, this count might be different than
the stored object count in “Platform performance” on page 43. This number
is the real-time count on the Smartcell, while the Plattorm Performance count
(taken from the local database) is only updated every minute.

Indexed Obiject(s)

The number of objects indexed since the Smaricell was assigned.

Store Rate The number of objects being stored per second.
Index Rate The number of documents being indexed per second.
Index Queue The number of documents waiting to be indexed.

Index Deletion Queue

The number of indexed documents waiting to be deleted.

Update Queuve

The number of documents waiting to be updated. (For example, email folder up-
dates.)

Other Smart Cells

IP addresses of Smartcells in the FREE state.
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IAP Version

Near the bottom of the Overview, you will find information about the IAP software version code
installed.

SMTP Flow Control

At the bottom of the Overview, the SMTP Flow Control area shows the following information, by
domain:

e The maximum number of connections allowed
e The current number of connections

e The number of archiver connections

Storage Status
The Storage Status page provides detailed object storage information for each domain.
To open the page, go fo Storage Status in the left menu.

Table 10 Storage Status features

Feature Description

The number of objects and store rate per domain, and the allocated space on the
system for storage and replication.

The dark area on the right side of the example storage bar graph below shows the
point at which storage space is 90 percent full. The dark area typically represents
the amount of disk space reserved for work space for the Smartcell maintenance
tasks.
Enigma local sllocated storage: jr;
Platform Store “

@ =

0% (6454 MB of 1 63 TB are used)

NOTE:

The storage bar graph shows only assigned and allocated Smartcells for all
active domains. The IAP might have free, unallocated hardware that is not
represented in the bar graph.

A line graph showing the number of messages per second that the system stored in
the past day, ending with the current time. It also shows the amount of folder updates.

Example:

Store Rate (Appliance)

[ ]

Store Rate Graph

Store Rae

25-Apr, 0008 25=Apr, 1 2:09
Time

Store Rate (Appliance)
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Feature Description

The number of Smartcells in each life cycle state. (See “Smartcell life cycle
states” on page 38 for an explanation of each state.)

Example:

2 assigned

Smart Cell Allocation

The domain group ID, the number of objects stored, the amount of used and total

Domain Details storage space, and the disk/space ratio, shown in bar graph format.

Software Management

Use the Software Management page to view the status of all IAP servers that are running JBoss, and
to start, stop, or restart the applications on one or more of the IAP servers.

This page is useful to show the software status of a server. However, you should use the
start/stop/restart functions only when necessary — for example, when you are upgrading a server
or before a planned power outage.

To open the page, go to Software Management in the left menu.

Software Management features

The following information is displayed on the Software Management page.

Table 11 Software Management features

Feature Description

The type of host group, the servers in the group, and the full name of each server.
Host group types include the following:

* BACKUP Servers: Backup servers

e CLOUD ROUTER Servers: Cloud router servers
* DB Servers: DB2 database server

*  FIREWALL Servers: Firewall servers

* HTTP Servers: HTTP portal servers

Hostname * KICKSTART Servers: Server for loading and deploying system software/configur-
ation files

* LOAD BALANCER Servers: Load Balancer servers

e PCC Servers: Platform Control Center server

*  META Servers: Metaservers

*  SMARTCELL Servers: Servers to store archived documents
o SMTP Servers: SMTP portal servers

The Archive Gateway does not use JBoss in IAP 2.1 and later versions, so is not
shown on the Software Management page.
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Feature Description

The status icon in front of the host name displays the JBoss status of the server.

2 A green check icon indicates the server is healthy, and both machine and
JBoss are up.

% A yellow icon indicates the server is unhealthy. The machine and JBoss are

Status icon up, but there are some failed and/or unhealthy MBeans.
* & A red X icon indicates the server is down. Either the whole machine or JBoss
is down.
* [ A gray icon indicates that service monitoring failed. The server status is un-
gray 9
known.
IP Address The server's IP address.

The status of the server. Corresponds to the icon in front of the server in the Hostname

Status
column.

Starting, stopping, and restarting servers on the system
To stop, start, or restart one or more servers, follow these instructions:
1. Select the machine(s) on which the action will be performed:

* To perform an action on all servers or all machines in a server group, click the Machine Type
radio button and select the servers from the drop-down list.

* To perform an action on specified machine(s), click the Selected Machine(s) Below radio button,
and then select the check box in front of the machine(s).

B NOTE:

Because the PCC server hosts the user interface, it is not listed in the Machine Type list and
cannot be selected if you specity Selected Machine(s) below.

2. In the Action drop-down list, select the action to perform:

* Start: Start a single machine, start all machines, or start all machines in a selected server
group.

* Stop: Stop a single machine, stop all machines, or stop all machines in a selected server
group.

* Restart: Stop and immediately start a single machine, or stop and immediately start all ma-
chines or all machines in a selected server group.

* Staggered Restart: Restart all machines in sequence, or all server group machines in sequence,
with a minimum of downtime.

3. Click Run Now.
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Hardware Management

B NOTE:

In virtual IAP environments, this feature is not supported and the Hardware Management page does

not appear.

Use the Hardware Management page to view the servers that are part of the IAP infrastructure and
links to their corresponding HP System Management pages and Remote Management ilO pages (if
enabled). (See the IAP Administration Guide chapter “Remote management of servers” for more
information about remote management.)

To open the page, go to Hardware Management in the left menu.

Hardware Management features

Table 12 Hardware Management features

Feature

Description

Hostname

The type of host group, the servers in the group, and the full name of each server.
Move your mouse over the status icon fo view a server's [P address.

Host group types include the following:

*  ARCHIVEGATEWAY Servers: Archive Gateway (email mining) servers
*  BACKUP Servers: Backup servers

*  CLOUD ROUTER Servers: Cloud router servers

* DB Servers: DB2 database server

*  FIREWALL Servers: Firewall servers

o HTTP Servers: HTTP portal servers

* KICKSTART Servers: Server for loading and deploying system software/configur-
ation files

* LOAD BALANCER Servers: Load Balancer servers

e PCC Servers: Platform Control Center servers

*  META Servers: Metaservers

*  SMARTCELL Servers: Smartcell servers to store archived data
o SMTP Servers: SMTP portal servers

Status icon

The icon in front of the host name displays the hardware status of each server.

£ A green check icon indicates there are no hardware alerts for the server.

€3 A red X icon indicates there is at least one hardware alert for the server.

Move your mouse over the status icon to display the number of alerts. To view
the alerts, navigate to Current Platform Alerts on the PCC Overview page.

MAC Address

The server's MAC address.

System Management

Click View to link to the HP System Management Homepage on the server, which
displays the server hardware status and other data.

For more information, see Hardware monitoring below.
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Feature Description

Shows whether iLO/Lights-Out 100 is set up on the server and configured in Proxy
Access Mode.

Remote Management | If remote management is enabled, a Manage link appears. Clicking the link displays
the iLO or Lights-Out 100 Web interface and allows you to perform operations such
as power cycling the server.

Hardware monitoring

You can monitor IAP hardware health from either the PCC user interface, the HP System Management
Homepage on every server, or (if available) an HP System Management console. Hardware monitoring
for IAP servers is provided by Proliant management agents. We include the standard HP Proliant
hardware management and system homepage agents as part of the IAP software. The management
agents provide SNMP support for hardware monitoring by way of SNMP traps.

A standalone IAP Proxy Agent running on PCC aggregates SNMP hardware traps from the Proliant
agents on the IAP servers. The agent is used for SIM discovery and trap forwarding

SIM discovery: The IAP Proxy agent responds to SNMP get requests from external SIM servers on the
PCC external network IP address. An external SIM server needs to be configured to identify IAP
appliances. The IAP appliance is displayed in the SIM console with the IP address as the PCC external
network IP address.

Trap forwarding: The proxy agent listens for SNMP traps from the individual IAP servers.

*  SIM: Once discovered in SIM, the proxy agent in the PCC server must be configured with the SIM
server's IP address for trap forwarding. Any number of external SIM servers are supported. The
SIM server displays traps received from the IAP Proxy agent as long as the source address is the
IAP appliance address: the PCC's external IP address. The proxy agent modifies the traps received
from the IAP servers by setting the source address to the PCC external address before forwarding
the traps to SIM servers.

* PCC: The IAP proxy agent loads known MIB definitions used by the Proliant agents in order to
parse the SNMP traps and retrieve source and description information. The IAP Proxy agent for-
wards the traps in the form of IAP alerts to the PCC, where they are displayed in the Current
Platform Alerts log at the top of the Overview page. A link to the System Management Homepage
for the IAP server is displayed in the alert context.

The Proliant management agents monitor hardware components such as storage (raid controllers and
disks), server (CPU, memory, temperature, and power), and NICS. The full list of hardware traps is
shown in the documentation for the Proliant Support Packs: http://bizsupport2.austin.hp.com/bc
docs/support/SupportManual/c00760188/c00760188.pdf.

Other information is included in the Proliant support pack user and installation guide: http://
bizsupport2.austin.hp.com/bc/docs/support/SupportManual/c01527454/c01527454.pdf

Since hardware monitoring of IAP servers is dependent on the Proliant management agents, the
hardware requirements are tied to the minimum requirements for the Proliant Support Packs. See the
IAP Support Matrix for more information.

Log messages from the IAP Proxy agent are stored in the proxyagent . log files in the /opt /tools/
snmpProxyAgent/ directory on the PCC server.
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SIM Console

It you use the HP SIM Central Management Server (CMS), it can recognize the IAP appliance via
SNMP from the SIM console, using the PCC external IP address. Once configured to identify IAP
appliances, the SIM console displays the IAP as a single managed system as shown below.

All Systems
Systemi(s) Guiick Laurich...
Yiew as: |t&hle "l

[T Select Al Systems"® itself

Summary: €30 Critical ¥ 0 Major /0 Minor 5 Normal £ 4 Disabied @ 0 Unknown Tatal @
HS | MP Isw ES |SystemMName * |System Type |System Address | Product Name

5 o W 15188248218 Cluster 15186248218 L&p

= A, 15186251148  Cluster 15186251148 &P
Figure 5 SIM Console

The ES column indicates the event status of the IAP, which is the most severe event or trap that has
been received. The trap detail contains information about the actual IAP server that originated the
trap.

® IMPORTANT:

The addresses of SIM servers must be manually configured in a text file to enable trap forwarding
from the proxy agent. For trap forwarding, create or use the file /opt /tools/snmpProxyAgent/
conf/ProxyAgent .properties and add the following line: trapsink=<sim server ip>

(for example 192.168.50.59).

Clicking the IAP System Name brings up the System Homepage as shown below.
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15.186.248.218 (1AP)

System Tools & Links Ol Cuick Launch...

) Health Status

151686 248218
Preferred System Hame 15186 24818
Hetwork MHame 15186248 18

Management Pratocols HTTP:, S4H 2.0, SSH:SSH-1 99-OpenSSH_4.3
B contact Information

Figure 6 System Homepage

The events received from the IAP can be seen by clicking the Events tab. This brings up the events
table. Trap detail can be obtained by clicking the Event Type. The detail includes the IAP server that
was the source of the trap.

15.186.248.218 (1AP)

To view sverd debais, nshe sure Evert Typs! colimn is dispiayed and cick an desied ik,

Summary: €31 Crtical W 13manr A omnor dhoweming 91 normal E107 Intormationst Totsk 122
B iﬁ'm: | Sewerity | Event Type ':;y:a_t-!-.r!j Hame | Event Time 4 iAsaiﬁnﬂd To i Crmments:
N . PN T R e e o P ol e, : SEREL,
™ hotclesred 4] il Shart 151BE MG 4HSNSS09FM
[T Maleleasd e Logical Drive Stalus Changs (300B) 1518848218 4509126
™ Motcleassd ¥ Generic tra (11003 15186243218 AMANS1035 AM

Figure 7 IAP events

The SIM documentation describes the use, configuration, and user interface of the HP SIM server
apart from the specific use to monitor the IAP:

* HP SIM installation and configuration guide for Windows installations:
http://docs.hp.com/en/418812-005/418812-005.pdf

* HP SIM installation and configuration guide for Linux installations:
http://docs.hp.com/en/418811-004/418811-004.pdf
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Performance Graph

Use this page fo create graphs showing different types of system events over specified time periods.
You can generate two categories of graphs:

¢ System monitoring graphs that show idle CPU usage, free memory usage, or the number of threads
used.

*  Platform store and indexing graphs that show the number of objects stored or indexed on the
system, and the rate at which objects are stored or indexed per second.

Table 13 Performance Graph features

Feature Description

Graph Type The type of graph or the server name.

Assigned Smartcell or

Domain The platform, domain, or Smaricell to be graphed.

Time Frame The time period being reported.

To open the page, go to Performance Graph in the left menu.

Example: Platform Store graph

An example of a platform store or indexing performance graph is shown below. This graph charts
the Domain1 store rate for today at five minute intervals.

Store Rate (demainl)

T

Figure 8 Performance Graph: Store Rate
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Example: System Monitoring graph

An example of a system monitoring performance graph is shown below. This graph charts the free
memory on the database server at hourly intervals over the past 24 hours.

Database Server (10.0.99.1)

95,259,000
45,004,000

94,758,000

Frae Mamory

44,544,000

94,250,000

12:%0 L3:00 1318 B30 13:39
Tirne

| Database Sarver {10.0.39, 1:-1i

Figure 9 Performance Graph: Free Memory

Creating performance graphs
1. Click the System Monitoring tab or the Platform Store and Indexing tab for the category of graph
that you want fo create.

2. Select a graph type:

* For Platform Store and Indexing, select one of the following:
* Store Rate (Obijects/Sec)
* Store Rate (MB/sec)
* Index Rate
*  Obiject Count
* Index Count
* Active Transactions
* Update Rate (Objects/Sec)
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* For System Monitoring, select one of the following:
* Idle CPU
Percentage of the CPU that is idle.

*  Free Memory

Percentage of the amount of free memory in the Java virtual machine vs. the total amount
of memory in the Java virtual machine (same as JVM Heap Free / JVM Heap Total)

* JVM Heap Total
The total amount of memory in the Java virtual machine.

* JVM Heap Used

The total amount of memory in the Java virtual machine minus the amount of free memory
in the Java virtual machine (same as JVM Heap Total — JVM Heap Free).

* JVM Virtual Memory Used

The amount of virtual memory the JVM processes were using, in bytes. (Includes the amount
in RAM and in the swap memory.)

* 10
The percentage of disk resource (I/O) utilization for all main disks on the system.

* Active Thread Count
Number of Java threads that JBoss was running at the time.

Select one of the following options:
* Machine Type (System Monitoring graphs): Select the type of machine (for example, PCC
Servers or SMTP).

* Assigned Smaricell/Domain (Platform Store and Indexing graphs): Select Entire Platform, the
domain name, or the Smartcell IP address.

Select the time frame and reporting inferval:
* Time Frame: For a preselected time period, click Select Time Frame, and select a time frame
from the drop-down list.

* From Date, To Date: For a custom time period, click Custom Time Range, and select the start
date and time and end date and time. The custom time range can be useful for troubleshooting.

* Interval: Select the reporting interval from the drop-down list.
Click Generate Graph.
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4 Configuration

This chapter contains the following information:

¢ Platform Settings, page 57
¢ Firewall Settings, page 58
* SSL Configuration, page 58
* Software Version, page 62
* Software Update, page 62

Platform Settings

The Platform Settings page is an administrative fool that displays configuration information about the
IAP.

This page is divided into two parts:

* Information about the services enabled in each domain is in the upper portion of the page.
¢ Information about the IAP configuration is in the lower portion of the page.

To open the page, go to General Configuration > Platform Settings in the left menu.

Domain Configuration

The upper portion of the Platform Settings view shows information about each domain. It includes the
domain type (Exchange or Domino), the services that are enabled (for example, indexing, replication,
folder support, compliance, and data backup), supported object (document) types, and retention
period(s).

The domain configuration information is drawn from the Domain. jcml configuration file.

Virtual IPs and Type: -j 15.186 248 162 can siore from ME Exchange
Supported Object Type: 54 Emails - | Documents
LOAP User Management:  WEnabisd
Indexing Service:  WEnabled
Replication Senice: K Dizabled
Default Domain Retention Period: ¥ Enabled 30 days (Reguisted: 207 unreguiated: 20)
RetentionBasis: ingesiDade
Duplicate Filtering:  #Enabiec
AuditLog Service:  WEnsbied
Tape Backup:  ¥Enabled
Admin Delete Service:  KDizableg
Folder Support:  W{Enabied

Figure 10 Domain Configuration
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Platform Settings

The lower portion of the Platform Settings page displays the setup details for the IAP. This information
is taken from the BlackBoxConfig.bct file.

Firewall Settings

The Firewall Settings page shows the firewall status and settings for the PCC server and the IAP HTTP
portals, and their virtual IP (VIP) addresses.

It includes the following information:

Table 14 Firewall ports

Feature Description

Virtual IP The virtual IP address.

Port The port number.

Service The service running on the port.

Type The transfer protocol used on the port: TCP or UDP

Inbound,/Outbound Shows if thg firewall is ™ eno.blgd or disabled on the port's inbound and out-
bound traffic. Outbound traffic is not filtered on the PCC server ports.

To open the page, go to General Configuration > Firewall Settings in the left menu.

SSL Configuration

SSL, or Secure Socket Layer, is a technology that allows web browsers and web servers to communicate
over a secured connection. This means that the data being sent is encrypted by one side, transmitted,
then decrypted by the other side before processing. It is a two-way process, meaning that both the
server AND the browser encrypt all traffic before sending out data.

The SSL Configuration page lets you generate certificate signing requests (CSRs), and corresponding
private keys, for secured connections on the IAP. You can create two types of CSRs: one for access
to the PCC portal, and one for access to the HTTP portals.

After generating the CSRs, see “Installing a third party certificate on the PCC portal” on page 60 and
“Installing a third party certificate on the HTTP porfals” on page 61 for the steps needed to complete
the process.

The SSL Configuration page contains two areas. The top area shows any current certificate signing
requests in the system. The bottom area contains a form to complete to generate a certificate signing
request (CSR) and RSA private key.

To open the page, go to General Configuration > SSL Configuration in the left menu.
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Available certificate signing requests

Table 15 Available certificate signing requests (CSRs) in the IAP

Feature Description

Machine Type

The host for which the CSR has been generated. The host is either a PCC or HTTP

portal.
Virtual IP The virtual IP address of the host.
Creation Date The date the CSR was created.
Path The path to the CSR. The CSR files are always placed on the PCC host.

Creating a certificate signing request

To create a certificate signing request (CSR):

1.

Complete the form at the bottom of the SSL Configuration page.

You can create only two types of CSR files: one for access to the PCC, and one for access to the
HTTP portal machines.

Click Generate CSR.

To install a certificate on the PCC portal, see “Installing a third party certificate on the PCC
portal” on page 60.

To install a certificate on each HTTP portal, see “Installing a third party certificate on the HTTP
portals” on page 61.

B NOTE:

If you enter incorrect information in the form and need to generate a new CSR, see “Deleting a
certificate signing request” on page 59 for the procedure to follow.

Deleting a certificate signing request

After a certificate signing request (CSR) is generated for the PCC or HTTP portals, it cannot be
regenerated. If you have entered incorrect information in the certificate request, the file must be
manually deleted before you can create a new CSR in the SSL Configuration page.

To delete a CSR:

1.
2.

Log in to the PCC console.

Go to /opt/keys and delete the CSR with one of the following commands:
# rm -f pccCert.pen (fo remove the PCC certificate request)

# rm -f httpCert.pem (fo remove the HTTP certificate request)

Upon deleting pccCert . pemand/or httpCert . pemin directory /opt/keys, log off or close
the PCC UL. If you do not, refreshing the PCC Ul will re-create these files, and the <SSL
Configuration> page will not allow new CSRs be created.
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® IMPORTANT:
Important! Do not delete the private key files (occkey.pem or httpkey.pem).

B NOTE:

After deleting pccCert.pemor httpCert.pemin /opt/keys, be sure to log off or close the
PCC UL If you don't and refresh, the PCC Ul will re-create these files. (The SSL Configuration page
will also not allow new CSRs be created.)

Installing and generating a certificate on the PCC portal

Follow these steps to generate and install a certificate for the IAP PCC portal.

1.

60

Create a certificate signing request (CSR) for the PCC:

Log in to the PCC Web interface and go General Configuration > SSL Configuration.

b. Complete the CSR generation form.

C.

Log out of the PCC Web interface.

This generates two files on the PCC:

# /opt/keys/pccCert.pen (the certificate request)
# /opt/keys/pcckey.pem (the RSA private key)

Manually copy the certificate request file to your local machine:

#

scp root@<external ip address of PCC>:/opt/keys/pccCert.pem

Send the certificate request to a certificate authority (CA) such as VeriSign for signing.

Follow the instructions provided by your CA.

Import the certificate you receive from the CA into the IAP PCC:

Store the certificate from the CA on your local machine (for example, as
pccCertSigned.pem).

Copy the certificate to the PCC:

# scp pccCertSigned.pem root@<external ip address of PCC>:/opt/
keys/pccCertSigned.pem

Import the certificate into the PCC's Apache server:

#

/usr/local/bin/ssl cert update.pl --pcc --cert /opt/keys/

pccCertSelfSigned.pem --key /opt/keys/pcckey.pem

Restart the PCC's Apache server by issuing the following command:

#

/etc/init.d/httpd restart
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Installing and generating a certificate on the HTTP portals

Follow these steps to install a certificate on the IAP HTTP portals.

1.

Create a certificate signing request (CSR) for the HTTP portals:

Log in to the PCC Web interface and go General Configuration > SSL Configuration.

b. Complete the CSR generation form.

C.

Log out of the PCC Web interface.

This generates two files on the PCC:

/opt/keys/httpCert.pm (the certificate request)
/opt/keys/httpkey.pem (the RSA private key)

Manually copy the certificate request file to your local machine:

# scp root@<external ip address of PCC>:/opt/keys/httpCert.pm

Send the certificate request to a certificate authority (CA) such as VeriSign for signing.

Follow the instructions provided by your CA.

Import the certificate you receive from the CA into the IAP PCC:

Store the certificate from the CA on your local machine (for example, as
httpCertSigned.pemn).

Copy the certificate to the PCC:

# scp httpCertSigned.pem root@<external ip address of PCC>:/opt/
keys/httpCertSigned.pem

From the PCC console:

Import the certificate into the Apache server on each HTTP portal.

# /usr/local/bin/ssl cert update.pl --http --cert /opt/keys/
httpCertSelfSigned.pem —--key /opt/keys/httpkey.pem

Restart all services on the HTTP portal by issuing the following command:
# /opt/bin/restarthttp

(You can also restart the services using Platform Control in the PCC Web interface. See
“Software Management” on page 47.)
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Software Version

This page shows the software version that is used by hosts in the system, and any software updates
that have been installed.

Table 16 Software Version features

Feature Description
Software Version IAP software version code installed.
Patches Applied History of IAP software patches (updates) applied to the system.

To open the page, go to General Configuration > Software Version in the left menu.

Software Update

The Software Update link will connect you to the IAP tool which allows you to install patches. To open
the page, go to General Configuration > Software Update in the left menu.
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5 Account Synchronization

Use this page to configure dynamic account synchronization (DAS), which automatically creates and
updates email user accounts on the IAP. You can define multiple configurations that track sets of users

from one or more LDAP servers for specific IAP domains.

B NOTE:

This chapter contains a DAS example for EAs for Exchange. EAs for Domino administrators will find

information on DAS in the EAs for Domino Administrator Guide.

* Account Synchronization overview, page 63

* Creating and running DAS jobs, page 63

* Editing or deleting jobs, page 69

* Managing available HTTP portals, page 70

* Editing or deleting available LDAP connections, page 70
* Viewing DAS history logs, page 71

To open the page, go to User Management > Account Synchronization in the left menu.

Account Synchronization overview

The Account Synchronization page is divided into three areas.

* The DAS Available Jobs area lists all jobs created and assigned to an HTTP portal.
* The LDAP Server Connectors area lists available LDAP connections.
¢ The Jobs History Logs area shows the history of DAS job runs.

Creating and running DAS jobs

The basic steps for creating and running a DAS job are as follows:

1. Create an LDAP connection. See “Creating LDAP server connections” on page 63.

2. Create the job. When you create a new job, you assign the job a name and an LDAP connection,

and set up the job query in the LDAP server. See “Creating jobs” on page 64.
Assign the job to an HTTP portal. See “Assigning HTTP portals” on page 67.
4. Run the job. See “Starting, scheduling, and stopping DAS jobs” on page 68.

Creating LDAP server connections
To create an LDAP connection:

1. In the LDAP Server Connectors areq, click New LDAP.
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2.

Complete the form to create an LDAP service connection by entering the following information:

Connection Hane ]ﬂch yexchLDAP

Host llame  [10.11.1
Binder user ]mnﬁ.drnini..-"trmur

Binder pswil ||uu|
Directory Server type  |Microsoft Active Dirschory = |
Security Option Im
Paort Iﬁ

Figure 11 New LDAP connection

* Connection Name: Name used to identify the LDAP connection.
e Hostname: IP address of the LDAP server.

* Binder user: User in the LDAP directory tree that you want to bind to. At a minimum, the user
must have read access to all users objects. For example: cn=Administrator, cn=
Users,dc=hostname, dc=com.

* Binder pswd: Password of the Binder user.

* Directory Server type: Type of LDAP server to which you are connecting: Microsoft Active
Directory

* Security Option: Type of LDAP security: simple authentication or SSL.

* Port: Open LDAP port of the LDAP server. Use the port 389 for simple authentication. Use
port 636 for SSL support.

To test the LDAP server connection before creating it, click LDAP fest.

A content pane displays the status of the LDAP connection. It tells you whether the connection
and bind are successful and the authentication types that are supported by the LDAP server. Errors
are displayed in red.

Click Create.

Return to the Account Synchronization page and verify that the new LDAP server connection is
listed under LDAP Server Connectors.

Creating jobs
To create a DAS job:

1.
2.
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In the DAS Available Jobs area, click New JOB.

Name the job you are creating by entering it in the Job Name box. (In addition to the characters
noted below, the name can contain no spaces.) Click Next Step.

Job Name: | dom1 CFG |
{the field canpot be blank orcoptain g @E B &R IS+ 10~ = |V character)

Figure 12 Create DAS job

From the drop-down list, select the LDAP connection you want to use with the job.

The LDAP connection must already be created. For more information, see “Creating LDAP server
connections” on page 63.
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Click Next Step.

The Mapping Information form appears.

Configuration Wizard: Mapping Information

Parameter Va
Job D | domiCFG
LOARP Domain Hame ichyexch.com
LDAP Job Starting Point |~ |cn=Users de=itchyexch,dec=com
4P Damain ID I domant :]

Detele Startng Point lcn-{!eic-:eﬂ objects de=itchyexch,dc=com I

Advanced Opbans _|I:I|

Figure 13 Mapping information
Complete the form by entering the following:

* LDAP Domain name: Domain to which the users belong. For example: itchyexch.com.
* LDAP Job Starting Point: Root node where the user accounts are stored. Example:

For Exchange, enter cn=Users, dc=itchyexch, dc=com for node Users in domain
itchyexch.com. The value must specify the relative location in the LDAP tree, including
parent nodes and domain name. (Another example is ou=stest, dc=sandbox2k 12, dc=
com where ou is the organization name in the exchange.)

* |AP DomainID: The IAP domain ID (not the domain name) where users are synchronized with
users on the LDAP server. This is the same as the domainID set in Domain.jcml.
* Delete Starting Point: The root node where deleted user objects are stored on the LDAP server.

Example: For Exchange, enter cn=deletedObjects, dc=itchyexch, dc=com for node
deletedObjects in domain itchyexch.com. The value must specify the relative location
in the LDAP tree, including parent nodes and domain name.
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6. Click the Advanced Options icon (2]) and complete the advanced options.
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Figure 14 Advanced options

USNChanged: Active Directory's unique sequence number (USN). Active Directory increments
the USN for each change in any of its user accounts. When DAS finds a larger USN, it extracts
new information. For initial setup, set USNChanged to 1 so DAS extracts all users. Thereafter,
do not change this value.

Delete USNChanged: USN in deleted users directory. This is the same as USNChanged but

for deleted objects. For initial setup, set this value to 0. Thereatter, do not change this value.

This value must be set to O the first time the mapping is set up.

NextReplID: IAP repository ID assigned to new users. DAS retrieves this value from the database,
but you can use this feature to specify the repository ID for the first user inserted when DAS
runs. For example, if you enter 67, the repository created and assigned for the first imported
user is ROOO0067. You can use this feature if users already exist in the system or to reserve
repository IDs for any reason. If you specify a value that is lower than an existing repository
ID, DAS automatically changes the value to the next higher number. The default is set to 5.
Audit Repository: Do not change.

Update LDAP filter: Criteria to include or exclude specific users. For example:

For Exchange, use at least the default, (objectclass=user) (mail=*), which excludes
users who do not have email accounts.

LDAP Query return attributes: List of return attributes. Example:

For Exchange, use the default attributes unless your LDAP schema requires mapping changes.
Delete LDAP Filter: Criteria to include or exclude specific users in the LDAP deleted users dir-
ectory. Add to the default for special cases.

LDAP Attribute to Map to Username: Active Directory attribute that will be mapped to users’
username. The attribute that is selected will be the webui username login name. You may use
Active Directory fields sSAMAccountName, userPrincipalName or mail as the IAP username

mapping.

B NOTE:

It is no longer necessary fo modify the LoadChanges . dse file on the HTTP portal to perform
the username mapping.
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7. Click Next Step.

A status page appears, stating that the mapping has been updated for the new job.

You are asked if you want to attach the job to a HTTP portal.

Click Assign Job to continue, then follow the instructions in Assigning HTTP portals below.

If @ HTTP portal is not available for the new job because it is being used for another job, click
Back to Main Page, and unassign the HTTP portal. See “Unassigning and reassigning a
portal” on page 68 for the steps to take.

Assigning HTTP portals

Before running a DAS job, assign a HTTP portal on which to run the job. Only one job can be assigned
to a HTTP portal. These steps are performed in the DAS Available Jobs area of the Dynamic Account
Synchronization page.

Assigning a portal

When you click Assign Job after creating a new job, the Assign a Job page appears:

Assign a Job to a HTTP Portal

Assignment Value
Job Name  domiCFC

DAS Server I I 10.0.71.1 "l"l

Configuration Enabled @ ves O g

Configuration Running State |I:| |
Period (minutes) |EI ]

DAS Server Running State | |

Save ] back Toman page

Figure 15 Assign a job to a portal

Complete the form to assign a HTTP portal to the job.

1.

Enter the following information:

DAS server IP: IP of the DAS HTTP portal where DAS runs the configuration.

Configuration Enabled: Select Yes to enable. If not enabled, the job cannot be scheduled or
started with this console.

Configuration running state: Do not change.
Period: Number of minutes between job runs. Enter 0 to run the job once.
DAS server running state: Do not change.

Click Save.
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Unassigning and reassigning a portal

It all HTTP portals are being used for other jobs and none are available for a new job, reassign a
HTTP portal from another job.

To reassign a HTTP portal:
1. Select an existing DAS job in DAS Available Jobs, and then click Unassign HTTP.
2. Select the new job.

The Job Update page appears.

Job Name dom1CFG
LDAP Server Name AchyexchLDAP

Mapping Domain  fchyexch.com
LDAP Starting Point  cnelisers desfchyexch des=com

HTTP Server
State

Figure 16 Job Update page

3. Click Edit in HTTP Server State.
The Assign a Job page appears.

4. Complete the form by following the instructions in Assigning a portal.
Start the job by following the instructions in the next section.

The DAS setup must be initialized whenever a new HTTP portal is assigned to a job.

Starting, scheduling, and stopping DAS jobs

If you are running DAS for the first time or have assigned a DAS job to a new HTTP portal, follow
these steps:

1. In DAS Available Jobs, select the job and click Stop/Start.
The job control page appears.

2. Schedule the job:
a. Click Schedule.
b. Enter the number of minutes between job runs.

To run a job once, enter 0. To run a job continuously, set the interval so that it is equal to
or greater than 60 minutes.

c. Click Confirm Schedule to save your changes.

You are returned to the job control page.
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5.

Click Yes in Initialize DAS setup.

inttialize DAS setup: & vas O o
Launch the Selected Job:

Set the Job Sehedule:

Stop the seleciad Job:

Figure 17 Initializing DAS setup
Click Start.
A notice appears stating that the job started successfully.

Click Back to Main Page.

To start a DAS job when DAS has already been initialized and the HTTP portal has not changed:

1.
2.

4.

Select the job in DAS Available Jobs.
Schedule the job if you have not already done so:
a. Click Schedule.

Enter the number of minutes between job runs.

To run a job once, enter 0. To run a job continuously, set the interval so that it is equal to
or greater than 60 minutes.

c. Click Confirm Schedule to save your changes.
Click Start.

If necessary, click Back to Main Page.

To stop a DAS job from running:

1.
2.

In DAS Available Jobs, select the job, and then click Start/Stop.
In the job control page, click Stop.

A notice appears stating that the job has stopped. When the DAS job is stopped, DAS will
unschedule itself and will not run the DAS job any more. (A currently running DAS job will not
stop.)

Click Back to Main Page.

Editing or deleting jobs

To edit an active or configured DAS job:

1.
2,
3.

In DAS Available Jobs, select the job and click Edit.

Make any changes needed for the job mapping.

Click the Advanced Options icon (I8l) to edit any advanced options.
See “Creating jobs” on page 64 for information about job options.
Click Update.

A confirmation page appears.
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5. Click Assign Job and ensure that a HTTP portal is selected and the configuration is enabled.

If you are changing the HTTP portal on which a job is running, select the new portal from the
drop-down list.

Click Save.
If you changed the HTTP portal for the job:
a. Click Back to Main Page.
b. Follow the steps in “Starting, scheduling, and stopping DAS jobs” on page 68.
The DAS setup must be reinitialized whenever the HTTP portal is changed.
8. If you did not change the HTTP portal, you can click Back to Main Page or click Run Job to start
the job.
To delete a DAS job:
1. In DAS Available Jobs, select the name of the job to delete.
2. Click Delete.
3. If you are deleting a job without an assigned HTTP portal:
a. In DAS Available Jobs, click the job.
On the Job Update page, click Delete, and then click Delete Job.
c. Click Back to Main Page.

Managing available HTTP portals

To assign or unassign a HTTP portal for a job, see “Unassigning and reassigning a portal” on page 68.

Editing or deleting available LDAP connections

To edit or delete an LDAP connection:

1. In the LDAP Server Connectors area of the DAS page, click the name of the connection you want
to edit or delefe.

To edit the connection, click Edit, complete the form, and click Save.
To delete the connection, click Delete.

4. Click Back to Main Page when you are finished.
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Viewing DAS history logs

The DAS jobs history log provides a list of job runs for each configured active job. The log includes
the job name; the number of IAP users that were added, deleted, and updated; the time between job
runs; the job status; and the date and time the job was completed.

The history also displays the number of IAP groups that were added, deleted, and updated.

To display the history log, scroll down to the Jobs History Log area at the bottom of the Account
Synchronization page.

To display a history of the previous runs for a specific DAS job, click the job name.

To check the status of a job, view the process icon in the State column. For example, the ©*** icon
indicates the job is Complete.

You can also point to the process icon to display the status. If a red X icon is displayed, issues were
found during the DAS run, or errors occurred in the job during its previous runs which have not yet
been repaired using Account Error Recovery. For more information about the issues, check the tooltip
on the status icon, Account Error Recovery Tool, and DAS logs on the HTTP portal.
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6 Account Manager (AM)

Use the Account Manager (AM) page to provision and update user accounts.
This chapter contains the following topics:

*  AM overview, page 73

* Managing user accounts, page 75
*  Managing groups, page 79

* Managing repositories, page 79

To open the page, go to User Management > Account Manager in the left menu.

Account Manager overview

Use Account Manager (AM) to view and update user accounts and repositories for unusual
circumstances on the IAP. Initial setup, and routine addition and deletion of user accounts, occur
automatically through synchronization with Active Directory or the Domino Directory.

IAP archives emails and other documents in repositories — virtual collections of documents associated
with a given user by routing rules (storing) and access lists (retrieving).

Use AM to update accounts as follows:

* Add users not imported through dynamic account synchronization (DAS).
* Change user permissions.

* Give users access to other repositories.

* Add special-purpose repositories such as audit repositories.

* Add or modify routing rules.

* Edit the retention period for some repositories.

B NOTE:

You can view accounts on replica domains, but you cannot use AM to add or edit them. Fields cannot
be edited and action buttons are unavailable when you select a domain that is a replica of another
domain.
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Figure 18 Account Manager page

Ackd Reposilory

Delete Selected

The total number of users and groups for the domain(s) is shown in the upper right corner of the page.

Account Manager features

Table 17 Account Manager features

Feature

Description

Search button

Searches are not case sensitive.

Use the search feature to find users, groups, or repositories.

For users and groups, you can search by email account name.

The search function uses the “Like” SQL database capability. For example, in the

User panel, you could enter jack to match users jackdoe or jacksmith. Entering %doe
would match users jackdoe, janedoe, or maryjanedoe. Entering %ja% would match
users jadams, jackdoe, janedoe, jacksmith, or maryjanedoe.
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Feature Description

Select this check box to display all objects of the type indicated by filter name (user,
All check box group, or repository). For example, select the User filter and All button to show alll
users.

Use to display only names starting with the button letter. Names correspond to the
Ado-Z buttons objects of the current filtered panel.

You can use the search function within the filtered panel.

Select the user, group, or repository radio button to view the corresponding panel.

*  Users (see “Managing user accounts” on page 75) - You can add users, view
and edit user information, change user status and privileges, and remove users
Panels from the system.

*  Groups - Groups are not currently supported in the IAP.

* Repositories (see “Managing repositories” on page 79). You cannot delete existing
repositories.

Click the navigation buttons at the bottom of the page fo:

* Add a repository.
* Add a user.
* Delete a user from the system. Grant or revoke access to a repository

Navigation buttons

Managing user accounts

Open the Users panel to view, add, remove, or change individual user accounts on the IAP.

Adding a user in Account Manager automatically creates a primary repository for the user. It also
adds routing rules and filters for the user's contact email address, and gives the user access to his or
her personal repository.

When the IAP is first installed, a single user (Default) is listed in the Users panel. You can delete this
entry affer users are imported info the system using DAS.

Adding a new user

Users can be added directly to the system using the Account Manager. For example, it is likely that
you will create an IAP administrator directly in the system, rather than granting administrative privileges
to specific users imported by DAS.

Users created in the system and given a local password are known as local users. Users imported by
DAS are known as remote users.

To add a new user:

1. Click Add User at the bottom of the Account Manager page.

2. Complete the Integrated Archive Platform Account and LDAP Information form that appears.
See “User account information” on page 77 for details on completing this form.

3. Click Save Now! to save the user information.
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Editing user information
To edit user information:

1. Click the User radio button, locate the user account that you want to edit, and then click the user
name.

See “Account Manager features” on page 74 for information on searching for a user.

2. In the Integrated Archive Platform Account and LDAP Information form that appears, clear the
check box labeled Deactivate this check box and then edit the user entries.
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Figure 19 Editing user account information
3. Edit the relevant user entries.

4. Click Save Now! when you are finished.

B NOTE:

To change a user's repository retention period, edit the repository. See “Editing repository
information” on page 82.
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User account information

Table 18 User account information

Feature Description
Integrated Archive Platform Account Information
(Required.) The system login name for the selected user.
Usernames must be unique, but they can be the same except for their domains. For
Username example, johnkdoe@company.com could be an Active Directory user imported into

the system through dynamic synchronization (DAS); at the same time, user johnkdoe
could be created as a local user in the IAP.

Local Password

The password in the IAP for a selected user. Active Directory users who are imported
info the system through DAS are not required to have a local password. However,
local users must have one.

First Name

First name of the selected user.

Last Name

Last name of the selected user.

Email Contact

(Required.) Email address for the selected user.

Mail To Me Address

(Required.) Email destination when the selected user clicks Send results to send a
copy of an archived document from the Web Interface.

Comments The system administrators' comments on the selected user account.
(Required.) The IAP domain to which the selected user belongs. Select the domain
Domain from the drop-down list; the selection limits the scope of the Search and A-to-Z filter
buttons.
. The IP address of the mail server for the selected user. (Optional, unless querying
Mail Server L . .
within Microsoft Outlook is required.)
Billing Groun ID In RISS versions prior to 1.5, this number identifies the account to be billed for ser-
9 P vices. It is not used in later RISS or IAP versions.

Personal Repository

The ID of the repository created for the selected user.

Direct Repositories

The IDs of the repositories to which the user has access. The user automatically has
access to his or her own repository. If the user is a member of a group, he or she
also has automatic access to the group's primary repository.

You can give the user access to another repository by clicking Edit, selecting the
check box for the repository, clicking Save to List, and then clicking Exit.
Repositories (except for the user's personal repository) can be removed from the list
by selecting the repository name and clicking Remove From List.

LDAP information

Membership Any groups to which a remote user belongs.
WinDomain The Windows domain to which a remote user belongs.

The remote user's object name, relative location in the LDAP tree, and domain. CN
LDAP Dn (Common Name) is the object name, cn is its branch in the tree, and dc values are

domain names. DAS supplies this value.
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Feature Description
S An account synchronization maintained field that indicates which DAS job was used
ource . :
to create or manage the information.
. The Global Unique Identifier of the user account on the LDAP server. This is account
Object GUID SRR
synchronization's key to the correct account on the LDAP server.
. An identifier for the user, automatically generated and maintained by Active Directory.
Obiject SID .
(Cannot be edited.)
USNChange The USN (Active Directory unique sequence number) imported from the corresponding

account on the LDAP server the last time account synchronization was run.

Created Date

The date the user account was created.

Last Modified

The date the user account was last modified.

All Repositories

All repositories to which a user has access — either through direct access or through
group membership.

Proxies Displays the email addresses that will route to the user's primary repository.
Check boxes
Active/Disabled Select or clear this check box to enable or disable the user account on the IAP.
Select this check box to grant the user administrative privileges on the PCC.
IAP Admin It's best to create a new, local account for the administrator. Be sure to also define

a local password.

Compliance

Select this check box if the user is authorized to view all recipients (including BCC
addressees) in the repositories to which the user has access. This function is generally
limited to compliance officers. For a compliance officer to see any BCC information,
either BCC or envelope journaling must be enabled on the mail server and the
corresponding setting must be enabled on the gateway server. Compliance Archiving
(archiving of journal mailboxes) must be enabled, as this feature is not available with
Selective Archiving.

IAP Remote Authoriza-

tion

An IAP remote authorization user must be in the system for replication statistics to be
displayed properly in the Replication page. A user account is automatically created
for this purpose, with the username of AuthorizationUser and a randomly-generated
password.

You can change the password for this account. You can also create a new IAP remote
authorization user account and password if you want. If you create a new account,
be sure to clear this check box in the AuthorizationUser account, or delete
AuthorizationUser from the system.

Admin Delete

This user is authorized to delete messages from the IAP before their refention period
has expired. The check box only appears when the Admin Delete service is enabled
in Domain.jcml. See “Administrative Delete” on page 121.
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Managing groups

Groups are not currently supported in the IAP.

Managing repositories

Use the Repositories pane to change the routing rules for a repository, change the retention period
for some repositories, or add repositories. You could, for example, add a repository to provide a
container for special routings (email addresses or email domains).

You cannot delete a repository in Account Manager.

Repository overview

The IAP archives emails and other documents into repositories. A repository is a virtual collection of
documents associated with a given user by routing rules (for storing documents) and access control
lists (for retrieving documents).

Repositories are used to manage retention and access to documents stored on the IAP. They define
the scope of a query; users can search for documents only in the repositories to which they have
access.

Email messages that are stored on the IAP can be associated with several repositories. For example,
an email might be sent to several recipients and archived into each recipient's repository. The message
itself is only stored once in the system, but contains references to all the associated repositories. The
message remains on the |AP until the retention period of all repositories associated with the message
has been exceeded.

There are several types of repositories that reside on an |AP: user repositories, access only repositories,
quarantine repositories, Auditlog repositories, and system repositories. They are described in the
following sections.

User repository types
The IAP supports the following types of user repositories:

* Unregulated repositories
* Regulated repositories

Unregulated repositories

Unregulated repositories are automatically created for users that are imported by DAS from Active
Directory or the Domino Directory. An unregulated repository can also be created directly in Account
Manager, for example to set up a local user account for the IAP administrator. (Users created in the
system and given a local password are known as local users. Users imported by DAS are known as
remote users.)

An email that is sent to a user’s email address and ingested into the IAP is associated with the user’s
repository. When the user is deleted from the Active Directory or the Domino Directory and a DAS
job is run, the user’s repository is disabled.

The document retention period for an unregulated repository is often the same as the retention period
for its IAP domain, but it can be greater. This value is set in Domain.jcml. For more information,
see “Retention periods” on page 100.
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Regulated repositories

Regulated repositories can be created for users whose activities require a different retention period
from users in unregulated repositories. The retention period is the only difference between regulated
and unregulated repositories. Regulated repositories can be created in Account Manager, or an
existing unregulated repository can be converted to a regulated repository by editing the repository
information in Account Manager. (See “Repository information” on page 83.)

The retention period for regulated repositories must be set in Domain. jcml, even if your organization
does not use regulated repositories. For more information, see “Retention periods” on page 100.

Access only (audit) repositories

Documents sent to the IAP can be routed to an audit repository in addition to their respective user
repositories, to enable compliance or legal discovery searches.

Audit repositories are special purpose repositories that allow compliance officers to execute searches
within the archived documents of more than one user. This can be all employees of an organization
or a subset of employees in a specific email domain.

Before IAP 2.0, audit repositories could be created using either regulated or unregulated repository
types. IAP 2.0 introduced a new type of repository, the access only repository, which is specifically
intended for audit purposes. The access only repository was created to avoid two retention issues that
sometimes occurred when regulated or unregulated repositories were used as audit repositories: the
retention period for the repository was too long, causing storage capacity problems on the IAP; or
the retention period was too short, leading to email being deleted from the audit repository and
impacting compliance searches.

The access only repository addresses this situation by keeping a document for as long as it is retained
in the corresponding user or quarantine repositories. After the retention period has expired in the last
user repository that is associated with the document, and any quarantine hold has been removed,
the document is removed from the access only repository and deleted. This type of repository does
not have its own retention period.

If your system has been upgraded from an earlier IAP version and you currently have one or more
repositories used for audit purposes, they can be converted from a regulated or unregulated repository
type to an access only repository type. This conversion is not required. You should only convert an
existing audit repository into an access only repository if the current arrangement does not allow you
to implement useful retention policies. Any conversion must be handled by the HP Professional Services
Organization.

For the steps required to set up a new audit repository, see “Setting up an audit repository” on page 84.

Quarantine repositories

Documents that are placed in a quarantine repository are not subject to automatic deletion. As long
as items are in this repository, they are preserved in a legal hold and cannot be deleted when their
retention period expires.

(The exception to this rule is the deletion of quarantined messages by an Administrative Delete user.
See “Administrative Delete” on page 121 for more information.)

When the hold is no longer necessary, the contents of the quarantine repository can be deleted. This
action does not delete the items from the IAP. It releases documents from the legal hold and makes
them subject once again to the retention period that was set for them.
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Compliance officers can create one or more quarantine repositories directly in the Web Interface. In
the PCC Account Manager, these repositories appear in the user's Account Information form, and
are shown under the Quarantine tab in the Repositories panel.

There is no limit to the number of active quarantine repositories that a user can have.

Because documents in a quarantine repository are removed from retention processing, the retention
period for this repository type is shown as -1 in the IAP Repository form.

The steps involved in creating and deleting quarantine repositories are described in “Using quarantine
repositories” in the IAP user guide.

Auditlog repository

The Auditlog provides a surveillance system log for companies that are required to prove they are
adhering to compliance processes. Logs are created for each user session in the Web Interface, each
Duplicate Manager job, and the granting of Administrative Delete authority in the PCC. The logs are
stored in the domain's Auditlog repository (<domain>.auditlog). This repository is created automatically
if the Auditlog feature is enabled in the Domain.jcml file. The default retention period for the
repository is seven years.

B NOTE:

The minimum retention period allowed, as for all repositories, is 30 days.

For information on setting up the Auditlog and granting compliance users access to the Auditlog
repository, see “Enabling the Auditlog” on page 147.

For information on performing Auditlog searches, see “Querying the Auditlog” in the IAP User Guide.

System repository types

Each of the following repositories is automatically created for an IAP domain:

Recycle Bin repository (<domain>.recyclebin): If the folder capture and/or End User Delete features
are enabled for a domain, messages that no longer have email folders or user repositories asso-
ciated with them are placed in the Recycle Bin repository. When the retention period for the Recycle
Bin repository expires, the documents are automatically removed from IAP during retention pro-
cessing. The default retention period for this repository is 30 days and can be extended.

CatchAll repository (<domain>.catch all): The CatchAll repository holds documents that fail to
route info any user or audit repositories because they cannot be associated with:

* Email addresses of registered IAP users imported by DAS

* A domain routing rule

The default retention period for this repository is 30 days and can be extended.

Failed indexing repository (<domain>.failed.indexing.repository): This repository holds documents

that cannot be indexed or are partially indexed. (For example, the system might not be able to
index the particular document type of an email attachment.)

Repository grouping on PCC pages

In the Account Manager and Retention pages, repositories are listed under the following tabs:

Unregulated
Regulated
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* Quarantine
*  Other or Other Type

Includes the Auditlog, failed indexing, CatchAll, Recycle Bin, and access only repositories for a
domain.

Adding repositories

User accounts and repositories are created automatically for each user that is imported by the DAS
process. You can also manually create the following types of repositories in Account Manager:

¢ Unregulated repositories

* Regulated repositories

* Access only repositories

See “Repository overview” on page 79 for information about these repository types.

To manually add a repository from the Account Manager:

1. Click Add repository on the Account Manager page.

2. In the IAP Repository form that appears:

Enter a unique name for the repository in the Name box.
In the Domain box, select the IAP domain in which the repository will reside.

In the Retention box, enter the number of days that documents should be retained in the re-
pository. The field will be populated with the default value for the specified repository type
as configured in Domain.jcml. This value can be modified but must be equal to or greater
than the number of days specified for the domain and the repository type in the Domain. jcml
file.

For an access only (audit) repository, this field cannot be modified.

In the Type box, select the repository type from the drop-down menu.

You can create repositories of the following types: Unregulated, Regulated, or Access Only.
If you select Access Only, a dialog box appears stating that this repository type should only
be used for audit repositories. Click OK to close the dialog box.

In the Add Email box, specify the user's email address(es). For example, user@company.com.
Do not complete this field for an access only (audit) repository.

In the Add Email Domain box, specify the email routing domain to be associated with the
repository. For example, company.com.

You do not need to complete this field for a user repository.

3. Click Save Now!

For more information on the fields in the IAP Repository form, see “Repository information” on page 83.

For information on creating access only (audit) repositories, see “Access only (audit)
repositories” on page 80.

Editing repository information

To edit an IAP Repository form:

1. Click the Repository radio button on the Account Manager page.
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2. Click the tab for the type of repository: Unregulated, Regulated, or Other (for access only
repositories).

Locate and click the name of the repository you want to edit.

4. In the IAP Repository form, clear the check box labeled Deactivate this check box and then edit
the repository entries.

&P Reposfony:

HBME: |61D.000643207AD1EB4091E40918847 124865 reposiory
D [ :

Domain: [5;

Retention: qu

Ty [ Unregulated d

EMad
Routing:

wendtestOi4sT1@itchyexch com
wendtestD044T 1emai2 Qitchyexch.com
wendtesiD044T 1email @achyexch com

T Check this box to delste the selscted Ellal routings from kst above.

Add EMait [

| EMadDomain
Routing:

T Check to delete the selected EMal Domain routings from kst

At EMai
Domain
Created [y, 2010 01.07 22:31:30 PST by

Diate:
Lu.s'l[-. I

Modified:

| Deactvate i check box and hen edt tne repostary envies sl UL

Figure 20 Editing repository information

5. Edit the relevant entries, using the descriptions in Repository information.

6. Click Save Now! to save the repository information.

Repository information

Table 19 Repository information

Feature Description

Name (Required.) Enter a name if adding a repository.

The IAP domain to which the selected repository belongs. Select the domain from

Domain the drop-down list; the selection limits the scope of the Search and A+to-Z filter buttons.
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Feature Description

Enter the number of days that documents are retained in the repository. (For example,
30=30 days.)

For regulated or unregulated repositories, this value cannot be lower than two values
set in the Domain. jcml file:

Retention * The retention period specified for the domain
¢ The retention period specified for the repository type
(See “Retention overview” on page 99 for more information on these values.)

Do not complete this field if you are creating an access only repository.

If adding a repository, you can select one of the following types:
* Regulated

*  Unregulated

*  Access Only

Type . . )

If changing the type of repository, you can:

* Change a regulated repository to an unregulated repository.
* Change an unregulated repository to a regulated repository.

Access only repositories cannot be changed to another repository type.

Mailing address(es) for email routing. To delete one or more addresses, select the

Email routing relevant address(es) in the list, and then select the check box beneath the field.

Specify the email addresses associated with this repository (for example,
Add Email user@company.com). This entry appears in the EMail routing box after the repository
information is saved.

Email Domain Routing | The email domain associated with the repository.

Specify the email routing domain fo be associated with this repository (for example,
Add Email Domain company.com). This entry appears in the EMail Domain Routing box after the repos-
itory information is saved.

Created Date The date the repository was created. (Cannot be edited.)

Last Modified The date the repository was last modified. (Cannot be edited.)

Setting up an audit repository

Audit repositories are special purpose repositories that allow compliance officers to execute searches
within the archived documents of more than one user. This can be all employees of an organization
or a subset, such as users with significant legal exposure.

Perform the following steps to set up a repository for audit purposes:
1. Create the repository.
a. Follow the instructions in “Adding repositories” on page 82.

Specity the email routing domain to be associated with the repository in the Add Email
Domain box.

See Configuring routing rules for an audit repository for details.
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2. Give one or more compliance officers access to the audit repository.

* To give a user compliance privileges, select the Compliance check box in the user's account
form.

* To give a compliance user access to the audit repository, select the repository in the Direct
Repositories box in the user account form.

See “Editing user information” on page 76.

Configuring routing rules for an audit repository

Audit repositories provide access to email messages based on the email routing domain. Specify the
email routing domain to be associated with the repository in the Add Email Domain box in the IAP
Repository form. When the form is saved, the domain is saved in the Email Domain Routing field.
(See “Repository information” on page 83.)

In the following example, messages containing at least one email address with the @company.com
email domain will be routed into the repository named Audit. A compliance officer with access to this
repository will be able to search for messages sent to any user that matches the email address pattern:
<user>@company.com.

&P Repository:
Name: | Ayt
gl
Domain: ||:I|:m.mf ;I
Retention |
Type: |.m:cess Onby __:_j

EMail Routing: ‘

[T Check this box to delete the selected EMail routings from kst above.

Add EMai |
EMaiDomain Routing: | Teompany.com
[T Check to delete the selected EMail Domain routings from kst
Add EMail Domain |
Created Date: |

Last Modified |

Figure 21 Repository form for an audit repository

Audit repositories can also be created to segregate messages based on email domain. For example,
if your organization has several email domains, you can create individual audit repositories for each
email domain.

You could also create a master audit repository that was associated with all email domains for the
organization, then create individual audit repositories for each specific email domain. This would
allow compliance officers to limit or widen a search as needed.
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7 Account Error Recovery

The Account Error Recovery page displays account synchronization activities that have not been

performed successfully.

To open the page, go to User Management > Account Error Recovery in the left menu.

Error Recovery overview

Unsuccessful account synchronization activities can include:

Not being able to add a new user because the user name or object GUID (Global Unique Identi-

fier) already exists

Not being able to update a user because the user's entry cannot be found

Not being able to remove a user because the user's entry cannot be found

Not being able to add an alias or email routing rule for a user's repository

Not being able to add a membership to a group

Activity errors are shown grouped by object GUID, with the most recent error at the top of the list.
You can select an activity fo attempt it again, or you can delete it.

Activities can be filtered by clicking User, Group, or Membership at the top of the page.

Error Recovery features

Table 20 Error Recovery features

Feature Description

Date Date the error occurred.

Error Type of activity error. For example, not being able to add an alias or email routing
rule for a user's repository.

USN Active Directory unique sequence number. (User or group filters only.)

UserName The name of the user account. (User filter only.)

GroupName The name of the group account. (Group filter only.)

G Automatically generated identifier for the selected group; unique to the system.

roup g

(Membership filter only.)

Member The name of the repository. (Membership filter only.)
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Feature Description

The type of repository:
* Regulated

*  Unregulated
MemberType * Quarantine

*  Other (includes the Auditlog, failed indexing, CatchAll, Recycle Bin, and access
only repositories for a domain)

(Membership filter only.)

The Global Unique Identifier of the user account on the LDAP server; its corresponding
. object name, relative location in the LDAP tree, and domain. CN (Common Name)
Object GUID ) . L . .

is the object name, cn is its branch in the tree, and dc values are domain names.
LDAP DN Account synchronization (DAS) supplies these values.

(User filter only.)

Repairing synchronization errors

To repair synchronization activity errors, identify the activities that you want to reattempt or delete.
Click an entry to display more information about an activity, including its Java User Management
Services (UMS) database entry (only shown if a UMS database entry matches the activity).

You will need to decide the order in which to reattempt or delete the activities.

To repair or delete synchronization errors:

1. Identify the activities that you want to reattempt and select the check box in front of those entries.
You can click the entry in the UserName or GroupName column to find out more about the error.

2. Click Apply Selected.
If the reattempt is successful, the entry is removed from the list.

3. Identify the activities that you want to delete and select the check box in front of those entries.
You can click the entry in the UserName or GroupName column to find out more about the error.

4. Click Delete Selected.

When an activity is deleted, it is immediately removed from the list and cannot be recovered.
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8 Data management

This chapter discusses the following topics:

* Duplicate Manager, page 89

* Reprocessing, page 97

* Refention, page 99

* Backup, page 107

* Restoring a Smartcell group, page 112
* Smartcell Cloning, page 115

* Replication, page 92

* Folder support, page 121

* Administrative Delete, page 121

Duplicate Manager

The Duplicate Manager page lets you schedule duplicate merge jobs and view the status of duplicate
merge jobs.

B NOTE:

Duplicate Manager is only supported for email archived from Microsoft Exchange.

To open the page, go to Data Management > Duplicate Manager in the left menu.

Duplicate Manager overview

Duplicate Manager is intended for organizations that are storing with single instancing enabled.
Single instancing is the ability to store a single copy of an email that exists in multiple user repositories.
Emails are uniquely identified by a cryptographic checksum called a hash. If an email client attempts
to store the same email twice (as determined by the message hash) only one copy is physically stored
and the same reference URI is returned for both store requests.

Storing duplicate emails uses unnecessary space on the Smaricells and clutters search results by listing
the same email multiple times. Once the email file has been stored there is additional data attached
to the file called metadata. Over the lifecycle of the email, the metadata will change as user access
permissions and folder information change. The purpose of the Duplicate Manager tool is to eliminate
duplicate emails while retaining all associated metadata. To that end, the Duplicate Manager will
take the union of all metadata and attach it to a single copy of the email and remove all redundant
copies.
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It a user previously ran a successtul query that returned duplicate emails and saved the query results,
after running this tool all but one of the duplicate emails should be accessible. If a user has quarantined
the files in the saved query result set affer running this tool, the single remaining copy of the email
will remain quarantined.

Smartcells have a storage threshold that is lower than the total capacity of the hard disk. This is
because the services that run on the Smartcells require a percentage of the disk space in order to
operate. Once the Smartcell reaches this threshold it will transition into a closed state. Because
duplicate emails can be stored across Smartcell groups, there is a possibility that the merge job will
not be able to work on a set of duplicates because the Smartcells have exceeded the storage threshold
and are no longer able to accept additional metadata. These duplicates cannot be merged until
additional space has been made available on the closed Smartcell by either migrating some of the
emails to a new group or waiting for retention to delete emails and free additional storage space.

The amount of time for a merge job to complete is dependent on the total number of files stored, the
percentage of those files that are duplicates, and the average number of duplicates stored per hash.
The first merge job can take many days to complete, while subsequent merge jobs can complete much
faster.

If no errors occur during the duplicate merge, duplicates are significantly reduced in the system.
However, there is no guarantee that all duplicates are removed. Some emails might not have an
associated hash, and cannot be merged into a single copy. The duplicate merge procedure might
also miss a few duplicate emails on the first pass, since duplicate merge speed was traded for an
exhaustive duplicate elimination. Duplicate merge does not attempt to merge all emails in a single
pass. It merges all emails in the system in manageable batches according to default or user configurable
batch size. As a result of this batching, unmerged duplicate emails often occur at the beginning or
end of the batches. A subsequent duplicate merge pass will remove the remaining duplicate emails.

Duplicate Manager job schedules

The Duplicate Manager Schedule shown on the top portion of the Duplicate Manager page shows
each domain, domain portal IP address, days of the week that a duplicate merge job is scheduled,
time for which it is scheduled, and whether the job status is enabled.

Dosnein i Forisl || SchedvedDays | Time (24H)] Statug |
' gomain! [edi] 100711 Sun, Man, Fri, Sat 12:00000 Enabied
% domain? [egi] 10.0.71.2 Sun, Mon, Fri, Sai 12:00:00 Enabizd

domain? Schodute: I BT BT

St Dupide abe Manager Schaduie for Domdin
domaing

Figure 22 Duplicate Manager job schedules

Scheduling a job
To schedule a duplicate merge job:

1. In the Duplicate Manager Schedule by Domain section, click the edit link next to the domain for
which you want to schedule a job.

2. On the resulting schedule page, use the check box to enable the job, select the HTTP portal where
the job will run, the days of the week to run the job, the time to run the job, and then click Save
Schedule Now!
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Q0 TIP:

For optimal performance this tool should run on a different HTTP portal than DAS and replication.

Enabling or disabling a job
To enable or disable a duplicate merge job:

1. In the Duplicate Manager Schedule by Domain section, click the edit link next to the domain for
which you want to enable or disable a job.

2. On the resulting schedule page, select or deselect the Enable check box and then click Save
Schedule Now!.

Starting, pausing, or aborting a job
To start, pause, or abort a duplicate merge job:

Use the radio button to the left of the desired domain, and click Start, Pause, or Abort as appropriate.
Start will start a duplicate merge job on the selected domain immediately. Pause will pause a duplicate
merge job currently running on the selected domain. Abort will abort a currently running or paused
duplicate merge job on the selected domain.

Duplicate Manager job histories

The Duplicate Manager History Logs displayed on the bottom portion of the Duplicate Manager page
shows information for the five latest duplicate merge job runs. You may also click a domain to see
all (up to 50) duplicate merge job history logs for that domain.

Duplicate Manager History Logs:

| [ Duplicates Duplicates
Domain  Start Time ! Status . Elapsed Time Progress  Processed Deferred
deman
Mon, 11 Jan 2010 12:00:00 PST Finshed 1 minutes 3 seconds 100°% 0 obpcis 0 objects
Sun, 10 Jan 2010 12:00:00 PST Finished 2 minutes 45 saconds 100% 0 objects 0 objacts
Sat, 9 Jan 2010 120000 PST Finshea 2 mines 28 seconds 100% 0 obpcts 0 obects
Fri, & Jan 2010 12:00:00 PST Finsshed 0 seconds 100% 0 objecls 0 objects
proang
Mon, 11 Jan 2010 12:00:00 PST Finshed 38 mnutes 35 seconds 100% 0 obpects 0 objects
Sun, 10 Jan 2010 12;00:00 PST Finshed 11 minutes 52 seconds 100% 0 objects 0 objects
. : Hist Finshed 4 minutes 18 seconds 100% 0 objects 0 objects
MR : Finshed 0 seconds 100% 0 objacts 0 objects

Ve gl Mishovy logs for domain domaing

Figure 23 Duplicate Manager job history

The Duplicate Manager History Log provides the following job history information.

Feature Description

Domain Domain name

Start Time Time stamp of when Duplicate Manager job started
Status Initializing, Started, Not Available, Failed, or Finished
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Feature Description

Elapsed Time Time since a job was started until finished, aborted, or paused
Progress Percentage of Duplicate Manager processed sets compared to the total
Duplicated Processed Number of duplicates processed

Number of duplicates that could not be processed by the Duplicate

Duplicates Deferred Manager in the job.

Replication

299

B NOTE:
This page is available only if a replicated system is configured.

Replication is not currently available in virtual IAP environments.

Use the Replication page to monitor and to start or stop replication for a domain on a remote system.

To open the page, go to Data Management > Replication in the left menu.

Replication overview

Replication status is updated after each polling cycle. Therefore, it could be up to five minutes after
you start replication before you see results on the graph of replication rates. Errors and warnings,
however, are displayed as soon as they happen on the system. (The Replication page is unavailable
until at least one domain on the PCC host system is configured for replication.)

The behavior of the primary Smartcell groups on the replication process is the following: The primary
Smartcell of a primary group by default is the one responsible of replicating the email. If this primary
Smartcell fails a failover occurs. A failover is the action performed by the secondary Smartcell of
taking over the responsibility to replicate email for its group. When the primary Smartcell is restarted
it will regain control of replicating email, this is known as failback. The intention of the failover and
failback mechanisms is to be able to provide fault tolerance by taking advantage of the Smartcell
redundancy that IAP provides and continue replicating even if the primary Smartcell is down and to
replicate from the primary Smaricell whenever it is up and healthy.

The behavior of the replica Smartcell groups in an IAP installation is basically to ingest messages from
its primary Smartcell group. In order for the ingestion to happen both replica 1 and replica 2 Smartcells
need fo be available and healthy; or, in the case of a IAP installation configured to only have one
replica Smartcell, only replica 1 needs to be available and healthy. Once a replica group is allocated
no further allocation will occur in the case where the replica Smartcell(s) are unavailable for any
reason. In the case where the replica Smaricell(s) are unavailable for any reason, no allocation for
replica Smartcells will occur, and the replication will fail until the replica Smartcell(s) become available
again.

If the primary site is not available for queries, users must enter the address of the replica site, instead
of the primary site, in their browsers.
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B NOTE:

In order for the Replication page fo display statistics from the remote system, an IAP remote
authorization user must be set up in Account Manager. See IAP Remote Authorization in “User account

information” on page 77.

Database Replication

The top part of the Replication page describes the database replication.

Table 21 Database Replication features

Feature

Description

Local Server/
Source Server

The replication and primary systems if you are logged into the replicated system.

Local Server/
Target Server

The primary and replication systems if you are logged into the primary system.

Replication Set

A set is made of one or more DB2 tables that replicated.

Inbound Sync Time/
Outbound Sync Time

The time at which the database tables in the replication set got last synchronized.
The synchronization time is displayed in two colors: green and red. Green means
that the database tables on the primary and replica DB2 have been synchronized
successfully within the last 30 minutes. Red means that the synchronization has
not happened for 30 minutes or more; this could indicate a DB2 replication issue
and you should contact HP technical support for advice.

Inbound Status/
Outbound Status

The replication status on the replicated and primary systems.

Re-initializing DB2 replication

Follow these steps to remove and re-initialize DB2 replication on the primary and replica systems. Be
sure to wait for each step to complete before proceeding to the next step.

1. Stop the IAP applications on the replica system:

PCC server on replica: /opt/bin/stop

2. Restart DB2 on the replica system:

DB2 server on replica: /etc/init.d/db2 app start

3. Stop the IAP applications on the primary system:

PCC server on primary: /opt/bin/stop

4. Restart DB2 on the primary system:

DB2 server on primary: /etc/init.d/db2_app start

5. Unconfigure DB2 replication on the replica system:

DB2 server on replica: /opt/bin/repl/dbRepl rm
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6.  Unconfigure DB2 replication on the primary system:
DB2 server on primary: /opt/bin/repl/dbRepl rm
7. Re-initialize DB2 replication on the primary system:
DB2 server on primary: /opt/bin/repl/dbRepl init
8. Re-initialize DB2 replication on the replica system:
DB2 server on replica: /opt/bin/repl/dbRepl init
9. Wait for the replication process to complete.
On average, it should take less than 30 minutes for the DB2 databases to synchronize.

Use the following steps to monitor DB2 replication and determine when the DB2 databases on
the primary and replica systems are synchronized:

a. Llog on to the DB2 server of the replica IAP and enter the following commands:

ssh db2

su - db2udb

db2 connect to ark01ldb
while true

do
date
db2 "select set name, status, synchpoint,synchtime from asn.ibmsnap subs set"
sleep 10
done
b. Wait until:

¢ All items listed in STATUS are O.

B NOTE:

If one or more items in STATUS is -1, replication is unlikely to succeed. You might want
to start over and repeat steps 1-8.

¢ All items listed in SYNCHPOINT have values.

o All items listed in SYNCHTIME have values and are within a few minutes of the current
time.
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10.

11.

This is an example of success:

SET NAME

SYNCHPOINT

SYNCHTIME

DB2UDB.base
DB2UDB.base

HAPPY .UBQ
HAPPY .UBQ
GRUMPY . UBQ
GRUMPY . UBQ
HAPPY.D2D
HAPPY.D2D
GRUMPY.D2D
GRUMPY.D2D
CSFR

CSFR

This is an example of failure:

SET NAME

x"4A9DA0D8000000010000"
x"4A9DA113000000010000"
x"4A9DA122000000010000"
x"4A9DA0D8000000010000"
x"4A9DA0D8000000010000"
x"4A9DA122000000010000"
x"4A9DA122000000010000"
x"4A9DA0D8000000010000"
x"4A9DA0D8000000010000"
x"4A9DA122000000010000"
x"4A9DA0D8000000010000"
x"4A9DA122000000010000"

SYNCHPOINT

2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.

SYNCHTIME

.244175
.000000
.955488
.244175
.244175
.955488
.904729
.184687
.184687
.955488
.244175
.904729

DB2UDB.base
DB2UDB.base
HAPPY .UBQ
HAPPY .UBQ
GRUMPY .UBQ
GRUMPY . UBQ
HAPPY.D2D
HAPPY.D2D
GRUMPY.D2D
GRUMPY.D2D
CSFR

CSFR

O O O OO OO Oo oo o

x'"4A9DA0OD8000000010000"
x'"4A9DA113000000010000"
x'"4A9DA122000000010000"
x'"4A9DA0D8000000010000"
x'"4A9DA0OD8000000010000"
x'"4A9DA122000000010000"
x'"4A9DA122000000010000"
x'"4A9DA0D8000000010000"
x'"4A9DA0OD8000000010000"
x'"4A9DA122000000010000"
x'"4A9DA0OD8000000010000"
x'"4A9DA122000000010000"

2009-09-04-16.
2009-09-01-15.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.
2009-09-04-16.

After replication is complete, restart the applications on the primary system:

PCC server on primary:

/opt/bin/start

Restart the applications on the replica system:

PCC server on replica:

/opt/bin/start

.244175
.000000
.955488
.244175
.244175
.955488
.904729
.184687
.184687
.955488
.244175
.904729
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Data Replication Flow and Detail Information

The middle part of the Replication page displays the flow of replicated data. You can also suspend
or resume the replication process per domain from this area.

Table 22 Data Replication Flow

Feature Description

The domain name and group ID of the domain being replicated, and the following
information:

* The IP addresses of the Smartcells being duplicated, the status of the replication,
and the number of stored and indexed documents being copied.

£ A check icon indicates normal operation.
€ An X icon indicates that replication failed the last time it was tried.

% An ! icon indicates replication is being retried.

Domain
* An arrow showing the direction of data. The direction is left to right from the
primary system to the replicated system. The direction is right to left on cross
replica configurations, reflecting that a primary Smartcell group in the remote IAP
installation is replicating to a replica Smartcell group on this IAP.
* The number of stored and indexed documents that have been copied to the rep-
licated domain.
* The percentage of data that has been copied to the replicated domain.
To stop replication, click Suspend. Replication will stop after the current batch is
replicated.
Suspend/Resume

To start replication, click Resume. The batch that would have been replicated next
when replication stopped will be replicated.

The Data Replication Flow and Detail Information section also includes a More Details link. Click More
Details to open the Data Replication Detail Information page to see additional primary and replica
system statistics. Statistics are provided by system group name and include Stored Obijects, Indexed
Objects, Active Transactions, Active Entries, Stored Resources, Stored Chunks, Stored References,
and Used Diskspace.

Replication Status

The bottom part of the Replication page displays the status of the replication.

Table 23 Replication Service General Status

Feature Description

Domain The domain name of the domain being replicated.
Group ID Group ID of the domain being replicated.

State Shows whether or not replication is in progress.

96 Data management



Feature Description

File Batch Count

The number of file batches that have been iterated to replicate. A batch is composed
of 100 messages; therefore, file batch count is the number of replication attempts
for a batch of 100 messages. (Under certain conditions a batch might get partially
replicated, meaning only an x number of files out of the 100 will be successfully
replicated. In such a case, replication attempts for the batch with the remaining
100-x also increases the file batch count.

Update Time The time of the last replication update.

Next Retry Time The date and time of the next replication update.

Message Any messages about the last replication update.
Reprocessing

The Reprocessing page displays each domain and shows whether reprocessing is enabled, when
reprocessing is scheduled, and a history log report. Reprocessing is an engine service that scans
recently stored data and reallocates messages to the proper repository.

Most reprocessing occurs as an automated and transparent background process that does not require
any operational effort other than passive monitoring.

In most cases, messages are reprocessed to reapply routing rules that have been recently added and
are applied to a short time period before the change has occurred. The Reprocessing view allows
you to schedule and enable reprocessing based on new routing rules.

B NOTE:

When you make a change using the Reprocessing Utility, the change does not take place immediately.
It is put in the job queue, and the reprocessing itself occurs 24 hours later.

To open the page, go to Data Management > Reprocessing in the left menu.

Rescheduling all reprocessing schedules

To reschedule all the domains to the same reprocessing schedule:

1.

2
3.
4

In the Reprocessing page, click Reschedule All.
Complete the form to set the status and schedule.

Click Reschedule All.

To ensure that all schedules are enabled, verity that all Reprocessing Status check boxes are
selected.

If selected, the text Enabled appears next to the check box.

Editing reprocessing schedules

To edit a domain's reprocessing schedule:
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1. In the Reprocessing page, click the edit link next to the domain you want to edit.

Schedule by Domain:

Domain i |  Reprocessing Stalus |  Scheduled Days | Time {24H]-|
ﬁ domaini ¥ Ensbled Sun, Mon, Tues, Wed, Thurs, Fri, Sat 02:00:00
@ domain2 [edi] ¥ Ensbied Sun, Mon, Tues, Wed, Thurs, Fri, Sat 02-00:00

Suspond ] Rosume Al Roscheduio Al ~Refrosn

Figure 24 Editing reprocessing schedules
Complete the form to set the status and schedule.

Click Save Schedule.

4. To ensure the schedule is enabled, verify that the corresponding Reprocessing Status check box
is selected.

If selected, the text Enabled appears next to the check box.

Changing the reprocessing status
You can enable or disable a reprocessing schedule of a specific domain or all the domains listed.
To change a reprocessing schedule:
1. In the Reprocessing page, locate the domain whose schedule you want to enable or disable.

2. Complete any of the following tasks to change the status:

Schedule by Domain:

Damain | Reprocessing Status | Schediuled Days [ Tmmlh}|
ﬂl domaind [sdi] ngm Sun, Mon, Tues, Wed, Thurs, Fri, Sat 02:00:00
@ domain2 [edi] W Enabied Sun, Mon, Tues, Wed, Thurs, Fri, Sat 02:00:00

sescheauie ] etresn

Figure 25 Change the reprocessing status

* To enable reprocessing for a specific domain, select the corresponding Reprocessing Status
check box.

* To disable reprocessing for a specific domain, clear the corresponding Reprocessing Status
check box.

* To enable reprocessing for all domains, click Resume All.
* To disable reprocessing for all domains, click Suspend All.

3. Verify the status by noting the text Disabled or Enabled next to the Reprocessing Status check
box.

Using the Reprocessing Utility

You can reprocess a user repository if you think a user hasn’t been included in the processing.

In the Reprocessing Utility area of the page:
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Reprocessing Utility:

Uzer Email: Uzer Repository ID: Domain hame:
i I | | idcmﬂim Vi
From Date: Select Specified Range. To Date:
ear Month Day ear Maonth Day
LEel iciimi b . 2= —
(2010 | [February ¥ |22 ¥ | -

Figure 26 Reprocessing utility

1. Enter the following information in the text boxes:

* The user email address
* The user repository ID

Users can only be reprocessed if their email address and repository are in the IAP. If so, they
are listed in the Account Manager.

In the Domain Name drop-down list, select the domain in which the user repository resides.
Specify a date range, and click Add in Reprocessing Queue.

The job is sent fo the queue, and the reprocessing takes place 24 hours later.

Viewing reprocessing history logs

The reprocessing history log at the bottom of the Reprocessing page shows a list of the last successful
reprocessing runs for each configured domain. The log includes each domain group, when a domain
was reprocessed last, the number of processed files, and the elapsed time of the run. This report is

based on data from Smartcell groups, which is averaged from the individual Smartcells of each group.

Retention

Retention periods are configured for an IAP domain and its repositories when the system is installed.
Use the Refention page to change the amount of time that documents are kept before they are deleted
from the system.

Retention is useful in meeting compliance requirements, when your company must retain emails or
files for a specified number of years.

To open the page, go to Data Management > Retention in the left menu.

Retention overview

Retention determines how long a document resides on the IAP before it is subject to automatic deletion
and permanently deleted from the system. Retention periods can be applied to IAP domains and
repositories. Documents remain physically on the IAP until all retention periods that are associated
with the item are exceeded.

This section describes how documents are retained in the system and includes the following topics:

* Retention basis

* Retention periods

* End User Delete

*  When the retention period expires
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Retention basis

Documents are retained based on either the send date or the archive date (also known as the ingest
date).

The send date for an email represents the date on the emaiil client when the email was sent or received.
The send date for a file, stored via the HP File Archiving software or the Obiject Storage AP interface,
represents the “last modified timestamp” of the file.

The ingest date (archive date) of an email or file is the date it was stored in the IAP, using the local
time on the SMTP server.

The retention basis is set in the Domain. jcml file on the kickstart server. One of the following options
should be listed in the file:

RetentionBasis=IngestDate
RetentionBasis=SendDate

If neither of the options is specified in the Domain . jcml file, the configuration defaults to the archive
date.

If the retention basis is changed from the archive date to the send date, email with an older send date
but recently archived (for example via the HP EAs Exchange PST Importer) might be deleted the next
time a retention job runs, if the send date is outside the retention period for the domain and repository.

The PCC Domain Configuration page and the Retention page show the retention basis.

B NOTE:
Whenever you configure any retention settings in the Domain . jcm1 file, run the following commands:

regloader.pl —cv —clearallConfirm=<IAP name> on the kickstart server and /opt/
bin/restart on the PCC to restart the IAP.

Retention periods
When the system is set up, three retention periods are configured in Domain.jcml:

* The retention period for the domain:
DomainRetentionPeriodDays=[number of days]

This is the minimum number of days that documents are stored in an IAP domain's repositories
before they are automatically deleted from the system. Values can be -1 (which disables retention)
or can range from 30 (days) to 2,147,483,647 (days).

After the system is put info production, domain retention can only be altered using the PCC Refention
page. You can enable or disable retention or increase the domain retention period. The domain
refention period cannot be decreased after the IAP starts archiving documents.

When retention is enabled on the Refention page, the -1 setfting in Domain.jcml has no effect.
Configuration changes made via the PCC retention page will override the settings made in the
Domain.jcml file.

* The retention period for unregulated repositories:
UnregulatedRetentionPeriodDays=[number of days]

Unregulated repositories are created for users imported by DAS from the Active Directory or the
Domino Directory. The unregulated refention period is used as the default retention period when
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the repositories are created. If necessary, individual repository retention periods can later be
changed via the PCC Account Manager page.

Setting the value to -1 one does not disable retention.

You can change the unregulated retention period by increasing the value in the Domain.jcml
file.

¢ The retention period for regulated repositories:
RegulatedRetentionPeriodDays=[number of days]

Regulated repositories can be created for users whose activities require a different retention period
than users in unregulated repositories. These repositories can either be created in Account Manager,
or an existing unregulated repository can be converted to a regulated repository by editing the
repository information in Account Manager.

If your organization uses regulated repositories, the retention period is usually greater than the
period for domain retention. A value must be configured for this field, even if you do not use
regulated repositories. Setting the value to -1 one does not disable retention.

You can change the regulated retention period by increasing the value in the Domain.jcml file.

All three retention periods must be set for retention to work. The retention periods are displayed on
the PCC Domain Configuration page and the Retention page.

See “Editing domain retention periods” on page 103 and “Editing repository retention
periods” on page 106.

Exceptions
The configurable retention periods do not apply in the following cases:

*  Quarantine repositories: Documents placed in a quarantine repository are preserved in a legal
hold and cannot be deleted when their retention period expires. See “Quarantine repositor-
ies” on page 80 for more information on these repositories.

*  Admin Delete: A user with administrative delete privileges can manually delete documents from
a quarantine repository, or a regulated or unregulated repository before its minimum retention
period has expired. See “Administrative Delete” on page 121 for more information.

End User Delete

What is End User Delete?

If users delete an archived email from an Outlook folder, the email is not automatically deleted from
the IAP. Users are deleting a “tombstone,” a pointer to the actual email that is now stored on the IAP.
(When users select the message in their email client, they are viewing a retrieved copy of the message.)

When a tombstone is deleted, and retention and End User Delete are enabled in the Domain.jcml
file, the reference to the user's repository is removed from the archived message. If folder capture is
enabled, references to the Outlook folders where the tombstone was located are also removed from
the archived item. The message is deleted from the user's repository, and the user can no longer
access it—either from Outlook, the Web Interface, or Outlook Integrated Archive Search. (This does
not affect other users who access the message via their own repositories. )

The End User Delete function applies to items in regulated or unregulated repositories, and is used in
conjunction with HP EAs Exchange Outlook clients. An archiving event, Synchronize Deleted ltems,
must be scheduled in EAs Exchange so that removal of a tombstone is synchronized with removal of
the message in the user repository.

End User Delete removes a message from a user repository. The archived message itself can be
removed from the IAP only when all repository (and folder) references are removed from the message.
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Messages that no longer have email folders or user repositories associated with them are placed in
the Recycle Bin repository when folder support and/or End User Delete are enabled for a domain.
After the retention period for the Recycle Bin repository expires (the default is 30 days), the messages
are automatically removed from the index and the Smartcell during the next retention job.

B NOTE:

When messages are placed in the Recycle Bin repository, they are re-indexed. The items can be
searched for in the Recycle Bin repository but cannot be searched for in the user repository from which
they were removed.

Configuring End User Delete

Example

Use the following fields in Domain.jcml to configure End User Delete:

°* MinUnregulatedRetentionPeriodDays
°* MinRegulatedRetentionPeriodDays
The value in each field determines the amount of time an email remains in a user repository after the

tombstone is deleted from Outlook. If set to =1, End User Delete is disabled. If set to >=0, End User
Delete is enabled for the repository type (regulated or unregulated).

When the value is set to 0, messages can be deleted from the user's repository immediately. When
the value is the same as the retention period for the repository type
(RegulatedRetentionPeriodDays or UnregulatedRetentionPeriodDays), messages
cannot be deleted via the Outlook client. (This is common in compliance environments.)

Archived messages are removed automatically from the IAP when the retention period has expired
for each repository in which the message was located.

The following diagram displays how the process works.

Message
enters IAP

Manual deletion pozsible Lvailakle for
automatic deletion
/I—/R in next 24 hours

/4;44““‘ LLLLLLLLL .,______,
\\'—_—V—_—r’ Frrrrrrasr

L . End User Delete Repository Reterntion
Lelsticplinpoesible minimum Fetention Period Period

Figure 27 End User Delete and retention

An example of a configuration with End User Delete could be:

DomainRetentionPeriodsDays=30
UnregulatedRetentionPeriodsDays=30
RegulatedRetentionPeriodDays=365
MinUnregulatedRetentionPeriodDays=0
MinRegulatedRetentionPeriodDays=365

This configuration means that:
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¢ Users can delete messages from their unregulated repository immediately, using their Outlook client.

*  From the minimum retention period (MinUnregulatedRetentionPeriodDays)to the maximum
retention period (UnregulatedRetentionPeriodsDays), manual deletion is possible in un-
regulated repositories.

¢ Users cannot delete messages from their regulated repository (if one exists) since, for regulated
repositories, the minimum retention period is the same as the maximum retention period.

¢ After the retention period has expired for all repositories associated with a message, the message
is available for automatic deletion during the next retention job.

When the retention period expires

When the refention feature is enabled, a retention job runs every night at midnight. The Smartcell
retention manager first checks the domain retention period for the minimum number of days and
verifies that retention processing is enabled. If retention is enabled, it retrieves the information for a
repository, including the repository retention period, and locates documents that were ingested or
sent before the age limit specified for the repository. The reference to the expired repository, and any
corresponding folder references, are removed from the document. If a document is also located in
other repositories and is still within their retention period, it is re-indexed.

Documents that no longer contain repository references are physically deleted from the Smartcell and
removed from the index.

Editing domain retention periods

The Setting and Configuration area of the Retention page shows the retention basis and retention
period for each IAP domain. It also shows whether retention has been enabled for the domain.

You can increase the retention period and/or enable retention processing for a domain by following
these steps:

1. In the Retention page, click Edit under Set Domain Retention.

2. Seta new retention period by selecting a preset time period from the drop-down list, or by entering
a specific time period in the text box.

The time period must be greater than the Minimum Domain Retention Period.

Doemain naeme | domaind
Retertion Sistus ¥ Enabled
Ieinistra Domain Felbanbon Perod | 30 days

Current Domain Retenion Pemod | 30 days

St Mew Fetention Period | |90 dayvs = WE'*“'I‘S

Figure 28 Editing the domain retention period
3. If retention processing should be enabled for the domain, select the Retention Status check box.
(Clear the check box to disable retention processing.)

4. Click Save Retention Now to save the revised seftings.

You can enable retention processing for all domains by clicking Resume All. Retention processing

can be disabled by clicking Suspend All.

HP IAP 2.1 Administrator Guide 103



B NOTE:

After the system starts archiving documents, refention processing can only be disabled or enabled
using the PCC Retention page. It cannot be disabled by editing the refention fields in the Domain . jcml
file.

Viewing deletion statistics

Documents can be deleted automatically from the IAP when their refention period expires, or they
can be deleted manually. The Retention page displays an Auto Delete Statistics table and a Manual
Delete Statistics table with information collected during the most recent retention job run.

These tables, located at the bottom of the Retention page, show aggregate data for domains and
Smartcells.

Automatic deletion statistics

The Auto Delete Statistics table shows information for the current (or last) retention job for each
Smartcell. You can view the history of retention jobs for each Smartcell by clicking the Smartcell link.

domain (1 group(s})
| Bl ©2Fiished Jobs, M 0 Obiscts Deleted By Current Jobs i
| domaind (1 group(s])

B 2Finshed Jobs, &) 58788 Objects Deleted By Current Jobs

Smartcoll IP Job Status | Deleted Updated Failed Start Time Elapsed
Objects) Object{s) Object(s) Teme
= Group 10 02001433414a3c126000 0010
1001722
AutoDelete ] Ba.TE8 A Hia Tue, Jan 12 2010 00-00:08 PST 1 hours
i7
minutes
23
seconds
100204 1
AutoDedts & 69,109 a ] Tue, Jam 12 2010 00:00:09 PST 1 hours
42
minubes
4
S8conda

Manual Delete Statistics
List of Domain{s) | Deleted Reference({s)

Figure 29 Auto Delete Statistics
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Click the “+" icon below the domain name to see the detailed activity statistics by Smartcell. When
a job is running, the statistics are updated every five minutes.

Table 24 Auto Delete Statistics

Field Description

The IP address of each Smartcell in the domain.

Move the cursor (mouse) over the icon in front of the Smartcell IP address to view
the Smaricell server name, the type of Smartcell (primary or secondary), the

Smartcell IP Smartcell state and status, active thread number, and Mac address.
You can click the Smartcell IP address to see the Platform Auto Delete History table,
which displays the retention history for that Smartcell.

Job Name Always AutoDelete.
A refention job is either:
* @ Finished
* & Failed

Job Status  »» Running
Move the cursor over the icon in the Job Status column o find the progress
(percentage complete) of the job. When a job is running, the status is updated
every five minutes.

Deleted Objects The number of documents that were deleted during the run.

The number of documents for which a repository reference was removed, because

Updated Obiecis the repository retention period had expired.

Documents with no remaining repository references are marked for deletion.
Documents that still contain repository references are re-indexed.

Failed Obiects The number of documents that failed to be deleted plus the number of documents
! that failed to be updated.

! Start date and time of the job run.
Start Time . . . Sy
Refention jobs run automatically every night at midnight (12:00 a.m.).

Elapsed Time The amount of time the job took to complete.

Manual deletion statistics

The Manual Delete Statistics table shows domain level statistics for the End User Delete function, if
this function is enabled in Domain.jcml. (See “End User Delete” on page 101.) End User Delete
occurs when users manually delete message tombstones (pointers to archived messages) from their
Outlook folders. If the minimum retention period for End User Delete has expired, the reference fo the
user's repository is removed from the message. When folder capture is enabled, the reference to the
Outlook folder where the tombstone was located is also removed from the message. The number of
removed repository references are displayed in the Deleted References column.

Messages can be deleted from the IAP only when all references have been removed from the message.
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Editing repository retention periods

Follow the instructions below to modity the retention period for an unregulated or regulated repository.
You can change the retention period as long as it is above the default retention period for the repository

type.

You can also edit the retention periods for the Auditlog, CatchAll, and Recycle Bin repositories in a
domain. Documents in a quarantine repository are removed from retention processing, so there is no
retention period for this repository type. (For more information about IAP repositories, see “Repository
overview” on page 79.)

1. In the Configuration and Setting area of the Retention page, click the name of the domain.

2. Click the repository tab (Regulated, Unregulated, Other Type) to locate the repository.
The Auditlog, CatchAll, and Recycle Bin repositories are located in Other Type.
You can search for a user repository by entering the user name in the Edit User Repositories box
and clicking Search.
The search function uses the “Like” SQL database capability. For example, you could enter jack
to match users jackdoe or jacksmith. Entering %doe would match users jackdoe, janedoe, or
maryjanedoe. Entering %ja% would match users jadams, jackdoe, janedoe, jacksmith, or
maryjanedoe.
Searches are not case sensitive.
Click the repository name to edit its retention period.

4. In the form that appears, click the drop-down list in Set New Retention Period or enter the number
of days in the text box.
Retention periods are shown in days. The number of days must be the same or greater than the
domain retention period. The system ignores any value that is less than the domain retention
period.

5. Click Save Retention Now.

B NOTE:

You can view user repositories on replica domains, but you cannot edit them. Retention periods and
other fields cannot be edited and action buttons are unavailable when you select a domain that is a
replica of another domain.
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Backup

The PCC Backup pages provide status information about the standard and optional backup services
running on the platform and provide access to HP Data Protector, which runs on optional backup
server(s).

B NOTE:

If none of the IAP domains is configured with tape backup (DataBackupEnabled=false in
Domain.jcml), tape backup is disabled in the IAP. Tape backup is also disabled in virtual IAP
environments. When tape backup is disabled, tape backup status is not included on the PCC backup
pages.

IAP backup data:

¢ Configuration files such as IAP configuration from the kickstart, SSL certificates, and SSO keys are
backed up locally (the standard backup). IAP configuration files from the kickstart server are backed
up locally to the PCC when the converter script is run. Configuration files can also be backed up
to tape (the optional backup system) by full and incremental backups.

* Database data is backed up locally. A local backup of the DB2 database is made daily on the
platform's local disk. A copy of that local backup is kept on the database server and the kickstart
server for added security. Database data files can also be backed up to tape (optional backup
system) by full and incremental backups.

* Smartcell data: This data can be backed up to tape (optional backup system) by full and incre-
mental backups. The content indexes are also backed up to tape.

B NOTE:

In virtual IAP environments, the optional backup system is not supported. You must use another
enterprise backup solution to back up Smartcell data and the virtual IAP system.

To open the Backup pages, go to Data Management > Backup in the left menu.

For detailed information about the optional backup system which runs Data Protector, see “Optional
backup system” on page 151.

Backup Overview

The Backup Overview page provides backup status information for configuration, database, and
Smartcell data. From this page you can also disable or enable tape backup to run as scheduled if
you have the optional backup server. (The backup server is not supported in virtual IAP environments.)
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Figure 30 Backup Overview

Overall backup service summary
An overall backup service summary is at the top of the page.

2 A check icon indicates backup service completed successfully. This status is displayed if the last
backup of all three sets of data completed successfully without error.

2 An ! icon indicates backup service completed with warnings. This status is displayed if the last
backup of all three sets of data completed but at least one backup completed with warnings.

€ An X icon indicates backup service failed. This status is displayed if the last backup of any of the
three sets of data failed.

An information icon @ indicates backup service information is being provided. This status is displayed
in non-error conditions. When backup service is initially set up, the information icon signifies that no
backup session has run yet.

Individual backup service summaries

The Backup Overview page also shows the backup status of each set of data: for configuration,
database, and Smartcells.

The success check icon @ is displayed if there is at least one full backup in the last 28 days and one
incremental backup in a 24 hour period. These time intervals are default but they can be customized.
Otherwise, the page shows a warning icon #or an error icon &. Warnings are displayed when the
last full or incremental backup completed with warnings. Errors are shown when the last backup failed
or completed with errors, or the last full backup is older than 28 days and the last incremental backup
is older than a day.
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An information icon @ indicates backup service information is being provided for the backup type.
This status is displayed in non-error conditions. (When backup service is initially set up, the information
icon signifies that no backup session has run yet.)

Conditional information will inform you when:

¢ The given backup type has a backup schedule enabled or disabled.

* A current backup session is running and its status (if any).

* A full backup is older than a certain threshold (by default 28 days).

* An incremental backup is older than a certain threshold (by default one day).

For the configuration and database data types (which have local backups performed on the IAP) you
will see bulleted information regarding the last backup session status.

Configuration data backup status

Configuration data to be backed up resides on various servers (for example, PCC, HTTP, and kickstart
servers). These servers are called the backup clients.

2 A check icon is displayed if the last backups of the configuration data on all backup clients
completed successfully without error and are not older than a certain number of days (one day for
incremental backup, 28 days for full backup).

% An ! icon is displayed if the last backups of the configuration data on all backup clients completed,
but incremental backup on some backup clients is older than two days (for example, “Last completed
incremental backup on kickstart is older than 1 day”).

& An X icon is displayed if the last FULL backup of the configuration data on any client is older than
28 days (for example, “Last completed full backup on PCC is older than 28 days”), or if the backup
status on any backup client cannot be found (for example, “No backup found on backup server”).

Database data backup status

Database data is backed up on the IAP local disk (kickstart and database servers) and also backed
up to tape if tape backup is enabled. The database data that is backed up to tape resides on the
kickstart server.

@ A check icon is displayed if the last local backup and tape backup of the database data completed
successfully without error, and tape backups are not older than a certain number of days (one day
for incremental backup, 28 days for full backup).

% An ! icon is displayed if the last backup of database data completed but the local database backup
has a warning (for example, “local backup 1 completed with warnings”), or an incremental tape

backup is older than one day (for example, “Last completed incremental backup on kickstart is older
than 1 day”).

€ An Xicon is displayed if the last full tape backup is older than 28 days (for example, “Last completed
full backup on kickstart is older than 28 days”), if the tape backup status cannot be found (for example,
“No backup found on tape”), or if the local backup status cannot be found (for example, “No backup
found on DB2 server”).

If tape backup is disabled, the status of the database backup to tape is not displayed on the dashboard.

Smartcell data backup status

Smartcell data to be backed up resides on assigned Smartcells. These Smartcells are also backup
clients. The name of the Smartcell backup client consists of gid and the group ID that the Smartcell
belongs to and the domain name of the IAP.
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@ A check icon is displayed if the last backup of the data on all assigned Smartcells completed
successfully without error and is not older than a certain number of days (one days for incremental
backup, 28 days for full backup).

% An | icon is displayed if the last backup of the data on all assigned Smartcells completed but
incremental backup on some Smaricells is older than one day (for example, “Last completed incremental
backup on gidxxx1 is older than 1 day”).

& An X icon is displayed if the last full backup of the data on any assigned Smartcell is older than
28 days (for example, “Last completed full backup on PCC is older than 28 days”), or if the backup
status on any assigned Smartcell cannot be found (for example, “No backup found on gidxxx1.").

If tape backup is disabled, Smaricell data backup is not displayed on the dashboard.

Disable/enable tape backup schedule

If the tape backup feature is configured on the Backup Overview page, a button to disable/enable
scheduled tape backup is displayed. If the tape backup schedule is disabled, tape backup will no
longer occur. The data on the previously backed-up tape will not be erased. When the tape backup
schedule is disabled, a bullet under each of the three backup types is displayed stating that the backup
is disabled.

Configuration Information

The lower portion of the Backup Overview page displays configuration information for the local and
tape backups.

The Configuration Information area contains the internal IAP IP address of the configuration and
database server, the run time schedule for the local backup process, and the location of the local
backup files.

The Configuration Information area also contains the internal IAP IP address of the backup server (if
available), the version of the Data Protector backup software being used, and a list of the IAP domains
that have tape backup enabled.

B NOTE:

If tape backup is disabled, this section displays “Tape Backup is disabled.” If tape backup is enabled
but the backup server is not available, the Backup Server IP section displays “Backup application
Server is down, cannot retrieve information.”

Database backup

Database data is backed up on the IAP local disk (kickstart and database servers) and also backed
up to tape if tape backup is enabled. The Database Backup page provides detailed information on
the last two local backups (one on the local database server and the other on the kickstart server).
The Database Backup page also provides detailed information on the last tape full and incremental
database backups (for optional backup servers). It includes completion time, size, type (full or
incremental) information, and informational messages.

The entry in the Last Database Backup table for the local database backup contains information about
the database backup job, which extracts information from the DB2 database and stores it in a
recoverable format.

The PCC displays statistics about the database backup process itself. In particular, the Completion
Time column shows the time at which the database extraction process completed. Other job logs
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might show the local backup job completing at a later time, but those later timestamps include the
overhead tasks that are managing the disk storage space for the database backup archive, and are
not the specific database backup process.

The Local Completion Time is useful for determining the data that was included in the backup, for
situations where recovery of backed-up data is dependent on the time the data was extracted.

Tape Backup Console

The Tape Backup Console page provides VNC access to the HP Data Protector graphical user interface
(GUI), which runs on the optional backup server(s). Use HP Data Protector for detailed optional backup
server status information and configuration.

This page does not appear in virtual IAP environments.

Local backup file locations
The contents of the install/config/primary directory on the kickstart server are backed up.

* Database backup files: The database backup files and DB2 transaction log files are stored on the
database server (partition /db2/vVolBack). The files are mirrored to a directory on the kickstart
machine (/install/db2backups). The DB2 database is backed up once a day and the last
two backup files are kept on disk.

*  Master configuration files: There are three master configuration files: BlackBoxConfig.jcml,
Domain.jcml, and the UserKeyStore file in the /install/configs/primary directory
on the kickstart server. Whenever one of these files is changed and the converter and Registry
Loader are run, the modified files are copied to the PCC machine, to the directory /usr/local/
MasterConfigFiles.

(To run the Registryloader after changing a configuration file, run the following script on the
kickstart server: regloader.pl -cv.)

B NOTE:

The file BlackBoxConfig.bct is not included in the local backup, because it can be generated
from BlackBoxConfig.jcml (/install/tools/converter/dumpBCT). The script
createBBC. zr generates the . jcml version that is backed up.

Restoring DB2 local backup files

The DB2 database can be restored from the backup files on the /db2/vo1Back partition on the
database server. If data is lost because the database machine was reinstalled, restore the backup
files first. Restore the backup files from either the copy on the kickstart server, or tape backups if
application backup is enabled.

The functionality to restore the database backup partition and the database itself is implemented in
the /opt/bin/backup/db2BackupUtility script on the database server.

Follow these steps to restore the database:

1. Before restoring the database, stop all IAP applications by issuing /opt /bin/stop on the PCC
server.

2. log on to the database system.
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3. If the database server was reinstalled, run the following command to restore the /db2 /vVo1Back
partition from the version stored on the kickstart server:

/opt/bin/backup/db2BackupUtility -restore from kickstart

B NOTE:
This will delete the content of the VolBack directory.

4. To restore the database, make sure the database is up by issuing the command:
su — db2udb -c db2start

5. To restore DB2, run the following command. You will be asked for a timestamp of the backup to
restore.

/opt/bin/backup/db2BackupUtility -restore db2
Normally, the last two backups of the database are kept.

6. Atfter the installation is finished, run /opt /bin/start on the PCC server to start the IAP and
validate that it operates correctly.

Restoring the master configuration files

Copies of the master configuration files are kept in the /usr/local/MasterConfigFiles directory
on the PCC server. Whenever one of the files is changed on the kickstart server and the converter is
run, the master configuration file is copied to the PCC server, and renamed to
YYYY-MM-DD-hh.mm.ss FileName.

Restoring a Smartcell group

B’ NOTE:

In virtual IAP environments, Smartcell restoration is not supported and this page does not appear.
You must use another backup/restore solution to back up and restore a Smartcell group.

The Restore Smartcell Group page lists broken groups that can be restored from tape, groups that
are currently being restored (including progress information), as well as past completed or aborted
restore operations.

If you lose one Smartcell of a group, use the Smartcell Cloning page to clone the Smartcell to rebuild
the group. Cloning is much faster than tape restore and the healthy Smartcell may have recent data
not on the tape backup.

If you experience the loss of both Smartcells in a group, use the Restore Smartcell Group page to
restore one Smartcell from tape. After one Smartcell is restored from tape, use cloning to get the
second Smartcell thus rebuilding the group.
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B NOTE:

You should only restore from tape when cloning is not possible. Cloning a Smaricell is faster than a
tape restore and also guarantees that the data is complete (data on tape is only as current as the time
the last backup took place).

To open the Restore Smartcell Group page, go to Data Management > Restore Smartcell Group in
the left menu.

Smartcell Group Restore candidates

The Smartcell Group Restore candidates section appears on the Restore Smartcell Group page when
there are one or more broken groups that can be restored from tape. Only groups for which both the
primary and secondary Smaricells are unavailable are listed here. If only one of the Smartcells in a
group has to be restored, cloning is the preferred option to recover the group.

Each entry in the group lists the domain name, the group ID, and (if available) the IP address of
primary and secondary Smartcell.

The Start Restore button initiates the tape restore for the given group. When you click the button, tape
restore for the particular group begins and an entry for the operation appears in the list of current
restore jobs.

Current Smartcell Group Restore Jobs

The Current Smartcell Group Restore Jobs section lists running or failed restore jobs along with their
current progress. Each entry provides the following information:

Table 25 Current Smartcell Group Restore Jobs information

Field Description
Group ID The group ID of the group being restored from tape.
Status Either Running or Failed.

IP address of the Smartcell to which the data is being restored. This field is populated

Smartcell IP as soon as a free Smartcell has been assigned for restore.
Started Date and time when this operation began.

Completed Step Information about the restore step currently being executed.
Action One or more possible actions to control the job.

You can perform the following actions:

* Reset

Can be performed as soon as the Smartcell has been assigned. This action aborts the current job
and resets the Smartcell that was assigned as a restore target. All data that was potentially restored
is already removed and the cell is moved back into the pool of free Smartcells.

* Retry

Only available if the current step fails. This action resumes the operation, retrying from the last
failed step.
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e Clone

Only available once the Smaricell is restored completely and is ready to be cloned. This action
takes you to the Cloning PCC page and marks the restore operation for this Smartcell as complete.

Unregistering a configured Smartcell

If a Smartcell that is already configured in an IAP must be “re-kickstarted,” you need to unregister the
Smartcell in the Tape Backup Console to be able to use it for the restoration process. (If this is a new
Smartcell added to IAP, this step is not necessary.)

To unregister a Smartcell:
1. Go to Data Management > Backup.

2. On the Backup page, click the Tape Backup Console tab and log into the Tape Backup Console.

3. Connect to the HP Data Protector Cell Manager by selecting File > Connect to Cell Manager, then
select the primary backup server to connect.

If you are already connected you can skip this step.

4. Once connected, select the Smartcell hostname from Clients, then right-click and select Delete.
In the figure below, the Smartcell being selected for delete is scs1-172-1.persistcorp.com.

File Edit View Actions Help

| Clients

| ¢ ) Data Protector Cell
¢ [®) Clients :
@= bs-50-168-1.persistcorp.com || :
gid02001 4354f4a3c] 2630497 | |
B ¢id020014384f4a3cl 26304a( §§:
B gido20014384f4a3cl 264cdf5| | |
I

[ General rSEcurity " Adwanced |

-! Client System

"

Hame: 5c-51- 172- 1 persistcorp.com

B id020014384f4a3c] 264cdff] ;1
1 hp-s0-71-1.persistcorp.com
1 hp-s0-71-2.persistcorp. com

Platform: gpl 86 64 linux-2.6.18-1258.615

"

Installed components:

B o z1-172-3.persist
B o :2-204-1.persist
B o :2-204-2.persist

Upgrade. ..
Checlk Installation...

B :5-50-107-1.persistcorp.com Component
B o1-172-1. persisteorn corm Disk Agent
B occ1-172-2.persist Add Components...

Figure 31 Unregistering a Smartcell
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5. When asked if you want to remove Data Protector software, click No.

Once this step finishes, the Smartcell is ready to be rekicked and available for restore.

114 Data management



Smartcell Cloning

Use the Smartcell Cloning page to show the status of current and past cloning operations, and to
clone a Smartcell.

To open the page, go to Data Management > Smartcell Cloning in the left menu.

Cloning overview
You can clone a Smartcell if its mirror Smartcell is SUSPENDED, DEAD, or FAILED. (See “Smartcell

life cycle states” on page 38.) Cloning a Smartcell copies all its information to another Smartcell that
is in the FREE state to give the Smartcell a new, viable mirror. Cloning operations can take a long
time (as much as a day), depending on the amount of information cloned.

Smartcells are placed in the free pool upon their initial installation. If your system does not contain a
Smartcell in the FREE state, do one of the following:

*  (Non-virtual IAP systems) Contact your local HP sales representative to order additional Smartcell(s).
*  (Virtual IAP systems) Follow the steps in “Preparing for Smartcell cloning in virtual IAP environ-
ments” on page 116.

When you access the Cloning page, PCC searches for ongoing cloning operations and loads the
current data. Only one Smartcell can be cloned at a time, so you see the progress of any ongoing
cloning operation.

B NOTE:

The type of file system used on the Smaricell has an impact on the cloning operation. A Smartcell
running the ReiserFS file system will require a clone Smartcell with a same size ReiserFS file system.

Cloning features

Table 26 Cloning features

Feature Description
The IP address of a Smartcell without a viable mirror. If all Smaricells have viable

s mirrors, the Source displays No Broken Groups Found. If more than one Smartcell

ource needs a mirror, a Change Source button appears below the automatically selected
IP address.
I The number of Smartcells currently in the FREE state. This number is decreased by

Free Cells one affer a cloning operation starts.

Assigned/Free A graphical representation of the assigned and free Smaricells.

Clone Cell Starts the cloning operation. See “Cloning Smartcells (copying data)” on page 116.
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Feature Description

Cloning Area

This area provides the following information about an ongoing cloning operation:

Source selected: IP address of the Smartcell being duplicated.
Target selected: IP address of the Smartcell receiving duplicate data.

Current Step Percentage: Dynamic bar showing how much source data has been
duplicated.

Overall Percentage: Current step in the cloning operation.
Cloning operation steps are as follows:

* |Initializing

* Assigning target host

* Transferring data

* Transferring indexes

*  Waiting for indexer to complete

* Updating history log

* Completed or Failed

Some steps happen so quickly you might not see them.

Steps such as Transferring data and Transferring indexes can take a long time if
there is a great deal of data to clone.

History Logs ‘

The following information about each cloning operation that has occurred since
startup:

Source
Target

Time Elapsed
Status

Date

Cloning Smartcells (copying data)

Preparing for Smartcell cloning in virtual IAP environments

Before copying a Smartcell's data, you need to add a Smartcell virtual machine (VM) to the virtual
IAP to act as the free Smartcell. This is done using the clone function provided by VMware's vSphere

Client.

In a virtual system, use different datastores for the source and the target (clone) Smartcell virtual
machines. The logical units (LUNs) created for the datastores must be allocated on different physical
disks for storage redundancy.

1. Start vSphere Client: Start > All Programs > VMware > VMware vSphere Client.

2. log in to the vCenter Server that manages the ESXi host using the IP address, Administrator ID,

and password.

3. Select the ESXi host.
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Clone an existing Smartcell using these steps:

Select the Smartcell to be cloned.
Right-click the Smartcell, and select Clone.
Enter a name for the new Smartcell.

The name should be in the form P_SC-<3rd octet of ip>-<4th octet of ip>.
For example, if the IP address chosen is 10.0.204.2, then the VM name must be P_SC-204-2.

The IP address for a Smartcell must be 10.0.172.x or 10.0.204.x, with the fourth octet
following on sequentially from the previous IP address. For example, 10.0.204.1,

10.0.204.2, 10.0.204.3, and so on. You cannot use an IP address that is already in use.

Select the virtual datacenter where you want to create the new Smartcell VM, and click Next.

[ @ Clone Virtual Machine - T =

Name and Location
Specify & name and location for thes virtual machine

Hame and Location Mame:

HasLL Ll P SC-2042

= i Virtual machine (VM) names may contain up to 50 characters and they must be unique |
within each wCenter Server VM folder. |

B e Imventory Location:
i o Sl ) WIN-TDBOOFSELOS
B [ [CPETR
ﬁ Discoveréd virtual machine
® B3 standalone

| Help < Back Net > Cancel
e | | |
|

B

Figure 32 Selecting datacenter for new Smartcell VM

Select the host on which you want to create the new Smartcell VM, and click Next.

Select the Resource Pool in which you want to create the new Smartcell VM, and click Next.
Select the datastore for the new Smartcell VM, and then click Next.

This must be a different datastore than the datastore for the source.

Select the disk format option Same format as source, and click Next.

Click Next. (No Guest OS customization is required.)

Verity that all the configuration information is correct, and click Finish.
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The new Smartcell VM is created in the specified location in the vSphere Client.

|
| Ready to Complete
Chck Firsh b start & task that wil creats the new vrtusl machine

Bame and Location
- Settings for th: new virtual machine:
Resource Poal Virtual Machine to Clone: P_SC-472-2
Dat Hame: P SC-204-2
r HostjChuster: 16.89.90. 126
Qiok Pormat Resource Pool: P_VIAP_B
I Guest Customizabion Datastore: bihviap
Ready to Complete Disk Storage: Same format as source

Guest OF Customization Specificaton: None, do not customize guest OS5

[T Power on this virtual machine after creation ™ Edit virtual hardware (Experimental)

/fy Creation of the virtual machine (VM) does not indude automatic installation of the guest oparating
system, Install & guest 05 on the VM after creating the VM.

o | <ok [[ Fnen ] conce

Figure 33 Completing creation of the newSmartcell VM
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5. Adjust the Power-on Boot Delay:

a.
b. Click the Summary tab.
c.  Click the Edit Settings link.
d. Select the Options tab.
e.

Boot Delay.
f. Click OK.

[ PCR_101_KS - Virtual Machine Properties

In the vSphere client, select the new Smartcell VM.

In the Advanced options, select Boot Options and enter the value 90,000 (ms) for the Power-on

Hardwane OPWEIRW]

Wirtual Machine Version: 7

Settirgs | Sumimary [~ Power-on Book Delay
General Options PCR_101_KS
Whenever the virtual maching is powered on or reset,
vApp Options Cizable) delay the haot For the Following rumber of millseconds:
Vidwrare Tools Shisk Doweny
Power Management Standby
Advanced IE‘U.«'IU 3:
General Normal
CPUTD Mask, Expose Mx flagho .. [~ Force BIOS Setup
Memary/CPU Hatplug Disabled Dwsabled
Boot Options Delay G0000 ms - }1; ﬁégﬁpﬁmﬁﬂ maching boots, force entry |
Paravirbuskzation Dizabled . % = .
Fibre: Channel NPTV None -
CPLUMMU Virtualization Autoematic
Swapfie Location Use defauk settings
__teb | oK Cancel

Figure 34 Adjust Power-on Boot Delay

6. Get the MAC address of the new Smartcell VM:

a.
b. Click the Summary tab.

c. Click the Edit Settings link.
d

In the vSphere client, select the new Smartcell VM.

Click Network Adapter 1 in the Virtual Machine Properties window.

The MAC address of the Smartcell VM is displayed in the window's right panel.
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11.

Add the IP address and the MAC address of the new Smartcell VM to the BlackBoxConfig.bct
configuration file:

a. Select the kickstart server VM, click the Console tab, and log in to the kickstart VM as the
root user.

b. Navigate to the /install/configs/primary directory.

¢.  Make a copy of the BlackBoxConfig.bct file as a precaution:
# cp BlackBoxConfig.bct BlackBoxConfig.bct.orig

d. Open BlackBoxConfig.bct using a text editor such as Vim.

e. Inthe MACHINES section of BlackBoxConfig.bct, add a new entry with the IP address
and MAC address assigned to the new Smartcell VM.

For example:
SC: 10.0.204.2 <MAC Address>
f.  Add KS:ks.sc.clearall to the end of the new entry.

Using the example above, the complete entry would be:
SC: 10.0.204.2 <MAC Address> KS:ks.sc.clearall

g. Save and close the file.
At the kickstart prompt, run the following scripts:

®* createBBC.zr

* regloader.pl —cv —c=<IAP Name>
IAP Name is the BlackBox value located at the beginning of the B1ackBoxConfig.bct file.
Enter v at the prompt to confirm.

In the vSphere Client, power on the new Smartcell VM.
Press F12 to PXE boot the new Smartcell VM.
Monitor the PXE boot until the server is initialized.

Perform the steps in the next section, Copying Smartcell data.

Copying Smaricell data

In both virtual and non-virtual IAP environments, follow these steps to copy data from a source Smartcell
to a target Smartcell:

1.

Perform one of the following actions:

* Select the source Smaricell from the Source field.

* If the option is present, click Change Source to select a different Smaricell for cloning. When
the selection box appears, select the Smartcell you want from the drop-down list, and click
Select.

Click Clone Cell.
This button is unavailable if there are no Smartcells to clone.

When cloning is successful a pop-up panel appears on screen.

120  Data management



3. Check the Status Area to see results of the cloning operation.
© A check icon indicates the cloning operation is proceeding normally.

& An X icon appears if the cloning operation has failed.

Folder capture support

IAP 2.x supports folder capture for Email Archiving software for Exchange (HP EAs Exchange) version
2.x.

This feature captures the original Outlook location of archived messages and updates the corresponding
documents in the IAP. The folder location (for example, /Inbox/project) is stored as metadata in
the archived email.

For folder capture to occur, it must be enabled on both the IAP and HP EAs Exchange. In HP EAs
Exchange, folder capture is enabled by default. On the IAP, it is disabled by default and must be
enabled in Domain.jcml.

When folder information is indexed, the folder name can be used to search for and retrieve messages
stored on the IAP. To limit the number of archived messages that are re-indexed when folder information
is added, a cut off date is specified in Domain.jcml. Messages stored before the cut off date have
only their metadata updated, while messages stored after the cut off date have both the metadata
and indexes updated with folder information.

B NOTE:

If the IAP contains a number of closed Smartcells, available disk space can be quickly depleted when
indexed folder information is added.

To prevent this error, we strongly recommend setting the cut off date to the date the system is upgraded
so that only new messages are indexed.

For more detail on folder support, see the “Working with folder capture” chapter in HP Email Archiving
for Exchange Administration Guide version 2.x.

Enabling folder capture

The FolderSupportEnabled option in Domain.jcml indicates whether folder support is enabled in
the IAP for a domain. If enabled, the IAP allows users from this domain to search for email by folder
and display the folder in which the email is stored. To enable folder support, this option must be set
to true: FolderSupportEnabled=true

After configuring Domain. jcml, run the following commands: regloader.pl -cv
-clearallConfirm=<IAP name> on the kickstart server and /opt/bin/restart on PCC to
restart the |AP.

The PCC Domain Configuration shows whether folder support is enabled.
Use the date of the IAP 2.x installation or upgrade as the date, for example 07,/30/2008.

Administrative Delete

The Administrative Delete function gives designated users the ability to manually delete an email that
has been stored in the archive. This function is typically used in the Federal area for dealing with
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classified data; for example, to remove inadvertently distributed messages from the archive. Email
can be manually deleted from regulated, unregulated, and quarantine repositories.

® IMPORTANT:

It is the responsibility of customers to verify that using Administrative Delete does not inferfere with
their organization's record retention policies. HP will not be held liable for the irresponsible use of
this feature. HP has made every effort to put the proper controls and logging in place to prevent
unintentional removal of data from the system.

Enabling Administrative Delete

Administrative Delete is enabled or disabled at the domain level. If enabled, the system allows a user
who has the appropriate privilege to delete email.

1. In a virtual IAP environment, follow steps a-e below.
In non-virtual IAP environments, go to step 2.
a. Start vSphere Client by selecting Start > All Programs > VMware > VMware vSphere Client.

Log in to the vCenter Server that manages the ESXi host using the IP address, Administrator
ID, and password.

c. Select the ESXi host.
d. Click the kickstart virtual server.
e. Click the Console tab.
2. At the kickstart console, log in as the root user.
3. Open the Domain.jcml file:
a. At the prompt enter:
# cd /install/configs/primary
b. Open Domain.jcml in a text editor.
For example:
# vi Domain.jcml
4. Enable Administrative Delete by setting the AdminDeleteEnabled field to true:
AdminDeleteEnabled=true

Add this field if it does not exist in the file.

B NOTE:

If Administrative Delefe is enabled, the Auditlog must also be enabled, as described in
“Enabling the Auditlog” on page 147.

(Administrative Delete can be disabled by setting the AdminDeleteEnabled field to false.)

5. Save and close the file.
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Run the Registryloader by entering:

# regloader.pl —cv —clearallConfirm=<IAP Name>

Enter y at prompt to confirm.

After the Registryloader has executed, go to the PCC console and log in as the root user.
Restart the IAP from the PCC:

# /opt/bin/restart

Log into PCC Web Administration.

The General Configuration Platform Settings page should show the Admin Delete Service as

enabled.

Granting the Delete Admin privilege

All IAP Admin users, with the exception of super users, can grant or revoke the Delete Administration
privilege. Only a remote user (a user existing in the Active Directory and imported by DAS) can be
granted Delete Administration privilege.

To grant this privilege to a user:

1.
2.
3.

5.

Log in to PCC Web Administration as the super user.
Open the PCC Account Management page and grant the IAP Admin privilege to a user.

Log in to PCC Web Administration as the IAP Admin user and open the PCC Account Management
page.

Select the user who needs to execute Administrative Delete and edit this user by selecting the
Delete Admin check box.

The domain that this user belongs to should have Administrative Delete enabled; otherwise, the
Delete Admin check box will not appear.

Save the change.

To revoke the Admin Delete privilege:

1.
2.

Log in to PCC as the remote IAP Admin user.

Open the PCC Account Management page and select the user who has the Delete Admin privilege
and edit this user by deselecting the Delete Admin check box.

Save the change.

Executing Administrative Delete

After obtaining the Delete Admin privilege, a user is allowed to delete any messages stored in IAP.
To delete messages:

1.

LA

Log in to the IAP Web Interface as the user with the Delete Admin privilege.
Search for and select the message to be deleted.

Click More Options.

Select Delete Checked Items.

To confirm the deletion, click Confirm Delete.
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After confirming deletion, a status page appears, which contains a report on the success or failure
of the deletion submittal.

After the message is submitted to delete, it may take up to two hours for the message to be
removed from the index. During that time, the message contents will be still searchable, but not
refrievable.

When a message is deleted by Administrative Delete:

The deletion physically removes the message and all references of the message from IAP.
The message is deleted if it is quarantined.

A message in Saved Results is deleted from the index and the message body is no longer
searchable. However, the message is still listed in Saved Results.

The deletion is done on both primary and secondary Smartcells. If the IAP is running in a replication
environment, the message is also deleted on the replica Smartcells.

If the IAP is running in a replication environment, Administrative Delete can only be executed to
delete a message that is stored on the primary IAP; the deletion is triggered on the replica IAP by
the replication process. Administrative Delete can not delete any message stored on the replica

IAP directly.

Llogging in Auditlog

Activities in Administrative Delete are logged in the Auditlog and stored in the Auditlog repository.

When a user obtains or loses the Delete Admin privilege, the change is logged in the Auditlog.
When a message is deleted by Administrative Delete, the operation is logged in Auditlog.

Current limitations

The following are current limitations of Administrative Delete:

In IAP 2.x, Administrative Delete only deletes emails. It does not delete documents that were stored
with the Object Store API (BIBO) or the HP File Archiving software (formerly FMA), and it does
not delete an audit trail.

If email has been backed up with the IAP backup feature, the email can be deleted from the IAP
using Administrative Delete. However, the email and any related information on the tape will not
be deleted. Because of this, all administrative delete operations should be re-executed on the IAP
when any Smartcell recovery has been performed. (This is a low-probability event.) The Auditlog
provides the necessary information to determine which delete operations need to be re-executed.

At this time, deleted messages in a saved query result appear when reloading the saved result in
the Web Interface. However, if you click the deleted messages, you will see Error displaying
message. The saved queries keep the reference to the file until the saved query is cleaned up.

This feature does not currently satisfy DoD or NSA data destruction standards.
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9 Reporting

This chapter includes information about the following topics:
e Event Viewer, page 125

¢ SNMP Management, page 127

* Email Reporter, page 129

* Collect Log Files, page 131

* “User Repository Utilization Report” on page 132

Event Viewer

The Event Viewer shows the events that are occurring or have occurred on system servers and in
system services and applications.

B NOTE:

All alerts are logged as events in the PCC, and are displayed among the other events on the Event
Viewer page. See “Current Platform Alerts” on page 41.

There are two ways to open the Event Viewer:

* Go to Reporting > Event Viewer in the left menu.
e Select Overview from the left menu, and then click Go to Event Viewer in Current Platform Alerts.

Event Viewer overview

The following information is displayed in the Event Viewer.

Table 27 Event Viewer features

Feature Description

A short description of the event.
The description is preceded by an icon showing the event level:
& Critical: The issue is critical for the entire system.

* ¥ Major: A server or application feature has a major problem, but the issue
is not critical for the entire system.

Description i Minor: A server or application feature has some internal problems, but they
are not critical for the server or feature health.

* & Resolved/Manually resolved: The issue has been automatically or manually
resolved.

@ Unknown: The cause of the issue was unknown.
* @ Information: The event was part of the normal operation of the system.
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Feature Description
Context The context in which the event occurred.
Machine The type of server on which the event occurred and the IP address of the machine.
Date The date and time that the event first occurred or was resolved.
Searching the Event Viewer

You can choose to display only events that match the search type and criteria specified in the Search
area of the viewer.

To search the Event Viewer:

1.

Select the number of events to be shown on each page.
The default is 20 events per page.

Select a Search Type in the drop-down list.

You can choose from the following types of searches:

* Show All Events

* Level (of event)

* Machine Type (of the machine on which the event occurred)
* |P Address (of the machine on which the event occurred)

* Host Name (of the machine on which the event occurred)

In the Search Criteria text box, enter the criteria for the search.

You must enter criteria for all searches except Show All Events. Searches are not case sensitive.

* For Level, see the legend at the bottom of the Event Viewer.

* For Machine Type, see the Machine column in the Event Viewer for examples.

* For IP Address, see the Machine column of the Event Viewer or the Software Management
page.

* For Host Name, see the Software Management page.

The search function uses the “Like” SQL database capability. For example, you could use Search

Type: Host Name and enter sc% in Search Criteria to match host names scs1-172-1.company.com

or sc¢s2-204-1.company.com. Entering %204% would match hosts sc:s2-204-1.company.com,
or scs2-204-2.company.com.

Or, to search for resolved events, you could select Search Type: Level and enter %resolved in
Search Ciriteria to view both resolved and manually resolved events.

Click Submit.

Deleting events

Delete events from the Event Viewer in one of the following ways:
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1. Choose one of the following:

* Select the check box in front of one or more events.

* Select a cutoff time in the drop-down list at the bottom of the page. For example, events older
than two weeks.

* Select All Events in the drop-down list at the bottom of the page to remove all events in the
viewer.

2. Click Delete after making your selection.

B NOTE:

The system automatically clears events (oldest first) when the number of records reaches 20,000. Ten
percent (2,000) of the maximum number of entries are removed. Currently, event retention is not
configurable.

SNMP Management

Application-generated alerts that occur in the IAP system are shown in Current Platform Alerts on the
PCC Overview page. These alerts can be forwarded as SNMP traps to external monitors in your
network and/or to email recipients.

Use the SNMP Management page to perform the following functions:

* Download the IAP MIB file to be imported into your monitoring management server(s).
*  Select the SNMP traps to be monitored.

¢ Set the monitoring servers and/or email recipients to be notified when an alert is received.
e Set SNMP community.

* Send a fest trap to verify that the configuration has been set up properly.

B NOTE:

Only application-generated alerts can be selected as SNMP traps on this page. Hardware monitoring
for AP servers is provided by Proliant management agents. See “Hardware monitoring” on page
50 for more information.

To open the page, go to Reporting > SNMP Management in the left menu.

Downloading the IAP MIB

The IAP MIB (management information base) allows monitoring applications such as HP SIM to
recognize SNMP events coming from the IAP.

IAP SNMP traps are placed in an SNMP XML file, which is used by the IAP system to generate a MIB
file, iap.mib. The generated iap.mib uses SNMP version 2, which is compliant with the transfer
protocol SNMP version 1.

Whenever a new version of the IAP software is installed on your system, download \opt\mibs\
iap.mib from the PCC server and import it info your monitoring management software so the monitor

can recognize the |AP SNMP traps. In the MIB Manager Service areq, click Download to copy the
IAP MIB file to your local machine.
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To import the MIB to the monitoring servers, refer to the documentation for your monitoring management
software.

Selecting SNMP traps

In the SNMP Trap Manager Service areq, select the SNMP traps to be monitored. When one of the
alerts is generated, a corresponding trap is sent to the SNMP monitoring server and/or email recipient
that is entered on the SNMP Management page.

To set the SNMP traps:

1. Select the system for which the traps will be activated.
This is always |IAP.

2. Select the traps to be sent:

Traps are grouped by features. You can activate all traps, activate traps by feature, or activate
traps individually.

The trap IDs correspond to the alert IDs that are listed in “IAP application-generated
alerts” on page 179.

3. Click Save when you are finished.

Setting the SNMP server

In the SNMP Trap Server Monitors areq, enter the IP address of the server where you wish to send

SNMP Traps, then click Add.

You can enter more than one IP address, since the SNMP information can be broadcast to multiple
servers, or receivers.

B NOTE:

Always enter the IP address of the server; do not enter the hostname.

HP SIM servers can be used as SNMP receivers. To be compliant with SIM servers, the system uses
SNMP protocol version 1. All SNMP receivers should be compatible with this version.

Use of a server can be enabled or disabled by clicking the radio button in front of the server entry,
then clicking Toggle Enabled/Disabled.

A server can be deleted from the list by clicking the radio button in front of the server entry, then
clicking Delete.

If you do not have an SNMP trap monitoring server, you can receive SNMP event notifications via
email. See Sending SNMP events by email.

Sending SNMP events by email

If you do not have an SNMP trap monitoring server, you can receive SNMP notifications via email.
This option is also useful if you are away from the office.

To enable the service, enter your email address or the email address of the person who will receive
the notifications, and click Add.

Repeat this step if you want to add more recipients.

128  Reporting



To enable/disable an email recipient, click the radio button in front of the person's name and click

Toggle Enabled/Disabled.

To delete an email recipient, click the radio button in front of the person's name, and then click Delete.

® IMPORTANT:

The mail host's IP address must be entered in the Email Reporter page for SNMP email notifications
to be sent. See “Creating and scheduling email reporis” on page 129 for more information.

Setting SNMP Community

An SNIMP community string is a text string that acts as a password. It is used to authenticate messages
that are sent between the management station (the SNMP manager) and the device (the SNMP agent).
The community string is included in every packet that is transmitted between the SNMP manager and
the SNMP agent.

Public is the default choice for the SNMP Community.

Testing the configuration

After configuring or updating the settings, you can click Send Test Trap to verify that the configuration
has been set up properly.

Email Reporter

Use the Email Reporter to configure summary monitoring reports that are sent periodically to chosen
email recipients.

You can select the information to be sent and the frequency of the reports— from one time only to
every seven days. These reports can include system status, storage rates, node health, and other
information from the PCC pages.

To open the page, go to Reporting > Email Reporter in the left menu.

Creating and scheduling email reports
To generate and schedule email reports:
1. Configure the fields in Mail Configuration if this is the first time you are using email reports:
Enter the IP address of the mail host.

Enter an email address for the report's sender, for example IAPAdmin@mycompany.com,
or iap-no-reply@mycompany.com. This does not have to be a real email address.

c. Click Save to save the mail configuration.
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2.

5.

In Generate Report With, select one of the following:

* All Contents to send all the information listed in Custom Contents.

299

B NOTE:

Always use All Contents when you are sending email to HP technical support.

* Custom Contents to select specific information to send.

Report on

Report taken from

Alerts

Overview > Current Platform Alerts

Archive Gateway (EAs Ex-
change only)

Archive Gateway Management > Overview Archive Gateway

Auto Delete Statistics

Data Management > Retention Information > Auto Delete Statistics

Backup

Data Management > Backup

DAS Statistics

User Management > Account Synchronization > DAS Available

Job(s)

Domain Settings

General Configuration > Platform Settings

Node Health

Software Management

Platform Performance

Overview > Platform Performance

Smartcell Metrics

Overview > Platform Statistics

Version

Software Version

Enter one or more email addresses in the Send to Recipient(s) text box.

When entering several email addresses in the box, separate them with a space, comma, or
semicolon. For example: recipient1@mycompany.com, recipient2@mycompany.com.

In the Frequency list, select the frequency that the report should be sent.

The frequency ranges from one time only to every seven days.

Click Schedule.

The Email Report information appears in the Current Active Schedules area of the page, unless the
frequency is set fo one time only. You can click Send Now anytime to immediately receive a copy of
the defined report rather than wait for the scheduled time.

To delete a recipient, select the radio button in front of the recipient's email address, then click Delete.
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Collect Log Files

The Collect Log Files page lets you collect logs detailing system runtime events and errors. These logs
can be gathered from specific servers or from all servers on the IAP. For example, you can collect

logs from the HTTP servers and email them to HP technical support for help in troubleshooting.

The logging level can be set to INFO, to collect announcements about the normal operation of the
system, or changed to DEBUG or TRACE to collect more detailed information and to help diagnose
runtime errors. This change is made either on the Archive Gateway (to log errors on the Gateway
server) or in the PCC Service Tools (to log errors on other system servers), under the guidance of HP
technical support.

To open the Collect Log Files page, go to Reporting > Collect Log Files in the left menu.

Collecting the logs

Follow these instructions to collect a log file:

1. Select the type of server from which logs should be collected.

You can select one of the following:

SMARTCELL servers

META servers

DB server

SMTP servers

HTTP servers

SMTP and HTTP servers

PCC server

ARCHIVEGATEWAY servers (Exchange only)
BACKUP servers

All Servers (except Exchange ARCHIVEGATEWAY)
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2. Determine how the log will be collected by selecting one of the following methods:

* Download the log to a .tar file.
*  Email the log.

Enter the recipient's email address in the Email Logs field. To send to more than one email
address, separate the addresses by a space, comma, or semicolon.

The nms-mail-relay in BlackBoxConfig.bct on the kickstart server must be configured
properly for the logs to be sent via email.

B NOTE:

The size of the logs may be huge. Depending on the email server rules regarding the
attachment sizes in the customer environment, the email might not go through. There is no
check to see whether the email has been correctly sent to the recipient.

* FTP the log.
Enter the destination host address and the username, password, and destination directory.

(Optional) Enter an encryption password to encrypt the logs. You will need to provide the
password to HP support engineers so they can open the logs.

B NOTE:

Log files are compressed into .zip format for logs from the Archive Gateway or .tgz format
for logs from the other system servers. If the logs are downloaded, the .zip or .tgz files are
bundled into a .far file.

3. Click Run Now.

User Repository Utilization Report

The User Repository Utilization Report feature provides you with a snapshot of the current utilization
of IAP user repositories. A collection job gathers the utilization data and places it in an internal
database. You can then download a ZIP archive that contains CSV-formatted User Repository Utilization
reports and a collection job summary file. You can also configure the feature to send the ZIP archive
info a valid IAP repository for historical documentation.

B NOTE:

HP does not recommend enabling this feature at sites with large quantities of previously archived
data. (All documents in the IAP must be reindexed before the report can be run and the IAP is not
fully functional during reindexing, which can take weeks.)
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User Repository Utilization Report data

A CSV-Hormatted User Repository Utilization report contains the following information for each repository
within an IAP domain. Some fields are only specific to certain classes of repositories.

Table 28 Fields reported for all repository classes

Field Description

There are three classes of repositories: user repositories, quarantine
repositories, and system repositories. Every IAP user has a primary
repository that belongs to that user. Users can quarantine a query result
set by creating a quarantine repository and routing the query results into
it. Repositories that are not associated with users are referred to as system
repositories.

REPOSITORY_CLASS

REPOSITORY_ID The unique identifier for the repository.

NUM_DOCS The total number of documents routed to the repository.

The total uncompressed size (in bytes) of all documents routed to the
repository. Each document is internally stored in a compressed archive.
UNCOMPRESSED_SIZE The information in this field conveys the fotal inflated size of all documents.
The uncompressed size disregards the fact that documents may be routed
to multiple repositories (single-instanced).

The total compressed size (in bytes) of all documents routed to the
repository. Each document is internally stored in a compressed archive.
This information conveys the total amount of disk space that all of the
repository's documents are using. The compressed size disregards the
fact that documents may be routed to multiple repositories
(single-instanced).

COMPRESSED_SIZE

Table 29 Fields reported for user and quarantine repositories

Field Description

For users that are created in the PCC Account Manager (known as local
users), the administrator manually enters the username. For users that are
USERNAME imported into the IAP via Dynamic Account Synchronization (DAS), the
username is populated with a value from the LDAP server (Active
Directory/Domino).

The user’s email address as entered into the Email Contact field in the

EMAIL_ADDRESS Account Manager.

The user’s last name as entered into the Last Name field in the Account
Manager.

LAST_NAME

The user’s first name as entered into the First Name field in the Account

FIRST_NAME
Manager.
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Field Description

The organizational unit to which the user belongs. This field is retrieved
oU from the LDAP distinguished name field. Because LDAP configurations
vary widely across companies, this field may not represent the
organizational hierarchy for all customers.

Table 30 Fields reported for quarantine and system repositories

Field Description

Every repository in the IAP has a name.

* For quarantine repositories, the name is based on the saved query
results name as given by the IAP user. The naming convention is
REPOSITORY_NAME <saved query name>.<repositoryid>.quarantine.repos-

itory.
*  For system repositories, the name is human readable, such as the
domain Catchall repository; for example, domainl.catch all.

Job summary file

The User Repository Utilization report also contains a collection job summary file.

This file is the last part of the downloaded ZIP archive. If there is a problem downloading the report,
the job summary file is dropped. Therefore, the existence of the job summary file indicates that the
report has been successfully downloaded. (However, you should always examine the report for
correctness when the download is complete.)

Job summary data

Table 31 Fields reported in the job summary file

Field Description

Domain The IAP domain on which the report was generated.

The report excludes documents stored after this date. Generally this field
Ignore Documents Stored After shows the time that the utilization collection job was started. However,
you can set it to some time in the past fo create backdated reports.

Start The time that the utilization data collection job started.

End The time that the utilization data collection job ended.

Either complete or incomplete. The status is complete if the collection job
completed without any errors. Otherwise, it is incomplete. If the collection
Results job encountered an error, such as a Smartcell (storage node) not
responding, the report can still be downloaded. In that case, the
completeness of the report is unknown.

The number of Smaricells that were expected to respond to the utilization

SmartCell Groups Expected
query.
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Field Description

The number of Smartcells that responded to the utilization query. If this
number is smaller than the number expected, the report is incomplete.
SmartCell Groups Responded However, if this number is the same as the number expected it does not
mean that the results are complete. Other errors might have been
encountered to make the results incomplete.

Enabling the report and the job summary mode

The job summary feature can be run in one of two modes - repository mode or folder mode. In
repository mode, the report collects utilization summary data for all documents in all repositories in
the domain. In folder mode, the report collects utilization summary data of only those documents in
user repositories that have attached folder information.

The HP representative must enable the User Repository Utilization Report feature and define the type
of job summary. The report only appears in the PCC Web Administration menu if it has specifically
been enabled.

Using the User Repository Utilization Report

The User Repository Utilization Report is generated in two steps. The first step is to collect the utilization
data for all repositories in a domain. The second step is to download the report. There is a Web page
for each step: the collection page and the download page.

You can access the User Repository Utilization Report from the left menu of PCC Web Administration
by selecting Reporting > Utilization Report.

Utilization Report Collection page

The first page in the Utilization Report view is the Utilization Report Collection page. This page displays
the status of the latest collection jobs and contains the mechanisms for triggering new collection jobs.
It consists of four areas: tabbed IAP domains, Latest Collection Job Status, Collect Utilization Data,
and Recurring Collection Jobs.

Tabbed IAP domains

Reporting / Utilization Report

The User Reposilory Ulizalion Repord aullines the slomage ulfzation for all reposlorsas in a domam.

sy com

Select the IAP domain by clicking the associated tab. The selected tag is colored gray.

Latest Collection Job Status

11/18/09 11:50 PM
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The collection job queries all the Smartcells in the specified domain, aggregates the results, and places
them in a database. In general, this process can take up to six hours to complete. However, a
large-scale volume of users, with a corresponding volume of emails, will lengthen the processing time
for the report.

You can monitor the job status in this area of the page. A job can be in one of the following states:

* Running - The job is currently running.
* Completed — The job has completed and the data has been placed in the database.

* Completed with errors — The job has completed, but it encountered an error during processing.
This happens when only a subset of the Smartcells responded to the utilization query.

¢ Failed — An unrecoverable error occurred and the job was aborted.
You can perform the following actions:

*  Get a report of completed jobs by clicking Download Report. After clicking this button, you are
taken to the Report Download page.

*  Archive completed jobs into the IAP by clicking Archive Report. The report will be attached to an
email and sent into an IAP repository. The archive feature allows you to keep an historical record
of the utilization reports, which can be retrieved via a search in the IAP Web Interface. An IAP
repository for the reports must be selected before the report can be archived. (See “Configure
Archiving Parameters” on page 138).

*  Refresh the status of the latest collection job by selecting Reporting > Utilization Report in the PCC
left menu.

B NOTE:

Be careful not to refresh the page using the Web browser’s refresh option. You might unintentionally
resubmit the last command (collect data/archive report/schedule/delete/
configure). If this happens and the browser prompts you to continue resubmitting the form,
select Cancel.

If a collection job encounters an error or fails, an SNMP trap is thrown. The traps, which are configured
in the PCC SNMP Management page, can be sent to an external server or to an email address. The
following traps have been added for utilization reports:

* utilization_report_failure — The collection job failed.
« utilization_report_error — The collection job completed with errors.
* utilization_report_archiving_failure — The utilization report failed to archive.

Collect Utilization Data

Collect Utilization Data

Initate the vlizatsan dala colachon ob for lhe doman.

Collect Data for domain slinky.com

lgnore documents stored after: | November 18] 17 4] 2009 ]

*The repaert will aulomalcally be archived to the following address: uiilization.reporé@slinky.com

Use this area to run a single collection job.
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1. Select the domain on which the collection job will be run in the tabbed IAP domains area at the
top of the page.

2. If you want the report to be archived when the collection job is complete, configure the archiving
parameters.

3. If necessary, configure the Ignore documents stored after field.

The collection job ignores documents that are archived after the given date. By default, the job
is set to ignore obijects stored after midnight (11:59:59 p.m.) on the current day.

You can set this field to an earlier date. This will generate a backdated report for all data currently
stored in the domain that was ingested before the given date. Current document routing is applied.

The backdated report feature should be used judiciously. The data collected in backdated reports
can misrepresent the actual utilization on the selected date if the retention, reprocessing, or
quarantine features have modified the document routing information. The retention feature can
remove items from a repository, so that lower utilization data could be reported. The reprocessing
feature routes email into a repository, so that higher utilization data could be reported. The
quarantine feature creates and routes the document to an additional repository, which will be
displayed in the report.

4.  Start the collection job by clicking Collect Data.
After the job has started, the Collect Data button becomes disabled.

Only one collection job can run on a selected domain at a time. While the collection job is
running, the status in the Latest Collection Job Status area of the page displays running.

Recurring Collection Jobs

Recurring Collection Jobs

Schedule recumng utization data collaction obs.

!-:hl-:hi_ul Collection Jobs for domain I-n.l'*,'ﬂl'l

[(]Last day of avery manth at 00:00:00

Gl

Recumrence Pattem
) Waakly Run the reporl every monlh on
@ Monthly @ Day | 1 &) of the montn Haiir {m Vet @
O Yearly ) Lasl day of the monlh

You can schedule utilization collection jobs to run on a weekly, monthly, or yearly basis by following
these steps:

1. Select the domain on which the collection job will be run in the tabbed IAP domains area at the
top of the page.

2. If you want the report to be archived when a collection job is complete, configure the archiving
parameters. Be sure to select the Enable automatic archiving check box.

3. Configure the recurrence pattern.
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4. Click Schedule.
The scheduled job will be listed in Active Job Schedules.

(To remove a scheduled collection job, select the job in Active Job Schedules and click Delete.)

Configure Archiving Parameters

Configure Archiving Paramalsra for domain slinky.com
Reporl il ba archived to  ulizaton. repord@elinky com

Enable aulomatic archving W

You can archive utilization reports for historical reference. The report is attached to an email and sent
info an IAP repository. It can be retrieved through a search in the IAP Web Interface.

To configure the archiving feature:

1. Ensure the relevant domain is selected in the tabbed IAP domains area at the top of the page.
2. In the text box, enter an email address that is associated with a valid IAP repository.

You might want to create a repository in the domain especially for these reports.

3. If you want the utilization report to be archived automatically, select the Enable automatic archiving
check box.

4. Click Configure.

Report Download page

You can download the User Repository Utilization Report for a selected collection job. The downloaded
report is a ZIP archive containing CSV files and a report summary page. The data is chunked into

CSV files with 65,000 lines (plus one header line) in order to maximize compatibility with Microsoft
Excel.

Reporting / Utilization Report C

Deraniond Bve User Repaadory LAEzalon Repod.

sempabed 1UQ0S 11:59 P TURDS 608 AL 111820 508 AM arsfived

Deopwrndand Flopsord for domalm slimiy com
Devamimad e oo b
FAY ubEn
(1 Belacled uners
Vaer Repeatary Seiesl

Emal AddraasDomain: | AddUser |
Seinct usens boma fle: oo na fie seiscied | Uplond Users

Include the foboeing
Tt Gusmnine mposlores
| Syslem mposdones
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To download a User Repository Utilization Report:

1.
2.
3.

Click Download Report on the Utilization Report Collection page.
To download the report for all user repositories in the IAP domain, click All users.

To download the report for a select set of users, click Selected users and complete the User
Repository Selection fields.

* To select a single user, add the user's email address (for example, john.doe@domain.com)

to the Email Address/Domain field and click Add User.

* To select all users in an email domain, add the domain (for example, @domain.com) fo the
Email Address/Domain field and click Add User.

B NOTE:

Downloading the report for all users in a selected email domain (such as @domain.com)
requires the system to perform additional work to expand the list of users. Downloading for
a large selection of users means that database queries are less efficient. Depending on the
number of users to which the email domain expands, the download time can be greater than
downloading the report for all users.

* Users can also be added by uploading a newline-separated file. Click Choose file, select the
file, and then click Upload Users.

The newline-separated file should be a plain text file (use Notepad or vim) where every line
contains either an email address (john.doe@domain.com) or email domain (@domain.com).
The newline-separated file can have any extension.

The users are added to the selection box. There is a limit of 500 entries in this box. You can
remove a user by selecting the email address and then clicking Remove User(s).

Select the check boxes for Quarantine repositories and System repositories if you want to include
them in the report.

Quarantine repositories and system repositories can only be included if reports are in repository
mode. (See Enabling the report and the job summary mode.)

Click Download Report.
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Limitations
The following limitations apply to User Repository Utilization Reports:

*  Only one collection job can run at a time on a given IAP domain.

*  Only one set of utilization data can be stored in the IAP database at a given time for each IAP
domain.

¢ In general, the process of collecting utilization data can take up to six hours to complete. However,
a very large volume of users, with a corresponding volume of emails, will lengthen the processing
time for the report.

During the time it takes fo process the data, failures might occur on a subset of the Smartcells in
the IAP domain. The job will continue fo process even if some of the Smaricells do not respond,
thereby creating a partial report. The report can still be downloaded, but it will not accurately
report the utilization data for the domain. No mechanism exists to reissue the collection job on
that subset of Smartcells. Instead, the job must be run again across the entire domain.

* This feature runs on the PCC server. If the PCC server is restarted, any collection jobs that are
currently running will fail, and you will need to start a new job. The Smartcells, however, will
continue to process the previous jobs to completion.

To prevent the Smartcells from running out of memory, we strongly recommend that you wait a
day before starting a new collection job, to allow the previous jobs to finish.
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10 External access

The PCC left menu contains an Archive Gateway Management section. The Archive Gateway
Management section has a link to an overview of the Archive Gateway status for each EAs for
Exchange domain, and a link for VNC access to the Archive Gateway.

Archive Gateway Management

For information on the Overview Archive Gateway page, see “Overview Archive
Gateway” on page 142.

To open the page, go to Archive Gateway Management in the left menu.

VNC Archive Gateway

To access an Archive Gateway for an EAs for Exchange domain:

1. In the left menu, go to Archive Gateway Management and select the VNC Archive Gateway link.
The VNC Viewer: Connection Details dialog box appears.

2. Click OK.
The VNC Authentication dialog box appears.

3. Enter the password that was provided by your HP service representative, and press Enter.
The Windows Welcome screen appears.

4. Place your mouse cursor anywhere in the VNC viewer and press F8. In the menu that is displayed,
select Send Cirl-Alt-Del to display the Windows login screen.

You can also call the Windows login screen by pressing Shift+Ctrl+Alt+Delete or AltGr+Delete.
5. log in to VNC using the password provided by HP.

B NOTE:

Important! Do not use Cirl+Alt+Delete. This key sequence does not work when logging in
to VNC from the PCC.
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Overview Archive Gateway

This page provides information about the Archive Gateway system for each domain, including service
status and health.

Table 32 Overview Archive Gateway features

Feature Description

Header The header shows the name of the Archive Gateway (for example, EM-50-110-1),
and the version of the Email Archiving software (for example, 1.05.0000).

The date and time that the statistics were collected (for example, 5/11/2009 2:10:17

Statistics Collected PM).

Each section in the overview describes a major area inside the Archive Gateway,
together with an overall health status for that area. The sections include information
on:

*  System services
* Configured tasks
Sections * Journal mining

* Selective archiving

* Synchronized deleted items

e Tombstone maintenance

[ If a disabled icon is displayed, the section is either disabled or data was not
available at the time statistics were collected.

System Services

The System Services section displays the health of the specific system services running on the Archive
Gateway.

Table 33 System Services features

Feature Description

Name The name of the service.

The following status types can be displayed:

2 The service is running and the Service Account is not set to LocalSystem. (VNC
Server is expected to have LocalSystem as its Service Account.)

Status & The service is stopped or the Service Account is set fo LocalSystem. (VNC
Server is expected fo have LocalSystem as its Service Account.)

The Service Information summary displays the red icon if any service is stopped or
the Service Account is set fo LocalSystem. Otherwise, the summary displays the green

icon.
Startup Type Possible values for Startup Type are Auto, Manual, or Disabled.
Service Account The name of the service account.
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Configured Tasks

The Configured Tasks section displays configuration information about tasks that have been created
and modified using the Scheduler program.

Table 34 Configured Tasks features

Feature Description
Task Name The name of the task.
The following status types can be displayed:
* @ The task is enabled.
Status ° & The task is disabled.
The Task Information summary displays the yellow icon if all configured tasks are
disabled. Otherwise, the summary displays the green icon.
Task Type The type of task, for example Selective Archiving or Journal Mining.

Process Count

Journal Mining only: Displays the number of processes that are configured to run
concurrently.

Schedule Frequency

Journal Mining only: Displays the frequency of the processes that are configured to
run concurrently.

Journal Mining

The Journal Mining section contains information on each Microsoft Exchange Journal Mailbox being
mined. It includes three areas: Exchange Statistics, Process Information, and Message Statistics. If

any of these areas has minor or major error conditions, then a fourth section is displayed. The fourth
areq, Processes in Failed or Retry State, contains information about the particular processes that have

errors.

Table 35 Journal Mining features

Feature

Description

Exchange Statistics

¢ Connection Status:
€2 The Exchange server is available and communicating with the email miner.

€ A connection to the Exchange server cannot be completed.

* Exchange Server: The Exchange server on which the journal mailbox resides.
¢ Journal Mailbox Name: The name of the journal mailbox being mined.

* Journal Message Count: The number of messages in the journal mailbox at the
time statistics were collected.

* Journal Folder Size: The size (in KB) of the journal mailbox at the time statistics
were collected.

¢ Failed To Archive Count: The number of messages in the FailedToArchive folder
of the journal mailbox at the time statistics were collected.

* Failed To Archive Size: The size (in KB) of the FailedToArchive folder of the

journal mailbox at the time statistics were collected.

HP IAP 2.1 Administrator Guide 143



Feature

Description

Process Information

Status:

2 No error conditions for any journal mining process on the journal mailbox.

% A journal mining process is in a retry state.

[ A journal mining process is in a failed state.

Active: The number of journal mining processes that were executing at the time
statistics were collected.

Failed: The number of journal mining processes that were in a failed state at the
time statistics were collected.

Retry: The number of journal mining processes that were in a retry state ot the
time statistics were collected.

Completed: The number of journal mining processes that had completed processing
at the time statistics were collected.

Queued: The number of journal mining processes that were queued for execution
at the time statistics were collected.

Message Statistics

Processed: The number of messages that have been processed. Note that pro-
cessed means different things depending on the context in which it is displayed.

Submitted: The number of messages that were submitted to the IAP for archiving.

Tombstoned: The number of messages that were replaced with “stubs” on the
Exchange server.

Ignored: The number of messages that were ignored. Note that ignored means
different things depending on the context in which it is displayed.

Rejected: The number of messages that were rejected because there was something
wrong with the original MAPI message, possibly message corruption on the Ex-
change server.

Average Processing Rate (msg/sec): The average processing rate.

Processes in Failed or
Retry State

Entry: This information helps identify the process that has entered a failed or retry
state. An icon identifies the state:

. A minor error has occurred. These errors will be retried.

(2 A major error has occurred. These errors will not be retried.

Status: The problem that caused the process to enter a failed or retry state.
Proc: The number of messages that were processed before the condition occurred.

Tomb: The number of messages that were tombstoned before the condition oc-
curred.

Sub: The number of messages that were submitted to the IAP before the condition
occurred.

Rej: The number of messages that were rejected before the condition occurred.
Ign: The number of messages that were ignored before the condition occurred.

Elapsed: The number of elapsed seconds of processing before the condition oc
curred.

Last Run: The date and time that the condition occurred.
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Selective Archiving

The Selective Archiving section contains the following areas described in Journal Mining:
*  Process Information

Message Statistics
Processes in Failed Or Retry State

See “Journal Mining” on page 143 for information on these areas.

Synchronize Deleted ltems

The Synchronize Deleted ltems section contains the following areas described in Journal Mining
*  Process Information

* Message Statistics

* Processes in Failed Or Retry State

See “Journal Mining” on page 143 for information on these areas.

Tombstone Maintenance

The Tombstone Maintenance section contains the following areas described in Journal Mining:
*  Process Information

Message Statistics
Processes in Failed Or Retry State

See “Journal Mining” on page 143 for information on these areas.
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11 Enabling the AuditLog

The Auditlog provides a surveillance system log for companies that are required to prove they are
adhering to compliance processes. The Auditlog records details about the following types of actions:

* Actions that users perform from the Web Interface, such as searching for an email, downloading
a file, or viewing a message.

* Actions that are performed to manually delete emails from the IAP. Logged actions include granting
Administrative Delete privileges to a user from the IAP's Platform Control Center (PCC), and deleting
emails from the IAP via the Administrative Delete feature in the Web Interface.

*  Actions that are performed to merge duplicate copies of an email in IAP's Duplicate Manager.

For a complete list of the actions that are logged, and for information on performing Auditlog repository
queries, see “Querying the Auditlog” in the IAP user guide.

This chapter describes how to enable the Auditlog feature, set the retention period, monitor status,
and grant user access fo the repository.

* Enabling the Auditlog feature, page 147

* Granting user access to Auditlog repository, page 148
* Monitoring status, page 149

* Auditlog repository retention period, page 149

Enabling the Auditlog feature

The Auditlog feature is enabled per domain. To enable the feature:
1. In a virtual IAP environment, follow steps a-e below.
In non-virtual IAP environments, go to step 2.
Start vSphere Client by selecting Start > All Programs > VMware > VMware vSphere Client.

Log in to the vCenter Server that manages the ESXi host using the IP address, Administrator
ID, and password.

c. Select the ESXi host.
d. Click the kickstart virtual server.
e. Click the Console tab.
At the kickstart console, log in as the root user.
Open the Domain. jcml file:
a. At the prompt enter:
# cd /install/configs/primary
b. Open Domain.jcml in a text editor.
For example:

# vi Domain.jcml
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Add the following attributes inthe /install/configs/primary/Domain.jcml file for each
domain in which the Auditlog feature needs to be enabled:

* AuditLogEnabled=true
* domainLog IP=<VIP for this domain>

It the IAP is part of a replicated site, the value of the domainlog_IP attribute needs to be the
VIP of the primary site. (Note that replication is not currently available in virtual IAP environ-
ments.)

® DocClass=email,windoc

Save and close the file.

Run the Registryloader by entering:

# regloader.pl —cv —clearallConfirm=<IAP Name>

Enter y at prompt to confirm.

After the Registryloader has completed its run, open the PCC console and log in as the root user.
Restart the IAP from the PCC:

# /opt/bin/restart

Log into PCC Web Administration.

The General Configuration Platform Settings page should show the Auditlog Service as enabled.
See “Monitoring status” on page 149.

Granting user access to the Auditlog repository

By default, no user has access to the Auditlog repository. To grant access to a compliance officer or

other user:
1. Llog in to the Platform Control Center (PCC).
2. Go to the Account Manager page (User Management > Account Manager).
3. Click the User radio button at the top of the page.
4. Find the user's name in the list.
You can search for the user with the letter buttons, or by using the search function.
See “Account Manager features” on page 74 for information about user name searches.
5. In the Integrated Archive Platform Account and LDAP Information form that appears, clear the
check box labeled Deactivate this check box and then edit the user entries.
6. Click any entry in the Direct Repositories box.
There should be at least one entry in the box, for the user's personal repository.
In the Adding Repository Access form that appears, click the Other tab.
Select the check box for the Auditlog repository, for example
<domainname>.userauditlog.repository.
B NOTE:
The user's personal repository must be in the same domain as the Auditlog repository.
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9. Click Save to List.
10. Click Exit.

The repository is added to the user's direct repositories.

Monitoring status

Use the PCC Platform Settings page (General Configuration > Platform Settings) to check whether the
Auditlog feature (Auditlog Service) is enabled for a specific domain.

i 15.186.248.162 can siore from MS Exchange

Virtual IPs and Type:

& Emails - | | Documents

¥ Enabled 30 days (Reguiated: 20 5 unreguiated: 20)

Supported Object Type:
LDAP User Management:  WEnsbisg
indexing Service: W Enabled
Replication Service:  MDissbled

Default Domain Retention Period:
RetentionBasis:  ingestDers
Duplicate Filtering:  #Enabiec
[RuditLog Service:  Wenabisa
Tape Backup: M Enabisd
Admin Delete Service:  XDizableg
Folder Support:  W{Enabied

Figure 35 Auditlog enabled

Auditlog repository retention period

The default retention period for the Auditlog repository is seven years, and can be changed. For
instructions on changing the retention period, go to “Editing repository retention periods” on page 106.
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12 Optional backup system

B NOTE:

In virtual IAP environments, the optional backup system is not available. You must use another enterprise
backup solution to back up the virtual IAP system.

For customers who require a tape backup of IAP configuration, DB2 database, and Smartcell datq,
HP offers an optional backup system which runs HP Data Protector backup service software. An HP
authorized representative can add the optional backup system by adding one or more backup servers
to IAP and pre-configuring the backup system. The HP representative enables the hardware and
application backup (APP) in the BlackBoxConfig.bct file and sets the Domain.jcml
DataBackupEnabled flag to true: DataBackupEnabled=true

Once properly configured, the backup server does not require manual interaction (beyond managing
tapes; for example, making sure there are enough free tapes in the library). Administrators need to
scan and format the tapes — tapes can only be used for backup after they are formatted. For more
information, consult the Data Protector documentation.

Administrators are also expected to connect the media to the backup server and configure the device
for single or additional backup servers. For more information, consult the Data Protector documentation.

The PCC Backup pages provide general backup status information for database, configuration, and
Smartcell data.

Topics in this chapter include:

¢ Default configuration, page 152

* Changing the configuration, page 155

* Operational workflow for vaulting, page 157

* Restoration of a Smartcell group from a vaulted tape, page 159
* Restoration in case of non-Smartcell group data loss, page 161
* Restoring IAP configuration information, page 161

* Troubleshooting, page 164

* Configuring multiple backup servers, page 162

For more information and best practices, see the Data Protector 6.1 Concepts Guide available at
http://www.hp.com/support/manuals and Data Protector online help.
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Detault configuration

Data Protector (as a backup solution) is automatically installed and pre-configured on IAP. This
configuration includes:

¢ Auto-configuring of your attached tape library by Data Protector
* Adding the IAP Smartcells, DB2 database, and configuration data to the backup specification
¢ Setting up a default backup schedule

After the HP representative has set up backup, backups are done on a regular basis using the attached
tape library. However, you may want to change this configuration to customize the setup to certain
needs or to infroduce vaulting capabilities. This chapter includes a sample scenario which explains
how to use Data Protector to make these changes.

Tape library

Data Protector auto-configures the attached tape library when the HP service representative or
administrator uses the Autoconfigure Devices option to auto detect the library. (To use this option, use
VNC to open the Data Protector user interface, select the Devices & Media context, right-click Devices,
and then select Autoconfigure Devices.)

You can see the configuration by selecting the Devices & Media context from the Data Protector user
interface. To open the Data Protector interface, initiate a VNC connection from the PCC or your local
desktop to the backup server.

After expanding the Devices section, you can see the drives, robotic paths and slots. In this example,
the tape library has two tape drives and several slots for tapes partly loaded with tapes. Data Protector
uses its standard algorithm for tape rotation to use the tapes equally available in the tape library.

@ HP:MSL G3 Series_hs-s0-169-1 - HP Data Protecior Manager
File Edit ¥View Actions Help

e
.

%171 Environrent & ] |Name: |Descriptinn
o= Automated Cperations Drives Physical drives of library
o~ [ifl Device Policies i Robotics Paths
o5 Devices slots Physical slots of library

+ 47 [HP:M5L G3 Series bs-s0-168-1

%=1 Drives
—{=J HP:Ultrium 4-5CS1 1 _hs-s0-169-1
—{=J HP:Ultrium 4-5CSI_2_hs-s0-169-1

-7 Robotics Paths

S j%;:ts
— b1
—& 2 [BESEE9L4]
—& 3 [BESSETL4]
—& 4 [BESEE3L4]
—& 5 [BESSS0L4]
—& 5 [BESLE6L4]
— 5P 7
—& g [BESEE5L4]
7 g

Figure 36 Data Protector Devices & Media
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B NOTE:

The tape library drive is specified in the backup specification by going to the Data Protector Backup
context, expanding the tree, and selecting one backup specification, e.g. IAP_DATA, selecting the

Destination tab, and selecting the tape library drive, and clicking Apply. After performing the same
steps for the other backup specifications IAP_CONFIG, and IAP_DB?2, backup runs on the schedule.

Setting the busy drive handling option

The busy drive handling option must be set as “Eject Medium” to prevent errors when there are queued
operations and the backup device drive is busy. To configure this option, perform the following steps
after auto configuring the backup device:

1. Initiate a VNC connection from the PCC or your local desktop to the backup server, and then
open the Data Protector user interface.

Select the Devices & Media context, right-click Devices, and then select Devices by Host.
Expand the backup server item.

Right-click HP:MSL G3 Series_bs-s0-169-1, and select Properties.

In the setftings on the right side of the window, click the Control tab.

In the Busy drive handling drop-down menu, change the option to Eject Medium.

Click Apply.

N o v s wN

%] Properties for HF;MEL GI Seres_bs-s0-163-1 - WP Data Profecion Manager
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Figure 37 Busy drive handling
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Backup specification and scheduling

The auto-configuration also sets up the backup specification including the data sources, shown in the
figure below. You can access it by selecting Backup from the context drop down box. The left pane
lists all backup specifications needed to properly back up your IAP, i.e. IAP_CONFIG, IAP_DATA,
and IAP_DB2. The right pane shows the properties for each individual backup specification, in the
data sources. The Smartcells that are included are automatically updated whenever the Smartcells
setup of the IAP changes. You should not make any changes here. If you experience misconfigurations
here, contact HP.

B NOTE:

If an AP configuration was changed fo remove some existing Smartcell groups and add new groups,
the tape backup console will show the old groups that are removed as registered backup clients.
Although, these groups are still available in the tape backup console, these groups are not selected
as a source for backup in the specification. Only valid groups are selected for backup.

[®] Backugs - I8P DATA - HP Data Protector Manager

| -2 Backup
o) Backup Specifications
o[ Filesyrstem
Bl AP COMFIG
E AE DaTA
Bl tar_DEZ
o] Templates

:[: Source

7 (3 mternal Database |
e [ g8 be-s0-168-1. munich.com
= B d02000c2edchiTal 22606710520, munich.com
e [ B hpes0-71-1.munich.com
= 7 8 ke0-107-1.munich.com
e [ Q, s0-51-172-1. munich.com
e [ B sc-s1-172-2.munich.com
o [ ® sc-s2-204-1.munich.com
e 7 8 so-s2-204-2.munich.com
e [0 B tn-z0-101-2.munich.com

Figure 38 Backup Specifications and Source

If you click Schedule, you will see the predefined schedule. As you can see, the schedule is automatically
set up to do a full backup every four weeks and an incremental backup once a day.
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Figure 39 Backup Schedule

Changing the configuration

The section above introduced Data Protector and explained the default backup configuration that IAP
uses. Let's look at what you would need to do to deviate from this default configuration and customize
your backup strategy to a full backup every two weeks and an incremental backup once a day.

B NOTE:

It is best to have the full backups of IAP_CONFIG, IAP_DATA, and IAP_DB2 at the same point in time
in case you would like to use the vaulting strategy (described later in this chapter).

The first step is to change the backup schedule for each backup specification. To do this, select the
Schedule tab and click Reset. This will remove all pre-configured schedules. Then click Add and set

up the schedule for the full backup as shown below. After you click OK, every other Friday in the
calendar should be marked red.
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Figure 40 Full backup

The second step is to do the same to set up the incremental backups. Note that for both schedules it
is very important that you specify backup protection to four weeks, so that Data Protector can reuse

the tapes after four weeks.

Specily the desired bachup time, frequency, duration,

and type.
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I Mone Time: 12:00 AME
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Eaclkup protection |Weeks

i

Figure 41 Incremental backup
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Having changed the configuration, your backup works already. If you do not need any vaulting you
can stop here; Data Protector will automatically use the available tapes for storage and make sure
that your data is protected. However, you may want to infroduce some vaulting capability and store
sets of tapes offsite. This will be explained in the next section.

Operational workflow for vaulting

One recommended way to perform vaulting is to have three different sets of tapes and cycle through
them. This means:

*  For the first backup cycle have a set of tapes in the tape library storing the data of the first full
backup followed by the frequently applied incremental backups

*  After the first backup cycle, the complete set of tapes used for the backup is replaced by a second
set of tapes. The first set can be brought to an offsite location for vaulting purposes.

¢ After another backup cycle, the second set of tapes is replaced by a third set of tapes. Now the
second set of tapes can be brought to the offsite location as well.

*  After yet another backup cycle, the third set of tapes is replaced by the first set of tapes, overwriting
the old backup.

For the sample scenario explained in the previous section, the duration of a cycle would be four
weeks. A backup cycle always begins with a full backup followed by a number of (optional) incremental
backups and ends with the last incremental backup before a new full backup.

To enhance data protection even more, the scenario could be extended by making copies of the sets
of tapes before moving them to one offsite location. The copies could then be moved to another offsite

location.

Estimating needed number of tapes

Let's assume that there is only one pair of Smartcells in the IAP, i.e. you have 5 TB of data to back
up. Therefore, for the full backup you need roughly a maximum of seven tapes (assuming LTO-4).
Depending on how many changes there are during one backup cycle, you need an appropriate
additional amount of tapes for the incremental backups, say one more tape. For three different set of
tapes (for vaulting) you need 24 tapes.

In the same scenario for LTO-3 you would need twice as many tapes.

This is a rough estimate and it can deviate depending on your use case. The amount of changes can
also vary over time within one setup, so you should always make sure that there are enough tapes in
the library. For a quick overview, however, the following table shows the numbers of tapes needed
for one backup cycle (note that you will need three times as many tapes for implementing vaulting).

Smaricells LTO-3 tapes LTO-4 tapes
1(5T8) 16 3

2 (10 TB) 32 16

3(15TB) 48 24

Refer to Data Protector Concepts Guide, Chapter 3 “Media management and devices” for more
information.
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Replacing tapes

Let's assume that you have the first set of tapes already in the library and the backup is working. After

each backup cycle, operational work is required.

You can determine the end of a complete backup cycle by looking at the backup schedule. A backup
cycle ends with the last incremental backup before a new full backup.

If you would like to make sure that your operational work does not conflict with the next full backup,

navigate to the PCC Web Interface and disable all backup schedules. Also make sure that no backup
is currently running using the Data Protector graphical user interface. Don't forget to enable the backup
schedule once you are done with operational work.

You can label tapes, eject them and replace them with new ones from within the Devices & Media
context in Data Protector. Navigate from Devices via your tape library to the Slots node and expand
it. You should see all your tapes.

To check which tapes were used for backup and need to be ejected, select each tape and click the
Objects tab. This shows you the backup object it contains. It also shows the backup times (Start
Time/End Time), which you can use to determine if a tape was used in the current backup cycle or

not.

[ General | Info [ Objects | Usage |
:F Ohijects backed up on medium.
Status  |Object.. [all.. [Client.. |Source |Des. |Size(®. [Bac.. [Start Time |End Time D
} Comple.. Filegysiem  Tes les-50-107-... f i/ 00028 full Bf12/09 7:06.. |Bf12/00 7. 0605 AM | Pro+|
} Comple.. Filesystemm  Yes bessO 165 1.,/ i/ g full Bfl2/09 701, 51408 701458 AM P
} Comple.. Filesystemm  Yes les-s0-107-.. f i/ 2] full Bfl2/09 701, 51408 701458 AM P
} Comple.. Filesystemm  Yes hpsl-71-1..¢ i/ o] full Bfl2/09 701, 51408 701458 AM P
} Comple.. Filesystemm  Yes tn-s-101-.. f i/ 2 full Bfl2/09 701, 51408 701458 AM P
} Aborted Filesystem  Ho gid020014... fstore futore 10060214 full BFL2/09 633, Bl 68205 AM  Pr
} Aborted Filesystem  Ho gid020014... fstore futore 101290733 full BfL2/09 533, BlAp00 65905 AM  Pry=
} Comple.. Filesystemm  Yes les-s0-107-.. f i/ 404273 incr BFL2M09 12: 1. 8124009 12:14:05 A Pr
} Comple.. Filesystemm  Yes gid020014... fstore futore 7 incr BFL2/09 12:0. 5124009 124:07:13 AM Pr
} Comple.. Filesystemm  Yes gid020014... fstore futore 12 incr BFL2/09 12:0. 5124009 124:07:13 AM Pr
} Comple.. Filesystemm  Yes les-s0-107-.. f i/ 4 incr BFL2/09 12:0. 514009 124:02:21 AT Pe

Figure 42 Backup Obiject

B NOTE:

Data Protector respects retention times set in the backup schedule. This means that no backup object
will be overwritten on a tape until it expires. It also means that you do not have to delete certain
backup objects, since Data Protector will automatically do that if it needs the space on the tape.

Before ejecting a tape:

1. Go to Data Protector Ul Device & Media > Device > Slofs, select the tape you want to eject for
vaulting, and then right-click and select Recycle.

2. Again select the tape and click Export.

3. Select the tape and click Eject.

4. The tape will be ejected and can be taken to an offsite location for vaulting.

Every tape you eject should be replaced by a tape from the next set of tapes.
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9 TIP:
If you have many tapes fo eject, select them all while holding down the Cirl key to select them

individually or while holding down the Shift key to select a complete range. Then open the context
menu and select Eject.

When you hold down the Cirl+eject keys you see a page that lets you enter a vault location for a tape
— for multiple tapes it will ask one by one the location. After you enter the location for all the tapes,
they will eject.

® IMPORTANT:

You should not eject a tape directly from the library panel. If you do, Data Protector cannot keep
track of the tapes. Always use Data Protector to eject backup tapes. To enter a tape, insert it info the
tape library and select Enter on an empty slot from within Data Protector.
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Figure 43 Entering a tape

After replacing all used tapes of the set by a new set, you should move the ejected set of tapes to an
offsite location for vaulting purposes. Do not forget to enable your backup schedule if you disabled
it for replacing the tapes. The operational work is done. After the next backup cycle, perform the
operational work again.

Restoration of a Smartcell group from a vaulted tape

If you experience the loss of both Smartcells in a group, you can use the last backups to restore the
Smartcell group. (If you lose only one Smartcell of a group, use the PCC Smartcell Cloning menu
function to recover the lost Smartcell.) To recover both Smaricells from tape, go to the PCC Data
Management Backup page and make sure that backup scheduling is disabled.

With the backup scheduling disabled, verify that there are no backups in progress using the Data
Protector console’s Monitor context. For example, the Current Sessions view should display the sentence
“No running sessions.”

Once you have verified that no backups are in progress, eject the current set of tapes from the tape
library and replace them with the set of tapes from the last full backup of the Smartcell group.

When the tapes are in the tape library, use the Data Protector console’s Devices & Media context to
scan the barcodes of the tapes. If the tapes were created on a different backup server, or if the backup
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server has had its Data Protector’s internal database (IDB) cleared of information about the vaulted
tapes, then the tapes will be listed as either “DataProtector Foreign” or “unknown” tape formats. If
either of these formats is displayed after the scan barcode function, then highlight the tapes and select
the Import Catalog function.

Importing a medium writes detailed information about backed up data that is on the medium to the
IDB, so that you can later browse it for a restore. Use media import when moving your media between
Data Protector cells. This operation is not available for media in free pools. Refer to the HP OpenView
Storage Data Protector Administrator’s Guide for more information on media management.

After inserting vaulted tapes:

1.  Scan the device.

2. Rightclick the slot/tape and click Import. The sessions will be imported.

B NOTE:
Attribute information such as object or media size is not reconstructed during import. Thus the size
of the imported objects will be shown as O KB. Importing can take a considerable amount of time,
depending on the device and media used.

® IMPORTANT:

Import all media used in one backup session at once. If you add only some media from the backup
session, you will not be able to restore data spanning to other media.

When finished importing the catalog, verify that the correct tapes have been mounted and cataloged
by using the Data Protector console’s Devices & Media context. Also examine each slot of the tape
library under the Objects tab to verify that the Smartcell group's data is on tape in one or more of the
slots, i.e. under the heading Client you should see the groupid (gid0200...) of the Smartcell group
that was backed up. Verify that the tapes are loaded by looking at each of the tapes, searching for
the Smartcell group ID.

With the tapes from the last full backup placed in the tape library, use the PCC Restore Smartcell
Group menu function to start the Smartcell group restore. The PCC will allocate a Smartcell to hold
the restored data and Data Protector will begin reading data from the tape restoring it to the newly
allocated Smartcell.

During the restore process, you may find that the restore requires additional tapes from subsequent
incremental backups. Use the Data Protector’s Monitor context to keep track of the progress of the
restore, and respond to the additional media mount requests as Data Protector issues them. Pay close
attention to the device and slot information that is displayed in the mount message and make sure to
place the correct tape into the requested device and slot. For more information about Data Protector
devices and media management, refer to the Data Protector documentation.

When all the data has been restored, the PCC will manage the post data restore processing. It will
require user interaction to start cloning to complete the restore process.
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Restoration in case of non-Smartcell group data loss

If you experience data loss of backed up information other than Smartcell groups, use Data Protector
for the restoration process. Change to the Restore context and expand the Filesystem node. Select
the client and backup object you would like to restore and click Restore. Data Protector will
automatically know which tape it needs. If the tape is not in the library Data Protector will tell you.
From the location label you will know where the tape is located.

Restoring IAP configuration information

The tape backup system stores selected IAP configuration information to tape. The Data Protector
backup specification named IAP_CONFIG defines the specific information that is stored to tape.

The IAP_CONFIG backup specification stores information from the PCC, kickstart, and backup servers:

* The PCC server information includes server certificates and host keys.
* The kickstart server information includes IAP configuration and Archive Gateway backup data.

¢ The backup server information includes backup specifications and schedules.

In the event that the configuration information is lost, overwritten or corrupted, it can be recovered
from the tape backup. The information should be restored only on an as needed basis as it may not
be as current as information stored on servers themselves. The information stored on the tape backup
is infended for disaster recovery and under most operating conditions; it should not need to be restored.

The IAP_CONFIG information is restored using the Tape Backup Console (the Data Protector graphical
user inferface). To bring up the console:

1. Open the tape backup console by clicking the tab on the backup page in the IAP PCC UL.

2. In the tape backup console, connect to the HP Data Protector Cell Manager, by selecting File >
Connect to Cell Manager. Select the primary backup server to connect. If you are already connec
ted you can skip the connection step.

3. Once connected, you can use the Data Protector Restore context to select the information to restore.
The information is restored by selecting the machine and then selecting the files to restore from
tape using the Source tab. In the example below, the PCC server (tn-s0-101-2.viap11.com) certi-
ficate and host key files are being restored.

HP IAP 2.1 Administrator Guide 161



Testowa |- i)

Praprertios e { 4 - 187 Dta Fraticto: Maapr
File Edit Wimy Scfsane Help

= RET

¥ ] Resiore Chincts
] Dizk Image
¥ S Filesysiem
* bi-s0-133-1mapl L.oom
B0 AN CEEYEL 24
g0 E0C0C IR0 CEL ZhEE
gE0C0CI00 DL DRy
g0E0C0CIa0 eI DR0 4
00l hTEAe S0l 2308
k3501 0T-1mapl 1,0om
e 20-101-2viapl Lcom
F P
&= ] Trnarieal D b
L b Sgssiinin
G o] I Y
S0 e AL
0, G L -

e el By RS
ot Re ol Iy R
oot et ) = |
pomd el e =R

=l LT
el 2L TS
= i 0L ML AT
A LT3
A LT
i 0L LNT-L
A L3
= R 0L OS2
2Ll
R 201NN
= 0 LR

#2 Olgects | 3 Taaka |

i T ...

Sparce | Destination | Optsons

Seluck the filex and dirsctarie that you mant 1o resloes

Seareh tnwereal |Last & weanthy

v -F
F e
=T
o e 4]
i B et L1
F ) Makefik
F Y ca-bundliert
F ) Incalbecbort
F Y licaltestart NEUP 12584 30070
=3 1 maksdummycort
v F D prvae
F 7 Insalbact ooy
B ] ncalhest ey DEUP 155041 3003

R Progetees Tor /7] | W Praperting fod 1]

Figure 44 Restoring information

Peglces

: Prasiwa |

| Devices | Bodi | Coples | Reskore Summang

Carecal

4. Click the Destination tab and verify that the files are being restored to their original locations
and that the most recent file is being used.

5. Click the button labeled Restore (located at the bottom of the page) when all the options have
been selected. The Preview button can be used to perform the restore without actually storing the
files to the destination. After clicking Restore or Preview you may be asked to choose multiple
or single objects to restore. If you are not asked this question, then skip to step 7. Otherwise,
choose single and click Next.

If asked to select host (object), make sure you select the host chosen earlier (step 3) from the drop-
down box. In this example, we are restoring the PCC (tn-s0-101.2.viap11.com).

A summary of the proposed restore will be displayed. If it is correct, click Finish. Otherwise, use
the Back button to navigate back and make your changes. Once Finish is clicked, the restore is
started as a Data Protector restore session and progress messages will be displayed. When the

restore is finished, a completion message is displayed.

Configuring multiple backup servers

IAP 2.1 supports adding multiple backup servers to shorten full backup cycles. We recommend that

you add one backup server per 50 TB of data. Up to three backup servers are supported. This translates
to 25 groups of 2 TB Smartcells or 10 groups of 5 TB Smartcells per backup server. If more than three
backup servers are required, replication should be used.

The installation of additional backup servers is the same as installing the primary backup server.

The HP Data Protector Cell Manager is installed and configured to work only from the primary backup
sever. (This is the first backup server configured in the BlackboxConfig.bct file, typically
10.0.169.1). The tape backup console (the Data Protector graphical user interface) runs on the
primary backup server and all the backup specifications and media configurations are configured
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and controlled from the primary backup server. A default specification is provided and can be
customized based on the customer needs.

The second and third backup servers act as media agents only, providing additional backup devices
to increase the amount of data that can be concurrently backed up. Additional tape devices are
connected to these backup servers. Once the device and media is connected to the additional backup
servers, the backup devices can be imported into the primary backup server as devices from the
additional backup servers. The importing of devices is done using the tape backup console running
on the primary backup server.

If the primary backup server is down for any reason, tape backup will not be run. If the primary
backup server cannot be brought back up, the IAP must be reconfigured to use one of the additional
backup servers as the primary backup server.

Automatic failover of the primary backup server to one of the additional backup servers is not supported
in IAP 2.1. A fresh kick of the backup servers is used to perform the reconfiguration to a different
primary backup server.

To reconfigure backup server configurations, comment or remove the “down” backup server from the
BlackboxConfig.bct file, then kick all the backup servers. Note that the regloader.pl -cv
command needs to be run after changing the Blackbox.bct file.

To configure devices attached to additional backup servers:

1. Open the tape backup console using the tab on the backup page in the IAP PCC UL

2. In the tape backup console, connect to the HP Data Protector Cell Manager, by selecting File >
Connect to Cell Manager. Select the primary backup server to connect. If you are already connec-
ted you can skip the connection step.

3. Once connected, configure the devices connected to the additional backup servers using the
Devices & Media drop down menu. In the figure example below, bs-s0-169-2.paris.com is the
second backup server:

[®] Devices - WP Dta Protecior Manager
| File Edit View Actions Help

Devices & Media | - I I 4 = -

- Ermronmant

i | H o

Figure 45 Configuring devices
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4. To add an additional backup device, right-click the Devices by host menu item and select Add
Device from the drop down menu. In the Client field, choose the additional backup server. As
we mentioned, for our example this would be bs-s0-169-2.paris.com.

5.  Select the device and finish the configuration of the device.

6.  Once the backup device on the additional backup server is configured and its media prepared
for backup, change to the Data Protector Backup context and modify the IAP_DATA backup
specification in the Backup drop down menu to add this newly configured device as the destination
for backup.

7. The backup will run based on the schedule and data is backed up to all the selected media at
the same time. The tapes required for restore are automatically identified by Data Protector and
no additional setup is required.

Troubleshooting

For detailed backup server status information, use the Data Protector graphical user interface running
on the backup server (connecting via VNC). The backup service on the Smartcells, the kickstart server,
and the DB2 server keeps a log file of recent events.

Data Protector keeps a log file on the backup server. This log file is also be included in the IAP log
collection script.

If a problem with the IAP backup occurs, determine if the root cause is on the IAP or on the Data
Protector side. Check the PCC status page and the alerts sent through the alert framework. For example,
an alert notifying you that the library is out of free tapes would clearly indicate that this is a Data
Protector issue in the error message. In addition, the log files both on the IAP and the Data Protector
side help determine on which side the problem originates.

B NOTE:

There is currently a Data Protector limitation in which the Data Protector Devices & Media Usage tab
information for tapes/slots may show zero percent usage even though the Objects tab correctly shows
that data has been imported.
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13 Remote management of servers

B NOTE:

Server remote management is not available in virtual IAP environments.

Server remote management capabilities allow you to perform administrative activities on IAP servers
without having to be physically present at the console. Remote management capabilities allow you
to use remote power management, remote console, and other features that iLO and Lights-Out 100
support. Every server within IAP can be remotely managed using ilO or LO100.

This chapter describes common tasks for administering remote management for IAP servers using HP
Proliant Onboard Administrator Powered by Lights-Out 100 or Integrated Lights-Out 2. Throughout
this chapter we refer to the HP Proliant Onboard Administrator Powered by Lights-Out 100 or Integrated
Lights-Out 2 as LO100, ilO, or Remote Processor.

Topics in this chapter include:

* Remote management solution overview, page 166
* Checking the iLO mode, page 168

* Disabling remote management, page 168

* Using Proxy mode, page 168

* Using Direct mode, page 173

IAP 2.1 hardware (DL180 G6, DL360 G6) and newer will ship with the iLO/LO100 Advanced Pack
license preinstalled on the servers. Customers with previous hardware releases who want the Advanced
Pack features will need to obtain and install the licenses through their standard channels. This chapter
assumes that the Advanced Pack license has been installed on the server. Licenses can be installed
on the servers either through the iLO/LO100 web interface or using the command line tools hponcfg
and 10100cfg. Refer to the iLO/LO100 user guides listed below for details.

Refer to the HP Proliant Onboard Administrator Powered by Lights-Out 100 or Integrated Lights-Out
2 product documentation for comprehensive instructions for configuring and using remote management.

* HP Proliant Lights-Out 100 Remote Management User Guide for HP Proliant DL140 G2, ML110
G3, and ML150 G2 Servers at http://bizsupport1.austin.hp.com/bc/docs/support/SupportManu-
al/c00857454/c00857454 .pdf

* HP Proliant Onboard Administrator Powered by Lights-Out 100 User Guide for HP Proliant ML150
G6, DL160 G6, and DL180 G6 Servers at http://bizsupport1.austin.hp.com/bc/docs/support
SupportManual/c01716486/c01716486.pdf

* HP Integrated Lights-Out User Guide for HP Integrated Lights-Out firmware 1.91 at hitp://bizsup-
port1.austin.hp.com/bc/docs/support/SupportManual /c00209014/c00209014.pdf

* HP Integrated Lights-Out 2 User Guide for Firmware 1.75 and 1.77 at http://bizsupport1.aus-
tin.hp.com/bc/docs/support/SupportManual /c00553302/c00553302. pdf
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Remote management solution overview

Goals

The following sections provide an overview of the IAP remote management solution.

The primary goals of the IAP remote management solution are to:

* Allow you to choose between:

* Direct access to iLO remote management processors via your management network for usability
and higher availability (no single point of failure).

* Proxy access to iLO remote management processors for manageability and greater security.

* For any IAP server, allow you to:
* Establish a secure connection to the iLO remote management processors.
* Power cycle or turn the remote server on or off.
* Monitor or interact with the boot sequence of the remote server.

* Access local media or ISO images on the server to remotely upgrade firmware.

Network topologies

The IAP remote management network keeps the iLO remote management processors isolated, both
physically and logically. The administrator can choose whether the IAP remote management network
is connected to the customer management network directly or by proxy. For both direct and proxy
access, the PCC remote management processor must always be connected to the customer management
network.

Direct mode

In Direct mode the iLO interfaces of the IAP servers are connected to the customer management network
directly. Since the IAP remote management network is self-contained, connecting it directly to the
customer network does not pose the risk of accidentally exposing internal IAP network. In this network
topology, a port on one of the dedicated remote management network switches is uplinked to a switch
in the customer's management network. The administrator is then responsible for configuring and
managing access to the remote processors in the IAP. For example, the administrator has to allocate
IP addresses on his network for each remote management processor in the IAP. This association
between a given AP server and its remote management processor has to be maintained by the
administrator, e.g. using a spreadsheet that needs to be updated each time physical servers are
added or replaced in the IAP. To help with the setup task, HP provides a PCC command to use to set
up the network settings and user management of the remote management processors. This script and
the required configurations steps are discussed below.

Advantages:
*  Usability
* Can access all remote management processors concurrently.

* Can be integrated with customer network management solution for access from their manage-
ment console.

* Availability: Direct access to remote management processors means no IAP Single Point of Failure.

Disadvantages or limitations:
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¢ Security: All internal IAP servers can be accessed via their remote management processor, bypassing
the IAP firewalls.

* Potential for unauthorized access to IAP servers
* The administrator is responsible for restricting access to the IAP remote management processors
only to authorized personnel
* Manageability: No automated mapping of a given IAP server IP address fo its remote management
processor IP address.

* Requires maintaining manually a mapping of IAP server IP fo remote management processor
IP

* Such a mapping would have to be communicated to HP Support personnel needing access to
the IAP remote management processors

*  More IP addresses required on customer network for IAP: Need one IP address for each IAP
server's remote management processor.

Proxy mode

In Proxy mode all IAP server iLO interfaces are connected through a separate network to the PCC. A
dedicated NIC on the PCC acts as the gateway to the IAP remote management network. Access to
the iLO network is through an additional IP address on the PCC that acts as the proxy. IAP assigns
internal IP addresses to all ilOs and the PCC gateway. The PCC ilO is connected to the customer
management network. Additionally, a Virtual IP (VIP) address on the same network as the PCC IP
address is used for the proxy access from the Ul.

When it is connected by proxy, the network is contained inside the IAP. The remote processors are
not accessible from the outside unless an action is initiated to request access to them. In this network
topology, a user who is successfully authenticated on the PCC or the PCC Web Ul has to request
access to a remote processor 1) via the PCC command line inferface using HP provided commands,
or 2) via the PCC Web UL. The IAP firewall dynamically grants access to one remote management
processor at a time. All access requests to remote processors are logged in an audit log.

Advantages:

*  Security

* Direct access to the remote management processors of all IAP servers (except PCC) is not
available.

* There is an audit log of requests to enable proxy access to remote management processors
*  Manageability

The PCC Ul displays a list of IAP servers and redirects the user transparently to the remote man-
agement processor of the selected server.

* You need fewer IP addresses for IAP on the customer network
You need one IP address for the PCC remote management processor and one VIP for proxy access

from the user interface.
Disadvantages or limitations:
* Usability
Can only enable proxy access to one remote management processor at a time.

* Availability: PCC is an IAP Single Point of Failure.

* Access fo internal remote management processors is via proxy on the PCC, which requires at
a minimum that the PCC operating system and networking are working.

HP IAP 2.1 Administrator Guide 167



* Though access to remote management is through the PCC Ul, JBoss does not need to be up
and running to gain access to the remote management processor. Users can bypass the Ul

and use a direct SSH from the PCC to the ilO.
* You can enable proxy from the command line by running the “iloproxy” script.

* The PCC must be a Proliant DL320 G5 or newer server. (The DL360 G4/G4p are lacking an
eth2 network interface that is required to connect the Remote Management network fo the PCC.)

* The DL140 G2 LO100 web user interface can not be accessed via PCC in Proxy mode. The LO100
command line interface can be accessed by logging on to the PCC and telneting to the IP address
of the LO100 remote processor.

Hardware wiring

All LO100s/ilOs for IAPs hardware generation 2.1 or above are pre-wired at the factory in the proxy
access mode.

At deployment time, the PCC ilO is wired to the customer management network. Should the customer
prefer a direct access topology, the wiring can be altered to remove the connection to the PCC eth?2
interface and uplink the switches to the customer management network.

Checking the iLO mode

To determine the iLO access mode of the IAP, refer to the “REMOTE MANAGEMENT” section of the

/install/configs/primary/BlackBoxConfig.bct configuration file on the kickstart machine.
There is a field called “iLO Access Mode” with the value of either direct or proxy. When this section

is missing from the configuration file, remote management is disabled for the IAP.

Disabling remote management

The IAP is shipped with remote management wired for Proxy mode, but is not enabled by default. If
remote management has been enabled by an administrator, it can be disabled with the following
steps:

1. Editthefile /install/configs/primary/BlackBoxConfig.bct on the kickstart machine
to remove the section “REMOTE MANAGEMENT” from the file.

2. Run createBBC.zr.

3. Run converter.zr

4. Run regloader.pl -cv
Using Proxy mode

Prerequisites

You must supply the following:

* ilO Subnet — The default subnet that iLO is configured with is 10.1.0.0/16. However, if this
conflicts with your network, the subnet can be updated to X.X.0.0/16 as you desire.

The value of 10.1.0.0 for “iLO Subnet” is a default and can be changed to one that is suitable
for your environment. In Proxy mode, the static IP addresses for the iLOs are derived automatically

from the server IP address and assigned on the configured iLO Subnet. For example, when the
server is at IP address 10.0.172.1 and the ilO Subnet is 14.0.0.0/16, then the ilO is assigned

168  Remote management of servers



the IP address 14.0.172.1, and the PCC server's eth2 interface is assigned a static IP address
14.0.0.1 on the iLO network. When the default iLO Subnet of 10.1.0.0 is used, then the iLO of
the server whose IP address is 10.0.172.1 is assigned the IP address 10.1.172.1 and the PCC

server's eth2 interface is assigned the IP address 10.1.0.1.

iLO Proxy VIP — The iLO Proxy VIP is an IP on your network to allow access to the iLO proxy. Enter
the IP in the BCT with the mask binary shorthand. This IP must be on the same subnet as the PCC
external IP.

IP of PCC ilO - The PCC iLO IP is the IP of the PCC’s remote management processor. This IP does
not have to be on the same subnet as the PCC external IP. In Proxy mode, the PCC is the only
server for which its iLO device sits on your network. The rest of the servers use internal IP’s. This

is required to be able to access the PCC ilO device when the PCC server is unreachable.

Configuring remote management

To configure remote management in Proxy mode:

1.

AR

Edit the /install/configs/primary/BlackBoxConfig.bct file on the kickstart machine
to add the following section:

FHEHHE
### REMOTE MANAGEMENT ###
FHEHH

1LO Access Mode: proxy
iLO Subnet: 10.1.0.0/16

iLO Proxy VIP: <proxy VIP>/??
Run createBBC.zr.

Run converter.zr

Run regloader.pl -cv

When run on the PCC server, the following command configures iLO on all the IAP servers, creates
the Administrator user for iLO, and allows you to set the administrator supplied password for that
user:

# /opt/tools/ilo/configure ilo -v -set —-f /opt/tools/ilo/ilo_ips.csv

The file i1o ips.csv is a text file that must be in the directory from which the command is run.
The file must contain the contents:

<Internal IP of PCC><IP of PCC i1L0><iLO netmask><Gateway IP for 1iLO
Subnet>

Here is an example of the contents: 10.0.101.2,15.1.2.30,255.255.0.0,15.1.2.1

When prompted, enter a password for the Administrator account.

Accessing the remote management web interface

To access the remote management web interface of all servers except the PCC:

1.
2.
3.

Log in to the PCC using the PCC external VIP address.
Select Hardware Management from the left menu.

In the Hardware Management view, click the Manage link for the server for which remote man-
agement is required. For iLO, this opens the Remote Management login page for the login cre-
dentials. (For LO100, an intermediate access page will be opened first which provides access
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links for the LO100 Web Ul and the LO100 Virtual KVYM/Media applet. Virtual KVM/Media
features are only available if you are licensed for ILO/LO100 Advanced Pack.)

4. Enter the user ID and Password login credentials to gain access to the remote management web
interface.

To access the remote management web interface of the PCC: Connect to the URL https://<PCC ilO
IP address> directly.

B NOTE:

When Proxy mode is configured, access iLO/LO100 remote management only via the links in the
Hardware Management page of the PCC because each link requests specific iLO/LO100 access for
the server clicked on (since all servers have the same URL for iLO/LO100 in Proxy mode). Also,
logging out (or timing out) from the PCC page will cause the iLO/LO100 access to be revoked.
Therefore, connecting to the URL https://<PCC iLO IP address> directly will not work unless the remote
management web interface has already been accessed at least once via the Hardware Management
page link, and the PCC webpage stays logged in.

B NOTE:

When accessing iLO/LO100 using a web browser, the browser may complain that the certificate
presented matches another server. For IE, click Continue to ignore this warning. For Firefox, remove
the previously stored certificate fo avoid the warning.

Accessing the command line interface

To access the remote management command line interface:

1. Using ssh, log in to the PCC server as the root user.

2. Enter the command ssh Administrator@<iLO IP Address> for the server to which ilO
access is required.

For example, use ssh Administrator@10.1.172.1 to connectto the ilO IP 10.1.172.1.

3. When prompted, enter the password to gain access to the iLO command line interface of that
server.

Using the command line interface to power cycle a server
To use the command line interface to power cycle a server:

1. Using ssh, login to the PCC server as the root user.

B NOTE:
To access the LO100 of DL140 G2 servers, use telnet not ssh.

2. Enter the command ssh Administrator@<iLO IP Address> for the server to which ilO
access is required.

For example, use ssh Administrator@10.1.172.1 to connect fo the iLO IP 10.1.172.1.
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When prompted, enter the password to gain access to the iLO command line interface of that
server.

If you have iLO or ilO2, at the hpiLO-> prompt, enter: power reset

If you have LO100, press Enter at the EMS-> prompt to get the Lights-0Out> prompt and enter
the command: reset [WARM|COLD]

Using the web interface to power cycle a server

To use the web interface to power cycle a server:

1.

w

Log in to the remote management web interface as described above in Accessing the remote
management web interface.

If you are using iLO, click the Virtual Devices tab, and then Virtual Power.
If you are using iLO2, click the Power Management tab at the top.

If you are using LO100, in the left menu click the Power Control Options link, and then select
one of the “Power Control Options” from the pull-down menu and click Apply.

For the ilO type, select one of the power cycle options.

Accessing the KVYM console

To access the KVM console:

1.

LAl

Log in to the remote management web interface as described above in Accessing the remote
management web interface.

If you are using LO100, click the KVM link in the “intermediate” page.
If you are using iLO or iLO2, click the Remote Console tab at the top.

If you are using ilO, click the Remote Console link.

If you are using iLO2, click the Integrated Remote Console link.

The server console will open in a new window.

B NOTE:
Virtual KVM features are only available if you are licensed for ILO/LO100 Advanced Pack.

Monitoring a server reboot

To monitor a server reboot:

1.

NouaswN

Log in to the remote management web interface as described above in Accessing the remote
management web interface.

Click the Remote Console tab at the top.

If you are using ilO, click the Remote Console link.

If you are using iLO2, click the Integrated Remote Console link.

When the server console opens in a new window, log in to the IAP server as the root user.
Enter the command: reboot

Monitor the boot sequence of the server in the console window.
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Turning on a server UID light

To turn on a server UID light:

1.

Log in to the remote management web interface as described above in Accessing the remote
management web interface

If you are using ilO, click the Virtual Devices tab at the top, click the Virtual Indicators link, and
click Turn Unit ID On.

If you are using iLO?2, click the System Status tab at the top and click Turn UID On.

If you are using LO100, click the Power Control Options link in the left menu, select one of the
Chassis Locator options from the pull-down menu, and click Identify.

Power cycling an unresponsive proxy server (PCC)

To power cycle an unresponsive proxy server (PCC):

L

Changing

Connect fo the URL https://<iLO IP address> to access proxy server (PCC) ilO.
Log in fo the remote management web interface using the user ID and password.

If you are using iLO, click the Virtual Devices tab, and then Virtual Power.

If you are using iLO2, click the Power Management tab at the top.

If you are using LO100, click the Power Control Options link in the left menu, select one of the
Power Control Options from the pull-down menu, and click Apply.

To power cycle the proxy server (PCC), select one of the power cycle options available for the
iLO type.

the administrative password on all ilOs

To change the administrative password on all iLOs:

1.
2,

Using SSH, log in to the PCC server as the root user.
Enter the command:
# /opt/tools/ilo/configure ilo -changepassword all

When prompted, enter the new password for the administrator account. The new password will
be applied to all configured iLO Administrator accounts.

Updating ilO firmware

To update ilO firmware:

1.

172

If you are using iLO and iLO2 devices, the firmware is automatically updated with the latest
firmware shipped with the IAP whenever the iLO devices are configured. To update to a newer
firmware than what the IAP shipped with:

a. Extract the ilO bin file and place it under /opt/tools/ilo/firmware/<ilo|ilo2>.
b. Enter the command:
# /opt/tools/ilo/configure ilo -query all

If you are using Lights-Out 100 devices, you must manually perform firmware updates:
a. Create the bin file using the firmware package.

b. Place the bin file on the PCC under /tftpboot/firmware/10100/<version> omitting
any periods in the version number.
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c. From the PCC command line, enter the command:
# /opt/tools/ilo/flashL0100 <iLO IP> <admin name> <admin password>
For example, to update LO100 firmware for IP 10.1.172.1, enter the command:

# /opt/tools/ilo/flashL0O100 10.1.172.1 Administrator <admin pass-
word>

The iLO IP is generated by taking the first two octets of the iLO subnet (set in the REMOTE
MANAGEMENT section in the BlackBoxConfig.bct file) and the last two octets of the
host IP.

Configuring the iLO processor of a new or replacement server

Use the configure ilo command from the PCC server to configure iLO on a new or replaced IAP
server, create the Administrator user for iLO, and set the customer supplied password for that user:

1. Run /opt/tools/ilo/configure ilo -v -set -f ilo ips.csv <IP Address>

<IP Address>is the new or replaced server’s IAP IP address. For example, use /opt/tools/
ilo/configure ilo -v -set -f ilo ips.csv 10.0.172.11foconﬁgumtheiK)of
the server whose IP address is 10.0.172.11.

2. Enter a password for the Administrator account when prompted.

The file i1o_ips.csv is a text file that must be current directory with the following contents:
<Internal IP of IAP server><IP of PCC iL0><iLO netmask><Gateway IP for iLO Subnet>

The following line is an example of the contents of the 110 ips.csv file:

10.0.101.2,15.1.2.30,255.255.0.0,15.1.2.1

Using Direct mode

Prerequisites

You must supply one IP address for each server to be configured with iLO access.

Configuring remote management

To configure remote management in Direct mode:

1. Editthe /install/configs/primary/BlackBoxConfig.bct file on the kickstart machine
to add the following section:

FHAFE A
### REMOTE MANAGEMENT ###
FHAF A

iLO Access Mode: direct
2. Run createBBC.zr.
3. Run converter.zr

4. Run regloader.pl -cv
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5. When run on the PCC server, the following command configures iLO on all the IAP servers, creates
the Administrator user for iLO, and allows you to set the administrator supplied password for that
user:

# /opt/tools/ilo/configure ilo -v -set —-f ilo ips.csv

The file ilo ips.csvis a text file that must be in the directory from which the command is run.

The file must contain the following entry for each server to be configured with iLO access, one
per line:

<Internal IP of IAP server><IP of 1iL0O><iLO netmask><Gateway IP for
1LO Subnet>

Here is an exomple of the contents: 10.0.204.2,16.1.2.40,255.255.254.0,16.1.2.1

6.  When prompted, enter a password for the Administrator account.

B NOTE:

The IPs of iLO (16.1.2.40) are addresses on the customer management network. One such IP address
must be included in the 1o ips.csv file for each server whose iLO needs to be configured.

Accessing the direct mode remote management web interface
To connect to an IAP server for remote management:

1. Connect to the URL https://<Server iLO IP address>

2. This opens the Remote Management login page for the login credentials. To gain access to the
remote management web inferface, enter the user ID and Password for remote management.

B NOTE:

On the PCC Hardware Management page, the links in the Remote Management column display
Not Enabled in Direct mode.

Accessing the command line interface
To access the remote management command line interface:

1. Enter the command ssh Administrator@<iLO IP Address> for the server to which ilO
access is required.

For example, use ssh Administrator@16.1.2.40 to connect to the iLO IP 16.1.2.40.

2. When prompted, enter the password to gain access to the iLO command line interface of that
server.

Using the command line interface to power cycle a server
To use the command line interface to power cycle a server:

1. Enter the command ssh Administrator@<iLO IP Address> for the server to which ilO
access is required.

2.  When prompted, enter the password to gain access to the iLO command line interface of that
server.

3. If you have iLO or ilO2, at the hpiLO-> prompt, enter: power reset
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4. If you have LO100, press Enter at the EMS-> prompt to get the Lights-Out> prompt and enter
the command: reset [WARM|COLD]

Using the web interface to power cycle a server
To use the web interface to power cycle a server:

1. log in fo the remote management web interface as described above in Accessing the direct mode
remote management web inferface
2. If you are using iLO, click the Virtual Devices tab, and then Virtual Power.

If you are using iLO2, click the Power Management tab at the top.

«

4. If you are using LO100, in the left menu click the Power Control Options link, and then select
one of the “Power Control Options” from the pull-down menu and click Apply.

5. For the ilO type, select one of the power cycle options.

Accessing the KVYM console
To access the KVM console:

1. Log in to the remote management web interface as described above in Accessing the direct mode
remote management web interface

2. Click the Remote Console tab at the top.

3. If you are using iLO, click the Remote Console link.

4. If you are using iLO2, click the Integrated Remote Console link.

The server console will open in a new window.

B NOTE:
Virtual KVM features are only available if you are licensed for ILO/LO100 Advanced Pack.

Monitoring a server reboot
To monitor a server reboot:
1. Log in to the remote management web interface as described above in Accessing the direct mode
remote management web interface
Click the Remote Console tab at the top.
If you are using iLO, click the Remote Console link.
If you are using iLO2, click the Integrated Remote Console link.
When the server console opens in a new window, log in to the IAP server as the root user.
Enter the command: reboot

NowUA®wN

Monitor the boot sequence of the server in the console window.

Turning on a server UID light
To turn on a server UID light:

1. log in to the remote management web interface as described above in Accessing the direct mode
remote management web interface
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Changing

If you are using iLO, click the Virtual Devices tab at the top, click the Virtual Indicators link, and
click Turn Unit ID On.

If you are using iLO2, click the System Status tab at the top and click Turn UID On.

If you are using LO100, click the Power Control Options link in the left menu, select one of the
Chassis Locator options from the pull-down menu, and click Identify.

the administrative password on all ilOs

To change the administrative password on all iLOs:

1.
2.

Using SSH, log in to the PCC server as the root user.
Enter the command:
# /opt/tools/ilo/configure ilo -changepassword all

When prompted, enter the new password for the administrator account. The new password will
be applied to all configured iLO Administrator accounts.

Updating iLO firmware

To update ilO firmware:

1.

If you are using iLO and iLO2 devices, the firmware is automatically updated with the latest
firmware shipped with the IAP whenever the iLO devices are configured. To update to a newer
firmware than what the IAP shipped with:

a. Extract the ilO bin file and place it under /opt/tools/ilo/firmware/<ilo|ilo2>.
b. Enter the command:

# /opt/tools/ilo/configure ilo —query all

If you are using Lights-Out 100 devices, you must manually perform firmware updates:

a. Create the bin file using the firmware package.

b. Place the bin file on the PCC under /tftpboot/firmware/10100/<version> omitting
any periods in the version number.

c.  From the PCC command line, enter the command: /opt/tools/ilo/flashLO100 <iLO
IP> <admin name> <admin password>

For example, to update LO100 firmware for IP 16.1.2.40, enter the command:
# /opt/tools/ilo/flashL0100 16.1.2.40 Administrator <administrator
password>

Configuring the iLO processor of a new or replacement server

Use the configure ilo command from the PCC server to configure iLO on a new or replaced IAP
server, create the Administrator user for iLO, and set the customer supplied password for that user:

1.
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Modify the file /opt/tools/ilo/ilo ips.csv and add or edit the entry for the new server.
Replacement servers do not need modification if they are using the same IP address.

Run /opt/tools/ilo/configure ilo -v -set -f ilo ips.csv

Enter a password for the Administrator account when prompted.
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The file 110 ips.csv is a text file that must be current directory with the following contents:

<Internal IP of IAP server><IP of iL0O><iLO netmask><Gateway IP for iLO Subnet>
The following line is an example of the contents of the 110 ips.csv file:

10.0.204.11,16.1.2.50,255.255.254.0,16.1.2.1

B NOTE:

The IP of iLO (16.1.2.50) is an address on the customer management network.
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A IAP application-generated alerts

The table below shows the application-generated alerts that appear in the IAP system.

These alerts notify the IAP administrator about significant problems that affect or can affect the functional

behavior of the IAP.

Alerts appear on the PCC Overview page, in the Current Platform Alerts area at the top of the page.
They can also be sent fo external monitors or email recipients. (See “SNMP Management” on page 127.)

Alerts are logged as events in the persistent storage (postgres) of the PCC, and displayed among the
other events on the Event Viewer page. (See “Event Viewer” on page 125.)

B NOTE:

Some alerts are generated or cleared with a time delay of up to 30 minutes. (The exact delay depends
on the alert specifics.)

Table 36 IAP application-generated alerts

ID Description Context After PCC/ After manual Alert
server removal fl’om level
restart PCC Overview

System Infrastructure
A010-01 | The Smartcell is The reason is After PCC restart: | Alert disappears | Major
suspended because | specified by various | Alert is shown and is not shown
of a service failure features After server even if the
restart: Alert problem still exists
usually
disappears, or
appears again if
Smartcell is
suspended
A010-03 | The DB2 instance is | Could not create After PCC restart: | Alert disappears | Critical
unavailable connection to DB2 PCC cannot start | and is not shown
unless DB2 is up | even if the

and running
After server
restart: After DB2
restarts the alert
disappears

problem still exists
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ID Description Context After PCC/ After manual Alert
server removal from | level
restart PCC Overview

A010-06 | A DB2 transaction Found gap in DB2 After PCC restart: | Alert is shown Critical

log file is missing transaction log: Alert is shown
Missing log file After server
<missing_tx_log> restart: Alert is
shown
A010-07 | The application JBoss failed to load | After PCC restart: | Alert disappears | Critical
server did not start all the services Alert is shown and is not shown
successfully After server even if the
restart: If the problem still exists
problem is not
fixed, the alert
appears again
A010-09 | The MySQL instance | Could not create After PCC restart: | Alert disappears | Critical
on the Smartcell is connection to MySQL | Alert is shown and is not shown
unavailable After server even if the
restart: After problem still exists
MySQL restarts
the alert
disappears
AO010-11 | The runtime Out of memory error | After PCC restart: | Alert disappears | Critical
environment detected | on server Alert is not shown
an out-of-memory <ip_address> After server
problem restart: This is the
recovery
condition for Out
of Memory alert.
Alert is cleared
when machine
restarts.
A010-12 | The machine cannot | The machine is not | After PCC restart: | Alert disappears | Critical
be reached responding fo Alert is shown and is not shown
‘<command>’ After server even if the
requests, where restart: Alert problem still exists
<command> is ‘ping’ disappears
or ‘netcat at port 22
A010-13 | The application JBoss is down After PCC restart: | Alert disappears | Critical
server on this Alert is shown and is not shown
machine is down After server even if the
restart: Alert problem still exists
disappears
A010-14 | The Postgres instance | Could not create After PCC restart: | Alert disappears | Critical
on the Kickstart is connection to Alert is shown and is not shown
unavailable Postgres (PCC After server even if the
persistent storage) restart: Alert is problem still exists
shown
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ID Description Context After PCC/ After manual Alert
server removal from | level
restart PCC Overview

A010-15 | Free swap space is Free swap space is | After PCC restart: | Alert is shown Minor

less than threshold <free_swap>% Alert is shown
limit (the threshold limit is: | After server
<hreshold free swap>%) | restart: Alert is
shown
A010-16 | Disk partition size Disk Partition After PCC restart: | Alert is shown Minor
has reached the low | <disk_partition_ Alert is shown again when next
threshold limit (95%) | name> is After server check for disk
<used_percentage> | restart: Alert is size is made and
full. <used_absolute> | shown again the disk size is still
is used of when next check | above the
<total_size> for disk sizes is threshold
made and the
disk size is sfill
above the
threshold
A010-17 | Disk partition size Disk Partition After PCC restart: | Alert is shown Maijor
has reached the high | <disk_partition_ Alert is shown again when next
threshold limit (99%) | name> is After server check for disk
<used_percentage> | restart: The alert | Size is made and
fU“ <Used_0bso|ufe> is Shown Ggqin the dlSk size is Sh”
is used of when next check | above the
<total_size> for disk sizes is threshold
made and the
disk size is still
above the
threshold
Archiving
A020-01 | The archiving process | No archiver services | Affer PCC restart: | Alert disappears | Critical
could not find any are available for Alert is shown and is not shown
available Smartcell | domain <domain> After server even if the
group restart: The alert | problem still exists
disappears for a
short period of
time, and appears
again
Indexing
A030-01 | Anindex is corrupted | Index <index> is After PCC restart: | Alert disappears | Major
unavailable and Alert is shown and is not shown
needs repair. Search | After server even if the
results might be restart: The alert | problem still exists
incomplete. disappears if the
problem is
recovered during
Smartcell start-up
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ID Description Context After PCC/ After manual Alert
server removal from | level
restart PCC Overview

Query Service
A040-01 | The query service Group <group> is After PCC restart: | Alert disappears | Major
cannot reach a unavailable for Alert is shown and is not shown
SmartCell group query. Search results | After server even if the
might be incomplete. | rastart: Alert problem still exists
disappears if the
problem is
recovered during
Smartcell restart
Replication
(In virtual IAP systems, replication is not supported and these alerts do not appear.)
A050-01 | The replica SMTP Failed to replicate After PCC restart: | Alert is shown Critical
server cannot be data because the Alert is shown
reached connection to After server
<smtp_server> failed | pastart: Alert is
shown

A050-02 | The replica SMTP Failed to replicate After PCC restart: | Alert is shown Maijor

server is busy data for group Alert is shown
<group> in domain | After server
<domain> because | restart: Alert is
the connection was | shown
closed by the replica
SMTP server at
<smtp_server>

A050-03 | A connection to the | Failed to replicate After PCC restart: | Alert is shown Critical

replica SMTP server | data because Alert is shown

timed out connection to the After server
replica SMTP server | rastart: Alert is
timed out at shown
<smtp_server>

A050-04 | The replication Failed to replicate After PCC restart: | Alert is shown Critical

process failed to send | data for group Alert is shown
data <group> in domain | After server
<domain> restart: Alert is
shown
A050-05 The replica archiving | The replica archiving | After PCC restart: | Alert is shown Critical
service for a group service for group Alert is shown
on the replica system | <group> in domain | After server
is unavailable <domain> is restart: Alert is
unavailable shown
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ID Description Context After PCC/ After manual Alert
server removal from | level
restart PCC Overview

A050-06 | The replication Could not get list of | Affer PCC restart: | Alert is shown Critical

process failed to list | files to replicate for | Alert is shown
files for a group group <group> in After server
domain <domain> | pastart: Alert is
shown

A050-07 | The replication Could not retrieve After PCC restart: | Alert is shown Critical

process cannot data to replicate for | Alert is shown

access data from the | group <group> in After server

source group domain <domain> restart: Alert is
shown

A050-08 | The replication Could not replicate | After PCC restart: | Alert is shown Critical

process failed for a | data for group Alert is shown
group <group> in domain | After server
<domain> restart: Alert is
shown
A050-09 | The replica archiving | The replica archiving | Affer PCC restart: | Alert is shown Critical
service for a group is | service for group Alert is shown
unavailable <group> in domain | After server
<domain> is restart: Alert is
unavailable shown
Database Replication
(In virtual IAP systems, replication is not supported and these alerts do not appear.)
A051-01 | A DB2 transaction A DB2 transaction After PCC restart: | Alert is shown Critical
log required by log <missing_tx_log> | Alert is shown
database replication | required by DB2 After server
is missing replication could not | rastart: Alert is
be found. DB2 shown
replication has been
stopped and will
have to be manually
re-initialized.
A051-02 | An IPC file is missing | An IPC file After PCC restart: | Alert is shown Minor
<missing_ipc_ Alert is shown
queue_fi|e> required After server
by DB2 replication | restart: Alert is
(<program>) could | shown
not be found. This
may cause DB2
replication to fail to
stop when requested
to do so.
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ID Description Context After PCC/ After manual Alert
server removal from | level
restart PCC Overview

AO051-03 | DB2 replication has | DB2 replication is in | Affer PCC restart: | Alert is shown Critical

errors error state. Details: Alert is shown
<error_msg> After server
restart: Alert is
shown
A051-04 | The primary and The primary and After PCC restart: | Alert is shown Maijor
replica databases are | replica DB2 Alert is shown
not synchronized databases are not After server
synchronized for restart: Alert is
more than shown
<threshold_
latency> secs (Actual
Latency:
<actual_latency>
secs). Details:
<error_msg>
AO051-05 | DB2 replication has | DB2 replication has | Affer PCC restart: | Alert is shown Maijor
not captured updates | not captured updates | Alert is shown
to the DB2 database | After server
for more than restart: Alert is
<threshold_ shown
latency> secs (Actual
Latency:
<actual_latency>
secs). Details:
<error_msg>
User Management and User Synchronization
A060-01 | The dynamic account | DAS job <das_job> | Affer PCC restart: | Alert is shown Critical
synchronization job | f4iled to import users Alert is shown when the job is
for users failed After server run again
restart: Alert is
shown when the
job is run again
A060-02 | The dynamic account | DAS job <das_job> | Affer PCC restart: | Alert is shown Critical
synchronization job | f4iled 1o import Alert is shown when the job is
for groups failed groups After server run again
restart: Alert is
shown when the
job is run again
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ID Description Context After PCC/ After manual Alert
server removal from | level
restart PCC Overview

A060-03 | The dynamic account | DAS job <das_job> | Affer PCC restart: | Alert is shown Critical

synchronization job | failed to disable users | Alert is shown when the job is
for deleted objects and groups After server run again
failed restart: Alert is
shown when the
job is run again
A060-04 | The dynamic account | Check Account Error | After PCC restart: | Alert is shown Maijor
synchronization job | Recovery for any Alert is shown when the job is
completed with errors | importing issues for | After server run again
starting restart: Alert is
point=<Idapdn>, shown when the
Server=<ldap_ job is run again
server>
Database Backup
A070-01 | The DB2 online DB2 online backups | Affer PCC restart: | Alert is shown Maijor
backups are too old | under Alert is shown
<online_backup_ After server
dir> are older than restart: Alert is
<max_days> days shown
A070-02 | The DB2 online No DB2 online After PCC restart: | Alert is shown Major
backup cannot be backups could be Alert is shown
found. found under <online_ | After server
backup_dir> restart: Alert is
shown
Tape Backup
(In virtual IAP systems, tape backup is not supported and these alerts do not appear.)
A071-01 | Tape restore failed. | Error allocating smart | Affer PCC restart: | Alert is shown if | Critical
Manual intervention | cell to restore to. Alert is shown if | the problem
required. Group ID: the problem persists when the
<group_id> persists when the | job is run again
job is run again
After server
restart: Alert is
shown if the
problem persists
when the job is
run again
A071-02 | Tape restore failed. | Tape restore After PCC restart: | Alert is shown if | Critical
Manual intervention | interrupted on smart | Alert is shown the problem
required. cell. After server persists when the
restart: Alert is job is run again
shown if the
problem persists
when the job is
run again
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ID Description Context After PCC/ After manual Alert
server removal from | level
restart PCC Overview

A071-03 | Tape restore failed. | Tape restore step After PCC restart: | Alert is shown if | Critical

Manual intervention | failed on smart cell. | Alert is shown the problem
required. After server persists when the
restart: Alert is job is run again
shown if the
problem persists
when the job is
run again
Administration
A080-01 | The Postgres instance | Could not create After PCC restart: | Alert disappears | Critical
on the PCC is connection to Alert is shown and is not shown
unavailable Postgres (PCC After server even if the
persistent storage). restart: After problem still exists
Postgres restarts
the alert
disappears
Retention
A090-01 | Retention is The domain retention | Affer PCC restart: | Alert disappears | Critical
misconfigured and period of Alert is shown and is not shown
will not run <domain_ret_ After server even if the
period> is below the | restart: Alert is problem still exists
minimum of shown if problem
<min_ret_period> for | persists when the
Domain <domain> | machine is
restarted
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B Indexed document types

In addition to email messages, the file types shown in the table below are indexed by the IAP. These
files can be email attachments or files that are migrated to the IAP using HP File Archiving software.

Microsoft Access, Project, and Visio files are not indexed. If these files are archived, users can search
for them only by using external identifying information, such as the file name or file extension.

Beginning with IAP 2.1, we have added file type and content-type support for the following
applications: WordPerfect Office, WordPerfect Presentations, WordPerfect for DOS, Quattro Pro for
Windows, and Quattro Pro for DOS.

See the “IAP overview” chapter in the IAP user guide for more detailed information on document

indexing.

Table 37 IAP indexed document MIME types

File extension | File type MIME content-type
xml XML document text/xml

Plain text file; treated as ISO-
Axt 8859-1 unless otherwise spe- | text/plain

cified
.:trr:, -html, HTML document text/html, rtf/html
rif Rich text format rif/text, application/rif
.dat TNEF (for Microsoft Exchange) | ms/tnef
-mht, .mhtml, Email message message/RFC 822
.nws, .eml
.doc, .dot Microsoft Word 97:2003 docu- application/msword

ment

xla, .xlc, .xIm,
xls, xlt, xlw

Microsoft Excel 972003 docu-

ment

application/vnd.ms-excel, application/ms-excel

Microsoft PowerPoint 972003

.pot, .pps, -ppt document application/vnd.ms-powerpoint, application/vnd.msppt

pdf ﬁ)cri:]g(te Portable Document application//pdf

.zip ZIP archive application/zip

docx Microsoft Word 2007 application/vnd.openxmlformats-officedocument.
document wordprocessingml.document

.docm Microsaft Word 2007 macro- application/vnd.ms-word.document.macroEnabled. 12

enabled document

HP IAP 2.1 Administrator Guide 187



File extension

File type

MIME content-type

Microsoft Word 2007

application/vnd.openxmlformats-officedocument.

dotx template wordprocessingml.template
.dotm 2/:1I;[)722|Hd\2/c?;101|e2r1?g7rnr;|2(;;o- application/vnd.ms-word.template.macroEnabled. 12
s Microsoft Excel 2007 application/vnd.openxmlformats-officedocument.
’ workbook spreadsheetml.sheet
xlsm ﬁ'é{)olzzhvfgrckifo?(07 macro- application/vnd.ms-excel.sheet.macroEnabled. 12
e Microsoft Excel 2007 femplate application/vnd.openxmlformats-officedocument.
spreadsheetml.template
Xltm 2/:;Lﬁzzftvfsfkiozo?(czxp?g::_ application/vnd.ms-excel.template.macroEnabled. 12
xlam Microsoft Excel 2007 add-in application/vnd.ms-excel.addin.macroEnabled. 12
b Microsoft PowerPoint 2007 application/vnd.openxmlformats-officedocument.
PP presentation presentationml.presentation
Microsoft PowerPoint 2007 application/vnd.ms-powerpoint.presentation.
pptm
‘ macro-enabled presentation macroEnabled. 12
o Microsoft PowerPoint 2007 application/vnd.openxmlformats-officedocument.
PP slide show presentationml.slideshow
Microsoft PowerPoint 2007 application/vnd.ms-powerpoint.slideshow.
ppsm
: macro-enabled slide show macroEnabled. 12
ot Microsoft PowerPoint 2007 application/vnd.openxmlformats-officedocument.
P template presentationml.template
Microsoft PowerPoint 2007 licati .
! application/vnd.ms-powerpoint.template.
.potm macro-enabled presentation
template macroEnabled. 12
Corel WordPerfect for Win-
.wpd dows — versions through Ver- | application/wordperfect, application/wpd
sion 12.0, X3
.gpw, .wbT, E:?/;er;(j::::rooirohf(\)/re:g\i/lor:]dows application/qpw, application/wb1, application/wb2,
wb2, .wb3 120.X3 9 application/wb3
Corel Presentations — versions - .
.shw application/presentations

through Version 12.0, X3
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Index

A

Account Error Recovery page, 87
Account Manager, 73
See also AM
Account Manager Service, 43
account synchronization
See DAS
Account Synchronization page, 63
accounts, user, 75
Administrative Delete, 78, 101, 121
administrative privileges, IAP, 78
alerts
application-generated, 42, 179
clearing from PCC Overview, 43
current platform, 41
hardware-generated, 42
levels, 42
AM, 73
See also Account Manager
about AM, 73
Account Manager window, 73
adding repositories, 82
adding users, 75
definition, 73
group panel, 79
user accounts, 75
Archive Gateway management
logging in, 141
ASSIGNED Smartcell state, 38
audit log, 147
Auditlog, 21

B

backup files
backup file history, 107
backup file locations, 111
configuration files, 112
database files, 111
restoring configuration files, 111
restoring DB2 backups, 111
backup system administration, 151

C

CatchAll repository, 44, 81
certificate signing request (CSR)
deleting, 58
generating, 58
certificates
installing, 58
cloning Smartcell, 115
CLOSED Smartcell state, 38
collect log files, 131
COMPLETE_PROCESSING Smartcell state, 38
compliance, regulatory, 78, 80, 81, 84, 99,
147
configuration
domain, 57
IAP, 58
configuration file backup, 107
conventions
text symbols, 15
Corel Presentations, 188
CPU use, 45

current platform alerts, 41

D

DAS
configuring, 63
creating jobs, 63
editing or deleting jobs, 69
history logs, 71
repairing synchronization errors, 87
scheduling jobs, 68
starting jobs, 68
stopping jobs, 68
data
reprocessing, 97
retention, 99
Data Protector, 151
Database and data backup page, 107
database backup, 107, 151
DEAD Smartcell state, 39
DISCOVERY Smartcell state, 38
document retention, 99
Duplicate Manager, 89
DWA Extension, 21
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E life cycle states

definition, 37
life cycle states, types, 38
log in

email mining system, 141

Email Reporter, 129
email SNMP notifications, 128
End User Delete, 101, 105

event log, 125 PCC, 33
VNC, 141
F Lotus Notes options, 21
failed indexing repository, 44
File Export, 21 M
?|e extlviensigns, 12; MIB, 127
irewall seftings, MIME content types, 187

folder capture, 121

FREE Smartcell state, 39 Mining
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